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1.1   INTRODUCTION 

Computers are machines that perform tasks or calculations according to a set of instructions, 

or programs. The first fully electronic computers, introduced in the 1940s, were huge machines 

that required teams of people to operate. Compared to those early machines, today's computers 

are amazing. Not only are they thousands of times faster, they can fit on your desk, on your lap, 

or even in your pocket. Computers work through an interaction of hardware and software. 

 

 Hardware refers to the parts of a computer that you can see and touch, including the case and 

everything inside it. The most important piece of hardware is a tiny rectangular chip inside your 

computer called the central processing unit (CPU), or microprocessor. It's the "brain" of your 

computer—the part that translates instructions and performs calculations. Hardware items such 

as your monitor, keyboard, mouse, printer, and other components are often called hardware 

devices, or devices. 

 

Software refers to the instructions, or programs, that tell the hardware what to do. A word-

processing program that you can use to write letters on your computer is a type of software. The 

operating system (OS) is software that manages your computer and the devices connected to it. 

Windows is a well-known operating system. 
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1.2    FUNDAMENTALS OF COMPUTER  

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define computer  

ii. Explain uses of computer 

iii. Explain the necessity of computer 

iv. Understand the input and the output devices 

v. Explain the types of computer 

vi. Describe the history of computers 

vii. Explain the free open source software systems 

 

1.2.1    WHAT IS COMPUTER   

A computer is an electronic device. It has the ability to store, retrieve and process data. In 

simplest form, a computer takes information (or inputs), processes it according to a set of 

instructions (a program), and gives back a result (or output). In this respect, it is very similar to a 

calculator, but obviously somewhat more complex. 

 

 

 

 

 

 

 

The term computer is derived from the Latin term ‗computare‘, this means to calculate. 

Computer can not do anything without a Program.  

                              Let‘s know more 

 

 

Charles Babbage is called the "Grand Father" of the computer. 

The First mechanical computer designed by Charles Babbage 

was called Analytical Engine. 

http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
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Four Functions about computer are: 

Input (Data): 
Input is the raw information entered into a computer from the input devices. It is the collection of 

letters, numbers, images etc. 

Process: 
Process is the operation of data as per given instruction. It is totally internal process of the 

computer system. 

Output: 
Output is the processed data given by computer after data processing. Output is also called as 

Result. We can save these results in the storage devices for the future use. 

                 

 

 

 

1.1.2   USES OF COMPUTER  

 

Computers in Education –  

 Computers are used in school for teaching. 

 Computers are used for mathematical calculations. 

 Students can do their work by using computer. 

 One revolution in education is the advent of distance learning. 

 Computers provide better study moods. 

Computer in Science –  

 Computers are used in scientific research to solve mathematical problems. 

 Helps scientists to understand the world around us.  

 Scientists can enter results and data into a computer. 

 Allow scientists to review information easily. 

Computer in Health and Medicine –  

 Patients monitoring and record keeping. 

 Helps doctor in controlling operation theatre machine. 

Program is a set of instructions which enables the computer to perform specified task 

http://ecomputernotes.com/fundamental/input-output-and-memory/explain-secondary-storage-devices
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 Helps in medical diagnosis of the patient. 

 Hospital administration. 

 Help doctor with more advanced scanning equipment. 

Computer in Business –  

 Computer allows businesses to keep detailed records. 

 Computers can be used to prepare detailed budgets and corporate forecasts. 

 It allows businesses to easily prepare dynamic marketing documents. 

 An important use of computers in business is running technical software. 

 Computer plays a vital role in advertising. Every advertisement is fully done with a 

computer. 

 Check the credit status of customers, and transfer funds automatically. 

Computer in Defence –  

 Computers help in launching of missiles. 

 Keeping records of criminal. 

 Helps in constructing weapon and controlling their function. 

 Used in planes and tanks to target the enemy. 

 Establishes a communication link between the soldiers and commanders through 

satellite. 

 Modern radar system. 

Computer in Home – 

 In playing games. 

 Music collection. 

 Write important documents and print them. 

 Computers can play a role in home security. 

 Use of computers in the home is for entertainment. 

Computer in entertainment –  

 Used for making cartoon movies and animation films. 

 Computer in photo editing 

 Used for making drawings. 
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Computers in banks –  

 Used in bank for storing information about different account holders. 

 Help in keeping the record of the cash. 

 Giving all kinds of information regarding any account in the bank. 

 Automatic teller machine. 

Computer in office- 

 Computers can help managers keep track of the financial status of the company on a 

yearly, monthly or even day-to-day basis.  

  Keep track of data about customers, products, demographics and other information 

important to the business. 

  Offices use computers for common purposes such as email and document creation 

Computer in railway station and airport – 

 Gives information about ticket reservations and bookings. 

 Information regarding the arrival and departure time of trains and aeroplane. 

 Helps in keeping records of passenger. 

 Connects pilot with service station. 

 Computers are crucial to an airport's air traffic control services. 

Computer in designing –  

 Fashion designers can use computers to construct patterns, design clothing, and create 

collections. 

 Adobe Photoshop and In Design are used to create marketing materials. 

 Computers help in designing buildings, houses etc. 

Computer in travel and tourism –  

 Most new cars uses computer chip to control the engine. 

 Keep record of tourist. 

 Information about visit able sites 

 Government use computer for planning, control and law enforcement activities such as 

Travel, Tourism etc.   

Computer in weather forecasting – 

 Weather stations 
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 Humidity measurement 

 Metrological studies 

Computer in sports –  

 Computers also allow sports professionals to store a large amount of video footage in one 

place. 

 Computers have aided in the design of safety equipment in sports such as football 

helmets to shoes to mouth guards  

 Statistics are an important part of sports. computers can be used in sports in order to Keep 

track of the data. 

 Sports media outlets use computers everyday in their jobs. 

 

1.2.3   NECESSITY OF COMPUTER 

 

The computer is one of the most brilliant gifts of science. Today the computer plays a very 

important role in the life of each and every individual whether the individual is student, small 

businessmen or a large company. The computer has proved a friend and servant of science, 

technology and industry. Most offices, shops, factories and industries use computers. The 

Internet on a computer is a storehouse of information. The computer is a boon to all. The most 

that any field has gained from the invention of the computers is the business field because of it‘s 

nature. 

It‘s necessary to have a computer in school because computers are the new way to educate 

everyone, children are being taught to operate computers so that in the future everyone has 

knowledge of basic computing. Computers have gained importance as they have increased the 

productivity and efficiency of work done. Large amounts of data in the personal lives as well as 

in businesses and industrial sectors are stored on computers. Computers have also brought a 

revolution in the field of medicine. Not only clinics and hospitals can store data, the doctors can 

also make use of the computer to scan patients‘ bodies and even perform surgeries that would 

have been quite complex and dangerous to do so without the finesse provided by the computers. 

Computers has help out a lot, in our daily lives where many of us can't live without one, by using 

computers and going on the internet, we can find any information on a person we want, like 

black history month, why go on the Library, when you could look up in computer as you can use 
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the internet to look up current evens from around the world without being in that country. By 

using computers we can check up on the weather, before we go to work or school. So by 

checking the weather we already know if it's going to Rain or Snow or it's could be sunny. Then 

there contracting other family members, where many of us use our computers to text our family 

to see how there going, when member of you family is so far away living in a difference state or 

country. 

 By using our computers to shop on the internet we can find the product we are looking for, 

without going inside the retail store to look for it, only to find out it's sold out. Since, computers 

appear in our life, they are not only tools for working, studying but also entertainment also. By 

shopping on the internet it saves some a lot of trouble from looking for something that is not 

there. Computer is the backbone of information technology whose major application lies in 

internet. Internet has some very useful applications in our day to day life. The computer gives us 

many benefits. Eventually, computers come into every family and effectively influence our usual 

life. Thus computer has become an indispensable part of our daily life.  

1.2.4   IMPORTANT TERMINOLOGY: INPUT AND OUTPUT DEVICES 

Some devices are used to input information, while others are used to output information from the 

computers. 

 

INPUT DEVICES –  

An input device is anything that puts information inside the computer such as Keyboard, Mouse, 

Scanner, Microphone etc.  

 

Keyboard –  

The keyboard allows the entry of textual information. It consists of a set of keys mounted on a 

board as shown in fig 1.1  

 Alphanumeric Keypad - It consists of keys for English alphabets, 0 to 9 numbers, and 

special characters like + - / * ( ) etc. 

 Function Keys - There are twelve function keys labeled F1, F2, F3… F12. The functions 

assigned to these keys differ from one software package to another. These keys are also 

user programmable keys. 
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 Special-function Keys - These keys have special functions assigned to them and can be 

used only for those specific purposes. Some special function keys are enter, spacebar, 

backspace, delete, insert, shift, caps lock etc 

 Numeric Keypad - Numeric keypad is located on the right side of the keyboard and 

consists of keys having numbers (0 to 9) and mathematical operators (+ − * /) defined on 

them. This keypad is provided to support quick entry for numeric data. 

 Cursor Movement Keys - These are arrow keys and are used to move the cursor in the 

direction indicated by the arrow (up, down, left, right). 

 

 

 

 

 

 

 

 

                                                       Fig 1.1   Computer keyboard 

Mouse –   

Mouse allows the selection of a point on the screen by moving a screen cursor to the point and 

pressing a mouse button as shown in fig 1.2 (a) and (b) 

 

 

 

 

                                     

                                                             Fig 1.2 (a)  Mouse 

Mouse Actions - 

 Left Click - Used to select an item. 

 Double Click - Used to start a program or open a file. 

 Right Click - Usually used to display a set of commands. 
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 Drag and Drop - It allows you to select and move an item from one location to another. 

To achieve this place the cursor over an item on the screen, click the left mouse button 

and while holding the button down move the cursor to where you want to place the item, 

and then release it. 

 

 

 

                                                            Fig 1.2 (b) mouse pointer 

Scanner –  

Scanner is an input device used for direct data entry from the source document into the computer 

system. It converts the document image into digital form so that it can be fed into the computer 

as shown in fig 1.3 

 

 

 

 

 

 

 

                                                          Fig 1.3 scanner 

Microphone –  

A microphone is used to record sound (usually through a sound card input or circuitry built into 

the motherboard). The sound is digitized i.e. turned into numbers that represent the original 

analog sound waves and stored in the computer to later processing and playback. 

 

 

 

 

 

 

                                                            Fig 1.4 microphone  
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OUTPUT  DEVICES  –  

An input device is anything that display information such as Monitors, Printers, Audio Output 

Devices. 

 

Monitor –  

Monitor is a Cathode Ray Tube device which can display text and graphics. The monitor is 

associated with a keyboard for manual input of characters and displays the information as it is 

keyed in as shown in fig 1.5  

 

 

 

 

 

 

                                                          Fig 1.5 monitor  

Printer –  

Printers are used to produce paper (commonly known as hardcopy) output. Based on the 

technology used, they can be classified as Impact or Non-impact printers shown in fig 1.6 

 Impact printers use the typewriting printing mechanism wherein a hammer strikes the 

paper through a ribbon in order to produce output. Dot-matrix and Character printers fall 

under this category. 

 Non-impact printers do not touch the paper while printing. They use chemical, heat or 

electrical signals to etch the symbols on paper. Inkjet, Desk jet, Laser, Thermal printers 

fall under this category of printers 

 

 

 

 

 

 

                                                  Fig 1.6 inkjet printer and laser printer 
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Audio Output Devices – 

The Audio output is the ability of the computer to output sound. Two components are needed:  

 Sound card – Plays contents of digitized recordings  

 Speakers – Attached to sound card 

These devices are used to produce sound from the computer system. The soundcard is a card 

installed in the tower case of the computer. Its role is to convert the signal coming out of the 

computer to a format that can be reproduced by the external speakers. 

 

 

 

 

 

                                                          Fig 1.7 speaker  

LCD projector -  

A Liquid Crystal Display (LCD) projector uses its own light source to project what is displayed 

on the computer on a wall or projection screen. 

 

 

1.2.5   TYPES OF COMPUTERS 

There are three different types of computers based on the principles of operation.  

 

Computer 

Analog Digital 

Super Computers  
Mainframe 
Computers 

Mini Computers Micro Computers  

Hybrid 
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Analog Computer  

Analog Computer is a device that works on continuous range of values. The output given by the 

analog computers is approximate since it deals with quantities that vary continuously such as 

voltage, pressure, temperature, speed etc. 

Digital Computers  

A digital computer operates on digital data such as numbers. It uses binary number system in 

which there are only two digits 0 and 1. Each one is called a bit. 

The digital computer is designed using digital circuits in which there are two levels for an input 

or output signal. These two levels are known as logic 0 and logic 1. Digital Computers can give 

more accurate and faster results. 

Digital computer is well suited for solving complex problems in engineering and technology. 

Hence digital computers have an increasing use in the field of design, research and data 

processing. 

 

Based on the purpose, Digital computers can be further classified as, 

 General Purpose Computers 

 Special Purpose Computers 

Special purpose computer is one that is built for a specific application. General purpose 

computers are used for any type of applications. They can store different programs and do the 

jobs as per the instructions specified on those programs. Most of the computers that we see today 

are general purpose computers. 

 

There are four different types of computers based on the performance and capacity. The four 

types are 

 

1. Super Computers –  

The most powerful computers in terms of performance and data processing are the 

supercomputers. These are specialized and task specific computers used by large organizations. 

The supercomputers are very expensive and very large in size. It can be accommodated in large 

http://www.byte-notes.com/types-computers-purpose


15 
 

air-conditioned rooms, some super computers can span an entire building. These computers are 

used for research and exploration purposes, like NASA uses supercomputers for launching space 

shuttles, controlling them and for space exploration purpose. 

                          

                         Let‘s know more 

 

 

 

Popular Supercomputers 

 IBM‘s Sequoia, in United States 

 Fujitsu‘s K Computer in Japan 

 IBM‘s Mira in United States 

 IBM‘s  SuperMUC in Germany 

 NUDT Tianhe-1A in China 

 

As of July 2009, the IBM Roadrunner, located at Los Alamos National Laboratory, is the fastest 

super computer in the world. 

 

 

 

 

 

 

 

 

2. Mainframe computers - 

Mainframe is a very large in size and an expensive computer capable of supporting hundreds, or 

even thousands, of users simultaneously. Mainframe executes many programs concurrently. 

Mainframes support many simultaneous programs execution. They are used in banking, airlines 

and railways etc for their applications. 

Popular Mainframe computers 

 Fujitsu‘s ICL VME 

 Hitachi‘s Z800 

In 1964, Seymour Cray designed the first Supercomputer "CDC 

6600". 
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3. Minicomputers –  

A minicomputer is a multi-processing system capable of supporting from up to 250 users 

simultaneously. Minicomputers are also called as ―Midrange Computers‖. These are small 

machines and can be accommodated on a disk.  It is a midsize computer. Minicomputers are used 

by small businesses & firms. These computers are not designed for a single user. Individual 

departments of a large company or organizations use Mini-computers for specific purposes. For 

example, a production department can use Mini-computers for monitoring certain production 

process. 

Popular Minicomputers 

 K-202 

 Texas Instrument TI-990 

 SDS-92 

 IBM Midrange computers 

 

4. Microcomputers ( personal computers ) - 

The invention of microprocessor (single chip CPU) gave birth to the much cheaper micro 

computers. The micro-computers are widely used & the fastest growing computers. These 

computers are the cheapest among the other three types of computers. The Micro-computers are 

specially designed for general usage like entertainment, education and work purposes. Well 

known manufacturers of Micro-computer are Dell, Apple, Samsung, Sony & Toshiba. 

 

 

 

 

They are further classified into : 

 Desktop Computers - Desktop computers are the most popular computer systems. These 

desktop computers are also known as personal computers or simply PCs. They are 

usually easier to use and more affordable. They are normally intended for individual 

users for many other  application. 

 Laptop / Notebook Computers - Laptop computers are portable computers. They are 

lightweight computers with a thin screen. They are also called as notebook computers 

Because PCs were so much smaller than mainframe computers, they were 

called 'microcomputers' for a while 
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because of their small size. They can operate on batteries and hence are very popular with 

travelers .The screen folds down onto the keyboard when not in use 

 Handheld Computers - Handheld computers or Personal Digital Assistants (PDAs) are 

pen-based and also battery-powered. They are small and can be carried anywhere. They 

use a pen like stylus and accept handwritten input directly on the screen. They are not as 

powerful as desktops or laptops but they are used for scheduling appointments, storing 

addresses and playing games. They have touch screens which we use with a finger or a 

stylus. 

 Palmtop Computer - A palmtop computer is similar to a laptop computer, but smaller. 

It's small enough to fit in the palm of your hand (hence the name!) Palmtops are usually 

not very powerful and have a very small keyboard. Also a touch screen or tiny joystick is 

used. Palmtops are extremely portable, but the small keyboard and screen make the 

devices tiring to use for long periods. 

 Tablet computer – Like laptops, but with a touch-screen, sometimes entirely replacing the 

physical keyboard. It accepts the handwriting. Tablet computers are even more portable 

than laptops.  

 

Hybrid Computers 

A hybrid computer combines the desirable features of analog and digital computers. It is mostly 

used for automatic operations of complicated physical processes and machines. Now-a-days 

analog-to-digital and digital-to-analog converters are used for transforming the data into suitable 

form for either type of computation. 

For example, in hospital‘s ICU, analog devices might measure the patient temperature, blood 

pressure and other vital signs 

 

1.2.6   HISTORY OF COMPUTERS 

The computer as we know it today had its beginning with a 19th century English mathematics 

professor name Charles Babbage. He designed the Analytical Engine and it was this design that 

the basic framework of the computers of today are based on. 

http://en.wikipedia.org/wiki/Tablet_computer
http://en.wikipedia.org/wiki/Touch-screen
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Computers can be classified into five generations. Each generation lasted for a certain period of 

time and each gave us either a new and improved computer or an improvement to the existing 

computer. 

First Generation (1940-1955) Vacuum Tubes 

The first computers used vacuum tubes for circuitry and magnetic drums for memory, and were 

often enormous, taking up entire rooms. They were very expensive to operate and in addition to 

using a great deal of electricity, generated a lot of heat, which was often the cause of 

malfunctions. 

First generation computers relied on machine language, the lowest-level programming language 

understood by computers, to perform operations, and they could only solve one problem at a 

time. Input was based on punched cards and paper tape, and output was displayed on printouts. 

The UNIVAC and ENIAC computers are examples of first-generation computing devices. In 

1946 the first general– purpose digital computer, the Electronic Numerical Integrator and 

Computer (ENIAC) was built. It is said that this computer weighed 30 tons, and had 18,000 

vacuum tubes which was used for processing. When this computer was turned on for the first 

time lights dim in sections of Philadelphia. Computers of this generation could only perform 

single task, and they had no operating system. 

The UNIVAC was the first commercial computer delivered to a business client, the U.S. Census 

Bureau in 1951. 

 

Second Generation (1956-1963) Transistors 

Transistors replaced vacuum tubes and ushered in the second generation of computers. The 

transistor was invented in 1947 but did not see widespread use in computers until the late 1950s. 

The transistor was far superior to the vacuum tube, allowing computers to become smaller, 

faster, cheaper, more energy-efficient and more reliable than their first-generation predecessors. 

Though the transistor still generated a great deal of heat that subjected the computer to damage, 

it was a vast improvement over the vacuum tube. Second-generation computers still relied on 

punched cards for input and printouts for output. 

http://www.webopedia.com/TERM/M/magnetic_drum.html
http://www.webopedia.com/TERM/M/memory.html
http://www.webopedia.com/TERM/M/machine_language.html
http://www.webopedia.com/TERM/E/ENIAC.html
http://www.webopedia.com/TERM/T/transistor.html
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Second-generation computers moved from cryptic binary machine language to symbolic 

or assembly languages, which allowed programmers to specify instructions in words. High-level 

programming languages were also being developed at this time, such as early versions 

of COBOL and FORTRAN. These were also the first computers that stored their instructions in 

their memory, which moved from a magnetic drum to magnetic core technology. 

The first computers of this generation were developed for the atomic energy industry. 

 

Third Generation (1964-1970) Integrated Circuits 

The development of the integrated circuit was the hallmark of the third generation of computers. 

Transistors were miniaturized and placed on silicon chips, called semiconductors which 

drastically increased the speed and efficiency of computers. With this invention computers 

became smaller, more powerful and more reliable. 

Instead of punched cards and printouts, users interacted with third generation computers 

through keyboards and monitors and interfaced with an operating system, which allowed the 

device to run many different applications at one time with a central program that monitored the 

memory. Computers for the first time became accessible to a mass audience because they were 

smaller and cheaper than their predecessors. 

 

                Let‘s know more 

 

 

 

 

 

 

Fourth Generation (1971-Present) Microprocessors 

The microprocessor brought the fourth generation of computers, as thousands of integrated 

circuits were built onto a single silicon chip. What in the first generation filled an entire room 

could now fit in the palm of the hand. The Intel 4004 chip, developed in 1971, located all the 

components of the computer—from the central processing unit and memory to input/output 

controls—on a single chip. 

An integrated circuit (IC) is a small electronic device made out of a 

semiconductor material. The first integrated circuit was developed in the 

1950s by Jack Kilby of Texas Instruments and Robert Noyce of Fairchild 

Semiconductor. 

http://webopedia.com/TERM/B/binary.html
http://webopedia.com/TERM/a/assembly.html
http://www.webopedia.com/TERM/H/high_level_language.html
http://www.webopedia.com/TERM/H/high_level_language.html
http://www.webopedia.com/TERM/C/COBOL.html
http://www.webopedia.com/TERM/F/FORTRAN.html
http://www.webopedia.com/TERM/I/integrated_circuit_IC.html
http://www.webopedia.com/TERM/S/silicon.html
http://webopedia.com/TERM/C/chip.html
http://webopedia.com/TERM/S/semiconductor.html
http://www.webopedia.com/TERM/K/keyboard.html
http://www.webopedia.com/TERM/M/monitor.html
http://www.webopedia.com/TERM/I/interface.html
http://www.webopedia.com/TERM/O/operating_system.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/M/microprocessor.html
http://www.webopedia.com/TERM/C/CPU.html
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In1980 Microsoft Disk Operating System (MS-Dos) was born and in 1981 IBM introduced its 

first computer for the home user. Three years later in 1984 Apple introduced the Macintosh and 

the 90s gave us Windows operating system.  

Microprocessors also moved out of the realm of desktop computers and into many areas of life as 

more and more everyday products began to use microprocessors. 

As these small computers became more powerful, they could be linked together to form 

networks, which eventually led to the development of the Internet. Fourth generation computers 

also saw the development of GUIs, the mouse and handheld devices. 

 

Fifth Generation (Present and Beyond) Artificial Intelligence 

The "fifth generation" of computers defined by the Japanese government in 1980 when they 

unveiled an optimistic ten-year plan to produce the next generation of computers. Fifth 

generation computing devices, based on artificial intelligence, are still in development, though 

there are some applications, such as voice recognition, that are being used today. The use 

of parallel processing and superconductors is helping to make artificial intelligence a 

reality. Quantum computation and molecular and nanotechnology will radically change the face 

of computers in years to come. The goal of fifth-generation computing is to develop devices that 

respond to natural language input and are capable of learning and self-organization such as 

capable of performing tasks in similar ways to humans, are capable of learning, and are capable 

of interacting with humans in natural language and preferably using both speech input (speech 

recognition) and speech output (speech synthesis).  

 

As a result of the various improvements to the development of the computer we have seen the 

computer being used in all areas of life. It is a very useful tool that will continue to experience 

new development as time passes. 

 

 

 

 

 

http://www.webopedia.com/TERM/I/IBM.html
http://webopedia.com/TERM/A/Apple_Computer.html
http://webopedia.com/TERM/G/GUI.html
http://webopedia.com/TERM/M/mouse.html
http://webopedia.com/TERM/H/hand_held_computer.html
http://webopedia.com/TERM/A/artificial_intelligence.html
http://webopedia.com/TERM/V/voice_recognition.html
http://webopedia.com/TERM/P/parallel_processing.html
http://webopedia.com/TERM/Q/quantum_computing.html
http://webopedia.com/TERM/N/nanotechnology.html
http://webopedia.com/TERM/N/natural_language.html
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1.2.7   FREE OPEN SOURCE SOFTWARE SYSTEM 

 

Free and open-source software (FOSS) is computer software that can be classified as both free 

software and open source software. FOSS programs are those that have licenses that allow users 

to freely run the program for any purpose, modify the program as they want, and also to freely 

distribute copies of either the original version or their own modified version. That is, anyone is 

freely licensed to use, copy, study, and change the software in any way and the source code is 

openly shared so that people are encouraged to voluntarily improve the design of the software. 

 

 

 

 

Definition of FOSS - 

The word "free" in our name does not refer to price; it refers to freedom. 

 First, the freedom to copy a program and redistribute it to your neighbors, so that they 

can use it as well as you. 

 Second, the freedom to change a program, so that you can control it instead of it 

controlling you; for this, the source code must be made available to you 

                                                                                - Free Software Foundation (FSF), Feb 1986 

 

All the software on the Live CD and the DVD are Free and Open Source software, with a few 

notable exceptions (Flash, Opera, Acrobat Reader and more) in the non-oss repositories. When 

we talk about free software we refer to freedom not a price. 

Free open-source operating systems such as Linux and Open BSD are widely utilized today, 

powering millions of servers, desktops, smart phones (e.g. Android) and other devices. 

Free Software –  

Free software is defined by the offering of 4 basic freedoms: 

 The freedom to run the program, for any purpose  

Definition of FOSS –  

Free software" is a matter of liberty, not price. To understand the concept, 

you should think of "free" as in "free speech" not as in "free beer"  

                                                                                - Richard Stallman (FSF) 

http://en.wikipedia.org/wiki/Computer_software
http://en.wikipedia.org/wiki/Free_software
http://en.wikipedia.org/wiki/Free_software
http://en.wikipedia.org/wiki/Open_source_software
http://en.wikipedia.org/wiki/Free_software_licence
http://en.opensuse.org/Package_repositories#Non-oss
http://en.wikipedia.org/wiki/Linux
http://en.wikipedia.org/wiki/OpenBSD
http://en.wikipedia.org/wiki/Server_(computing)
http://en.wikipedia.org/wiki/Desktop_computer
http://en.wikipedia.org/wiki/Android_(operating_system)
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 The freedom to study how the program works, and adapt it to your needs  

 The freedom to redistribute copies, so you can help your neighbor 

 The freedom to improve the program, and release your improvements to the public, 

so that the whole community benefits  

 

Open Source –  

It emphasize the technical and economical benefits of open source code and open development, 

and care little or nothing at all about the ethical aspects. However there is very little software 

acknowledged by the Open Source Initiative that is not also Free Software, hence the term 

FOSS (Free and Open Source Software) is often used. 

 

Benefits of FOSS 

 Decreasing software costs 

 Increasing security and stability (especially in regards to malware) 

 Protecting privacy  

 Giving users more control over their own hardware.  

 Better quality control 

 

Examples of Free and Open Source Software 

Operating systems –  

 Linux  - Operating system kernel 

 Ubuntu - Linux distribution  with full compliment of software for everyday use.  

 Google Chrome OS  - Lightweight operating system based around the web browser 

 Android smart-phone operating system  - by Google / Open Handset Alliance 

 Symbian smart-phone operating system  - by Nokia 

 MeeGo smart-phone operating system  - joint venture between Intel and Nokia 

 BSD  - Operating system 

 Darwin  - The core of Apple's Mac OS X, operating system 

 GNOME - desktop environment for Linux (and Unix) 

 KDE  -desktop environment for Linux (and Unix) 

http://en.wikipedia.org/wiki/Malware
http://en.wikipedia.org/wiki/Privacy
http://en.wikipedia.org/wiki/Linux
http://en.wikipedia.org/wiki/Ubuntu_%28Linux_distribution%29
http://en.wikipedia.org/wiki/Linux_distribution
http://en.wikipedia.org/wiki/Google_Chrome_OS
http://en.wikipedia.org/wiki/Android_(operating_system)
http://en.wikipedia.org/wiki/Symbian_platform
http://en.wikipedia.org/wiki/MeeGo
http://en.wikipedia.org/wiki/Berkeley_Software_Distribution
http://en.wikipedia.org/wiki/Darwin_%28operating_system%29
http://en.wikipedia.org/wiki/Mac_OS_X
http://en.wikipedia.org/wiki/GNOME
http://en.wikipedia.org/wiki/KDE
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 Xfce - lightweight desktop environment for Linux (and Unix) 

Programming Languages –  

 C, C++, Mono, PHP, Python, Perl, Ruby, TcL 

 

Check your progress – 1 

a) A computer has the ability to ……………., …………… and …………….. data. 

b) Program is a set of ………………. 

c) An ……………. device is puts information inside the computer. 

d) There are ………………. function keys. 

e) …………… device converts the document image into digital form. 

f) …………. Computer is a device that works on continuous range of values and            

……………computer operates on digital data. 

g) ……………………. Is regarded as the father of computer. 

h) First generation computers relied on …………………… 

 

  

1.3   COMPUTER MEMORY  

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define computer memory 

ii. Explain types of computer memory 

 

The computer memory is a temporary storage area. It holds the data and instructions that the 

Central Processing Unit (CPU) needs. Before a program can be run, the program is loaded from 

some storage medium into the memory. This allows the CPU direct access to the program. 

Memory is a need for any computer. 

http://en.wikipedia.org/wiki/Xfce
http://simple.wikipedia.org/wiki/Temporary
http://simple.wikipedia.org/wiki/Storage
http://simple.wikipedia.org/wiki/Area
http://simple.wikipedia.org/wiki/Information
http://simple.wikipedia.org/wiki/CPU
http://simple.wikipedia.org/wiki/Computer_program
http://simple.wikipedia.org/wiki/Load
http://simple.wikipedia.org/wiki/Storage_medium
http://simple.wikipedia.org/wiki/Computer
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The CPU calls instructions and data from the computer's memory. Because the same computer 

performs different tasks at different times, the memory is erasable—much like audio cassette. 

But there are some programs and instructions which the computer needs. It does not matter what 

function you are performing. These programs often are permanently recorded in the memory. So 

they cannot be destroyed. As a result, the computer's memory usually consists of two parts: 

 

PRIMARY MEMORY –  

Primary Memory (also called main memory) is used for immediate access of data by the 

processor. While primary memory storage demonstrates faster processing ability, it is costly and 

hence is not largely used for data storage. Most computer systems around the world use primary 

memory only for bootstrapping and related purposes, and use secondary memory devices for 

personal data storage purpose.  

Primary Memory can be divided into two types - Random Access Memory (RAM) and Read 

Only Memory (ROM).  

RAM retains its contents as long as the power supply is on. A RAM chip is used as primary 

memory in most computers today. However, older computers (in the '80s) used ROM devices 

memory 

primary 
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PROM EPROM EEPROM 
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Punching 
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(CD/DVD) 
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(floppy disks, magnetic tapes, paper clips or punches; but more prominently floppy disks) as 

primary memory mechanisms. 

 

RAM – 

RAM stands for Random Access Memory also referred to as main memory, primary memory 

or system memory.  RAM refers to read and write memory that is you can both write data into 

RAM and read data from RAM. RAM is volatile, which means that it requires a steady flow of 

electricity to maintain its contents. As soon as the power is turned off, whatever data was in 

RAM is lost. A computer's RAM is the memory used to store data and programs on a temporary 

basis. The amount of RAM directly affects a computer‘s performance. The more RAM a 

computer has, the more programs and documents it can open without slowing the system down. 

Current PC computers have anywhere from 256 MB of RAM or 256 million bytes of memory a 

program can use, to as much as 4 GB of RAM. Mac computers generally have between 128 and 

512 MB of RAM. 

 

There are primarily two forms of RAM:  Static RAM (SRAM) and  Dynamic RAM (DRAM). 

 

 Static RAM: The most expensive of the lot, SRAM uses bistable latching circuitry to 

store one bit each, and hence is faster than its counterpart. Its high price prevents it from 

being widely used in everyday computing machines, but many modern machines use 

SRAM as the processor's cache register. 

 Dynamic RAM: Widely used in modern computers as primary memory, DRAM is 

slower than SRAM, but is inexpensive due to its one transistor-one capacitor paired 

assembly of memory storage. 

 

ROM – 

ROM stands for Read Only Memory. ROM is a type of "built-in" memory that is data can only 

be accessed and read by the user, not overwritten, upgraded or modified. The system programs 

stored on a ROM device could never be altered and hence, stayed secure for use. ROM is non-

volatile which means it keeps its contents even if the power is cut off.  In addition, ROMs are 

http://www.webopedia.com/TERM/R/RAM.html
http://www.webopedia.com/TERM/R/read.html
http://www.webopedia.com/TERM/W/write.html
http://www.webopedia.com/TERM/W/write.html
http://www.webopedia.com/TERM/R/read.html
http://www.computerhope.com/jargon/n/nonvolat.htm
http://www.computerhope.com/jargon/n/nonvolat.htm
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used extensively in calculators and peripheral devices such as laser printers, whose fonts are 

often stored in ROMs. 

 PROM (programmable read-only memory): A PROM is a memory chip on which you 

can store a program. But once the PROM has been used, you cannot wipe it clean and can 

not use it to store something else.  

 EPROM (erasable programmable read-only memory): An EPROM is a special type 

of PROM that can be erased by exposing it to ultraviolet light. 

  EEPROM (electrically erasable programmable read-only memory): An EEPROM is 

a special type of PROM that can be erased by exposing it to an electrical charge. 

 

SECONDARY MEMORY – 

Secondary memory is available on mass storage devices for permanent data storage. Data stored 

on a secondary device is retained even when it is not supplied any power. This data can be 

transported in most cases, and looks and appears the same on any machine, irrespective of where 

the data was first copied onto the secondary storage device.  

Secondary memory is not directly accessible by the computer. When a computer needs to run or 

execute an application stored in secondary memory, it first brings it to primary memory storage 

for a while, to control and carry out its execution. Once execution of the application is done, the 

processor releases the application and restores its control and memory data with the secondary 

memory devices.  

 The essential data storage techniques of the '50s and '60s where punch tapes and punch 

cards. 

Punch Tapes: A 0.1 mm thick paper strip was used to store data in the form of punched 

holes. A keyboard was used to punch the desired alphabet onto the tape. This alphabet 

was represented on the tape by a certain number and a select pattern of holes. 

Punch Cards: Primarily used in textile and handloom industries, punch cards stored 

instructions of operation for machines. Early digital computers made punch cards popular 

as data storage assemblies. Their working is pretty much similar to that of punch tapes, 

except for the fact that instead of paper strips, this technique uses cards about 3¼ inches 

× 7⅜ inches in size.  

http://www.webopedia.com/TERM/C/calculator.html
http://www.webopedia.com/TERM/P/peripheral_device.html
http://www.webopedia.com/TERM/L/laser_printer.html
http://www.webopedia.com/TERM/F/font.html
http://www.webopedia.com/TERM/P/PROM.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/E/EPROM.html
http://www.webopedia.com/TERM/E/EEPROM.html
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 Magnetic tape – Magnetic tape is a recording technique invented in 1928. This formed 

the basis for magnetic digital information storage. This form of data storage gained 

immense popularity in the '70s, when magnetic tapes were wound around 10.6-inch reels. 

The device used for the read-write operations on these tapes is called a tape drive. Until 

the early 1980s, magnetic tape drives were huge external devices. With the introduction 

of IBM's 3480 family of magnetic tape cartridges, most magnetic tape storage assembly 

went inside the central processing unit.  

 Floppy Disk - The floppy disk memory technique uses a thin plastic-coated film covered 

with magnetic material. It is covered with a protective plastic cover. Initially developed 

by IBM as inexpensive microcode feeders in 1967, floppy disks were made commercially 

available in 1971 to the public. Floppy disks began as giant 8-inch diskettes, and 

eventually evolved into 5¼-inch diskettes, and later 3½-inch diskettes. 

 Optical Drives (CD/DVD) - Philips and Sony collaborated in the '70s on a project to 

create a new digital audio disc. This collaboration brought together the optical disc drive 

technologies both the companies were earlier separately working on. Launched in 1982-

83, the Compact Disc (CD) eventually went on from being an audio disc to a data storage 

device.  

 Hard Disc Drives - The dominant technique for storing data in current times, a hard disk 

consists of rapidly rotating discs with a magnetic head to read and write data. Data can be 

accessed randomly. HDDs were introduced by IBM (Yes, again IBM!) around the late 

1950s for real-time transaction processing machines. A few years later, IBM 

commercially launched the IBM 1311 model, which was almost as big as a dishwasher, 

and had the capacity to store about 2 million characters. 

 Flash drives - A flash drive is a data storage device that uses flash memory for storage 

purposes. Typical in design, flash drives are light-weight and small in design; and are 

hence easily portable. Flash drives operate from the power supplied by a computer's USB 

port (the port in which they are plugged in). The data on it can be erased and re-

programmed as per the user's requirements. Low cost, minimal power consumption, and 

portable features make flash drives extremely desirable and popular in modern times. 
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Check your progress – 2 

 

a) The CPU calls instructions and data from the computer's ………………. 

b) ………….. Memory is used for immediate access of data by the processor. 

c) A computer's …………… is the memory used to store data and programs on a temporary 

basis. 

d) …………… is a type of memory that is data can only be accessed and read by the user. 

e) ……………… memory is not directly accessible by the computer. 

f) ………………….. is a recording technique invented in 1928. 

g) A ……………… is a data storage device that uses flash memory for storage purposes. 

 

 

1.4   COMPUTER LANGUAGE AND ITS TYPES  

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define computer language 

ii. Explain different types of computer languages 

 

Computer languages are the languages by which a user command computer to work on the 

algorithm which a user has written to get an output.  

 Why we need computer language? Because, computer understands only the computer language, 

the computer don‘t understand our languages like English, Hindi, Punjabi etc. So we have to give 

instructions in one of the computer languages. 

 

Types of Computer Language  

To communicate with the computer user also needs to have a language that should be understood 

by the computer. As we human beings communicate with each others in different language such 

as Urdu, French, Punjabi and Arabic etc. Similarly to communicate with the computers we have 

to use specific languages and for this purpose, different languages are developed for performing 

different types of work on the computer. Basically, languages are divided into two categories. 
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        1. Low Level Languages. 

        2. High Level Languages. 

 

LOW LEVEL LANGUAGES – 

Low-level languages are considered to be closer to computers. Programs and applications written 

in low-level language are directly executable without any interpretation or translation. Low level 

computer languages are machine codes. Computer cannot understand instructions given in high 

level languages or in English. It can only understand and execute instructions given in the form 

of machine language i.e. language of 0 and 1. There are two types of low level languages: 

 Machine Language. 

 Assembly Language 

 

Machine Language –  

It is the lowest and most elementary level of Programming language and was the first type of 

programming language to be developed. Machine Language is basically the only language which 

computer can understand, which is represented inside the computer by a String of binary digits 

(bits) 0 and 1. The symbol 0 stands for the absence of Electric pulse and 1 for the presence of an 

electric pulse. Since a computer is Capable of recognizing electric signals, therefore, it 

understands machine Language. 

Advantages of Machine Language 

 It makes fast and efficient use of the computer. 

 It requires no translator to translate the code i.e. Directly understood by the computer 

Disadvantages of Machine Language: 

 All operation codes have to be remembered 

 All memory addresses have to be remembered. 

 It is hard to amend or find errors in a program written In the machine language 

 These languages are machine dependent i.e. a particular Machine language can be used 

on only one type of computer 
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Assembly Language –  

Assembly languages have the same structure and set of commands as machine languages, but 

they enable a programmer to use names instead of numbers. This is another low level but a very 

important language in which operation codes and operands are given in the form of alphanumeric 

symbols instead of 0‘s and l‘s. These alphanumeric symbols will be known as mnemonic codes 

and can have maximum up to 5 letter combination e.g. ADD for addition, SUB for subtraction, 

START, LABEL etc. Because of this feature it is also known as ‗Symbolic Programming 

Language‘. This language is also very difficult and needs a lot of practice to master it because 

very small English support is given to this language. 

In the early days of programming, all programs were written in assembly language. Programmers 

still use assembly language when speed is essential or when they need to perform an operation 

that isn't possible in a high-level language. 

Advantages of Assembly Language 

 It is easier to understand and use as compared to machine language. 

 It is easy to locate and correct errors. 

 It is modified easily 

Disadvantages of Assembly Language 

 Like machine language it is also machine dependent. 

 Since it is machine dependent therefore programmer should have the knowledge of the 

hardware also. 

 

HIGH LEVEL LANGUAGE – 

A programming language such as C, FORTRAN or Pascal that enables a programmer to 

write programs that are more or less independent. Such languages are considered high-level 

because they are closer to human languages. The main advantage of high-level languages 

over low-level languages is that they are easier to read, write, and maintain.  

High level computer languages give formats close to English language and the purpose of 

developing high level languages is to enable people to write programs easily and in their own 

native language environment (English). High-level languages are basically symbolic languages 

that use English words and/or mathematical symbols rather than mnemonic codes.  

http://www.webopedia.com/TERM/C/command.html
http://www.webopedia.com/TERM/P/programmer.html
http://www.webopedia.com/TERM/N/name.html
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As computer does not understand the high level language so, programs written in a high-level 

language are translated into machine language by a compiler or interpreter. The first high-level 

programming languages were designed in the 1950s.  

 

The various High – Level Languages are:- 

 BASIC – Beginners All Purpose Symbolic Instruction Code  

 FORTRAN – Formula Translation  

 COBOL – Common Business Oriented Language  

 PASCAL – Named after Blaisé Pascal  

 C – The latest and most powerful language. 

Advantages of High Level Language 

 User-friendly 

 Less time is required to write the program. 

 Easier to learn 

 Easier to maintain. 

 Program written in High level language are easier to debug the error. 

 Program written in high level language are largely machine independent. 

 Program developed on one computer can be run on another with little or no modification. 

Disadvantages of High Level Language 

 A high-level language has to be translated into the machine language by a translator and 

thus a price in computer time is paid. 

 The object code generated by a translator might be inefficient Compared to an equivalent 

assembly language program 

 A long sequence of statements is to be written for every program 

 

Check your progress – 3 

 

a) Computer understands only the ……………… language. 

b) Programs and applications written in ……………………… are directly executable. 

c) …………………. is the only language which computer can understand. 

http://www.webopedia.com/TERM/C/compiler.html
http://www.webopedia.com/TERM/I/interpreter.html
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d) …………………..enable a programmer to use names instead of numbers. 

e) …………………… are  symbolic languages that use English words and/or mathematical 

symbols. 

 

 

1.5   OPERATING SYSTEM 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define operating system 

ii. Explain DOS and windows 

iii. Explain security and antivirus 

 

An operating system is a program that manages the computer hardware. It also provides the basis 

for application programs and acts as an intermediary between a user of a computer hardware. 

Some operating systems are designed to be convenient, others to be efficient, and others some 

combination of two. 

 

What is an operating system? 

An operating system is an important part of almost every computer system. A computer system 

can be divided into four components:  the hardware, operating system, the application programs, 

and the users. 

The hardware (the central processing unit (CPU), memory and the input/output devices) – 

provides the basic computing resources. 

The application programs (such as word processors, spreadsheets, compilers and web browsers) - 

define the ways in which these resources are used to solve the computing programs for the 

various users. 

The operating system controls and coordinates the use of the hardware among the various 

application programs for the various users.  

http://www.webopedia.com/TERM/P/programmer.html
http://www.webopedia.com/TERM/N/name.html
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The components of the computer system are its hardware, software and data. The operating 

system provides the means for the proper use of these resources in the operation of the computer 

system. An operating system is similar to a government. Like a government, it performs no 

useful function by itself. It simply provides an environment within which other programs can do 

useful work.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                   Fig 1.8 what is operating system 

Operating systems perform basic tasks, such as recognizing input from the keyboard, 

sending output to the display screen, keeping track of files and directories on the disk, and 

controlling peripheral devices such as disk drives and printers. 

 

An Operating System can be of Three Types: 

 

 Single User MS-Dos, MS-Win 95-98, Win-ME 

 Multi User UNIX, Linux, XENIX 

 Network Novel Netware, Win-NT, Win-2000-2003 

 Single User: If the single user OS is loaded in computer‘s memory; the computer would 

be able to handle one user at a time. 

http://www.webopedia.com/TERM/I/input.htm
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http://www.webopedia.com/TERM/P/printer.htm
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 Multi user: If the multi-user OS is loaded in computer‘s memory; the computer would 

be able to handle more than one user at a time. 

 Network: If the network OS is loaded in computer‘s memory; the computer would 

be able to handle more than one computer at time. 

Microsoft is an American company that in 1975 was founded by Bill Gates and Paul Allen. The 

company headquarters in Redmond, Washington. Main activity is the development of basic 

computer software such as operating systems, development tools, office applications and 

databases.  

Operating systems that Microsoft has developed the firm are divided into two groups:  

 MS-DOS (Microsoft Disk Operating System) 

 Windows (Brand name for the Microsoft Windows operating system) 

 

1.5.1   DOS AND WINDOWS 

 

Operating systems provide a software platform on top of which other programs, 

called application programs, can run. The application programs must be written to run on top of 

a particular operating system. For PCs, the most popular operating systems are DOS, OS/2, 

and Windows but others are also available, such as Linux. 

 

DOS – 

DOS "Disk Operating System." DOS was the first operating system used by IBM-

compatible computers. It was originally available in two versions that were essentially the same, 

but marked under two different names. "PC-DOS" was the version developed by IBM and sold 

to the first IBM-compatible manufacturers. "MS-DOS" was the version that Microsoft bought 

the rights to, and was bundled with the first versions of Windows. 

 

MS-DOS (Microsoft Disk Operating System) is an operating system for x86-based personal 

computers. MS-DOS Originally developed by Microsoft for IBM, MS-DOS was 

the standard operating system for IBM-compatible personal computers.MS-DOS originally 

written by Tim Paterson and introduced by Microsoft in August1981. 
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http://www.webopedia.com/TERM/A/application.htm
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http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/X86
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http://www.webopedia.com/TERM/I/IBM.htm
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American computer programmer Timothy Paterson, a developer for Seattle Computer Products, 

wrote the original operating system for the Intel Corporation‘s 8086microprocessor in 1980, 

initially calling it QDOS (Quick and Dirty Operating System), which was soon renamed 86-

DOS. A year later, fledgling company Microsoft purchased exclusive rights to sell the system, 

renamed MS-DOS, to IBM for their newly developed IBM-PC. IBM-compatible versions were 

marketed as PC-DOS. Version 1.0 was released in 1981; additional upgraded versions kept pace 

with the rapidly evolving PC. Windows 95, introduced by Microsoft in 1995, incorporated MS-

DOS 7.0 but ultimately superseded the MS-DOS platform. Starting with Windows NT, 

Microsoft‘s operating systems were designed independently of MS-DOS, though they were 

capable of running some MS-DOS applications. 

 

Although MS-DOS enjoyed enormous popularity in the 1980s and early 1990s, the 

technology did not always keep pace with its competition. The system lacked the  

 Multitasking,  

 Multiuser capabilities of the UNIX operating system  

 Ms-dos was limited to a command line interface 

In contrast to the user-friendly graphical user interface (GUI) of the early Macintosh computer 

from Apple Inc. Although MS-DOS ceased to be marketed as a stand-alone operating system, the 

relatively simple, stable platform is still used in some embedded computer systems. 

Different version of DOS, such as 2.0, 3.0, 3.2, 4.0, 5.0, 6.0, 6.2, 6.22, 7.0, 7.2 are available.  The 

higher versions have more features and commands.  However, the basic commands and features 

are available in all versions. 

  

Structure information  

 16-bit operating system, (formerly 8-bit)  

 Single tasking  

 Command interpreter for internal and external commands  

 External driver software imbedding for periphery devices possible  
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System environment  

 Minimum: 512 kbytes RAM, 5 mbyte hard disk storage (depends on version for full 

installation)  

 FAT file system  

 Executable with every x86 compatible CPU  

 Low RAM and fixed storage disk needs  

 

Field of Application  

 Booting system for storage media  

 File management  

 For single user systems only  

 Network client (NetBEUI, IPX/SPX, TCP/IP)  

 Batch processing  

 

MICROSOFT   WINDOWS –  

 

Windows OS, computer operating system (OS) developed by Microsoft Corporation to run 

personal computers (PCs). Featuring the first graphical user interface (GUI) for IBM-compatible 

PCs, the Windows OS soon dominated the PC market. Approximately 90 percent of PCs run 

some version of Windows. 

The first version of Windows 1.0 was  introduced in 1985, was simply a GUI offered as an 

extension of Microsoft‘s existing disk operating system, or MS-DOS. Based in part on licensed 

concepts that Apple Inc. had used for its Macintosh System Software, Windows for the first time 

allowed DOS users to visually navigate a virtual desktop, opening graphical ―windows‖ 

displaying the contents of electronic folders and files with the click of a mouse button, rather 

than typing commands and directory paths at a text prompt. 

 

WINDOWS was similar to APPLE Mach operating system interface on IBM-PC. The main 

features of windows are  

 Easy to use graphical user interface (GUI) 

 Device independent graphics 

http://www.britannica.com/EBchecked/topic/130429/computer
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 Multitasking support. 

WINDOWS-95 released in 1995 is a 32-bit operating system which includes MS-DOS7.0 and 

takes control of computer system after starting.  

 

Versions of Microsoft's window operating system are: 

 Windows XP / Vista / 7 / 8 (home and professional versions for end users) 

 Windows Server (server versions of the extension as 'SQL Server', 'Exchange Server' and 

others) 

 Windows CE / Mobile / RT (special versions for Pocket PC - Mobile Devices)  

Advantages of using windows –  

 Ease of use 

 Available software 

 Support for new hardware. 

 Compatibility with MS driven websites. 

 

Disadvantages of using Windows 

 High resource requirements 

 Poor security 

 Virus susceptibility 

 Outrageous license agreements 

 Poor stability 

 

1.5.2   SECURITY AND ANTIVIRUS  

 

SECURITY –  

In the computer, the term security or computer security -- refers to techniques for ensuring 

that data stored in a computer cannot be read or compromised by any individuals without 

authorization. Most computer security measures involve data encryption and passwords.  

Data encryption is the translation of data into a form that is unintelligible done without 

converting the data.  

http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/R/read.html
http://www.webopedia.com/TERM/E/encryption.html
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A password is a secret word or phrase that gives a user access to a particular program or system. 

Computer security is the process of preventing and detecting unauthorized use of your computer. 

Prevention measures help you to stop unauthorized users (also known as "intruders") from 

accessing any part of your computer system. Detection helps you to determine whether or not 

someone attempted to break into your system, if they were successful, and what they may have 

done. 

Computer security is that branch of information technology which deals with the protection of 

data on a network or a stand-alone desktop. As every organization is dependent on computers, 

the technology of its security requires constant development. Here are the different types of 

computer security. 

There are essentially two major types of computer security – 

 

Software security - Software security usually consists of server protection and security, system 

security from viruses and other malicious software programs, and data security through theft 

prevention and safe computer practices. Computer network security can be disrupted or 

encroached in the following ways: 

 Trojan Horse - Trojan horse is common and one of the most potential threats to 

computer security. They are malicious and security-breaking programs. They are a useful 

tool for hackers who try to break into private networks. Hackers generally attach Trojan 

horse to a file, which triggers a virus or remotely controlled software, giving the hacker 

complete control over the computer. 

 Viruses and Worms - Viruses and worms are well-known for their destructive nature 

and the property of replicating themselves. They are basically pieces of computer 

program codes, which are written by hackers and other computer geniuses. 

 Sniffing - Sniffing is the act of intercepting TCP/IP packets while they are getting 

transferred on a network. The interception generally takes place through simple 

eavesdropping done by a hacker. 

 

Hardware security - Hardware security usually consists of physical devices, including server 

mainframes, computers, and external or portable memory and storage devices. 

 

http://www.webopedia.com/TERM/P/password.html
http://www.webopedia.com/TERM/U/user.html
http://www.webopedia.com/TERM/A/access.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/S/system.html
http://www.wisegeek.com/what-is-computer-security.htm
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Protection –  

The internet offers access to a world of products and services, entertainment and information. At 

the same time, it creates opportunities for scammers, hackers, and identity thieves. If malicious 

software infects your computer it can stop it working properly, can delete or corrupt your files 

and can allow others to access your computer and your confidential information. 

Computer facilities have been physically protected for three reasons: 

 To prevent theft of or damage to the hardware 

 To prevent theft of or damage to the information 

 To prevent disruption of service 

Strict procedures for access to the machine room are used by most organizations. 

Things you can do to protect your computer are: 

 Use security software 

 Practice the principle of least privilege (PoLP) 

 Maintain current software and updates 

 Frequently back up important documents and files 

Avoid threats to your computer 

 Never share passwords or passphrases 

 Do not click random links 

 Beware of email and attachments from unknown people 

 Do not download unfamiliar software off the Internet 

 Do not propagate virus hoaxes or chain mail 

 Log out of or lock your computer 

 Shut down lab/test computers 

 Remove unnecessary programs or services 

 Restrict remote access 

 Treat sensitive data very carefully 

 Remove data securely 

 Employ encryption whenever it is available 

 

http://kb.iu.edu/data/akln.html#top3
http://kb.iu.edu/data/akln.html#soft
http://kb.iu.edu/data/akln.html#polp
http://kb.iu.edu/data/akln.html#patch
http://kb.iu.edu/data/akln.html#backup
http://kb.iu.edu/data/akln.html#threats
http://kb.iu.edu/data/akln.html#pw
http://kb.iu.edu/data/akln.html#donotclick
http://kb.iu.edu/data/akln.html#attach
http://kb.iu.edu/data/akln.html#download
http://kb.iu.edu/data/akln.html#hoax
http://kb.iu.edu/data/akln.html#logout
http://kb.iu.edu/data/akln.html#shutdown
http://kb.iu.edu/data/akln.html#remove
http://kb.iu.edu/data/akln.html#restrict
http://kb.iu.edu/data/akln.html#sensitive
http://kb.iu.edu/data/akln.html#removedata
http://kb.iu.edu/data/akln.html#encrypt
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ANTIVIRUS – 

Antivirus is a utility that searches a hard disk for viruses and removes any that are found. Anti-

virus software is a program or set of programs that are designed to prevent, search for, detect, 

and remove software viruses, and other malicious software like worms, trojans, adware, and 

more. 

These tools are critical for users to have installed and up-to-date because a computer without 

anti-virus software installed will be infected within minutes of connecting to the internet. The 

bombardment is constant, with anti-virus companies update their detection tools constantly to 

deal with the more than 60,000 new pieces of malware created daily. 

There are several different companies that build and offer anti-virus software and what each 

offers can vary but all perform some basic functions: 

 Scan specific files or directories for any malware or known malicious patterns 

 Allow you to schedule scans to automatically run for you 

 Allow you to initiate a scan of a specific file or of your computer, or of a CD or flash 

drive at any time. 

 Remove any malicious code detected –sometimes you will be notified of an infection and 

asked if you want to clean the file, other programs will automatically do this behind the 

scenes. 

 Show you the ‗health‘ of your computer 

Always be sure you have the best, up-to-date security software installed to protect your 

computers, laptops, tablets and smartphones. 

 

Check your progress – 4 

a) The ………………….. controls and coordinates the use of the hardware. 

b) ………… was the first operating system used by IBM-compatible computers. 

c) DOS is a …………… operating system. 

d) ………………….. is a 32-bit operating system. 

e) ………………… is the process of preventing and detecting unauthorized use of your 

computer. 

f) Antivirus is a utility that searches a hard disk for ……….. and removes any that are 

found. 

http://www.webopedia.com/TERM/U/utility.html
http://www.webopedia.com/TERM/H/hard_disk.html
http://www.webopedia.com/TERM/V/virus.html
http://www.techterms.com/definition/operating_system
http://www.techterms.com/definition/ibmcompatible
http://www.webopedia.com/TERM/U/utility.html
http://www.webopedia.com/TERM/H/hard_disk.html
http://www.webopedia.com/TERM/V/virus.html
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Let Us Sum Up (Summary) 

1. Computers are machines that perform tasks or calculations according to a set of instructions, 

or programs. 

2. An input device is anything that puts information inside the computer such as Keyboard, 

Mouse, Scanner, Microphone etc.  

3. An input device is anything that display information such as Monitors, Printers, Audio 

Output Devices. 

4. There are three different types of computers based on the principles of operation analog, 

digital and hybrid. 

5. FOSS programs are those that have licenses that allow users to freely run the program for 

any purpose, modify the program as they want, and also to freely distribute copies of 

either the original version or their own modified version. 

6. Primary Memory (also called main memory) is used for immediate access of data by the 

processor. 

7. RAM stands for Random Access Memory that is both write data into RAM and read data 

from RAM. 

8. ROM stands for Read Only Memory that is data can only be accessed and read by the 

user. 

9. Secondary memory is available on mass storage devices for permanent data storage. 

10. Computer languages are the languages by which a user command computer to work on 

the algorithm which a user has written to get an output.  

11. Low level computer languages are machine codes. 

12. There are two types of low level languages: Machine Language and Assembly Language 

13. A high level language such as C, FORTRAN or Pascal that enables a programmer to 

write programs that is more or less independent. 

14. The operating system controls and coordinates the use of the hardware among the various 

application programs for the various users.  

15. Security or computer security refers to techniques for ensuring that data stored in 

a computer cannot be read or compromised by any individuals without authorization. 

 

 

http://www.webopedia.com/TERM/W/write.html
http://www.webopedia.com/TERM/R/read.html
http://www.webopedia.com/TERM/P/programming_language.html
http://www.webopedia.com/TERM/C/C.html
http://www.webopedia.com/TERM/F/FORTRAN.html
http://www.webopedia.com/TERM/P/Pascal.html
http://www.webopedia.com/TERM/P/programmer.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/R/read.html
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Answers  

 

Check your progress -1 

a) Store, retrieve and process 

b) Instruction 

c) Input 

d) Twelve 

e) Scanner 

f) Analog, digital 

g) Charles babbage 

h) Machine language 

  

Check your progress – 2 

a) Memory 

b) Primary 

c) RAM 

d) ROM 

e) Secondary 

f) Magnetic tape 

g) Flash drive 

 

Check your progress – 3 

a) Computer 

b) Low level language 

c) Machine language 

d) Assemble language 

e) High level language 

 

Check your progress – 4 

a) Operating system 

b) DOS 



43 
 

c) 16 – bit 

d) Windows 95 

e) Computer security 

f) Viruses  
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Course -7 Basic Computer Skills 

Unit-2 

WORD 

Windows, the operating system, helps to connect each element of personal computer 

together but it cannot  perform practical tasks such as letter writing and calculating bills. For 

these jobs we need some additional soft wares known as applications or programs that are 

designed to perform specific tasks. Most of the personal computers come with a package of 

programs which are already installed. One of the most popular packages is Microsoft Office. 

Office consists of several individual programs such as Word, Excel/Spreadsheet, Power-point 

and Outlook. They are quite sophisticated programs capable of doing tremendous tasks with 

    their array of  usage being very wide.  

2.1 Microsoft Word: 

Word is an extremely powerful word processor which is capable of producing ‗written‘ 

documents of all kinds including letters memos newsletters and posters. You have the option to 

create documents from scratch or for many types of documents to use one of the programs 

wizards or templates. The wizards let you chose the content and how the document looks while 

the templates have a preset layout. 

Opening the program: 

Opening a program and creating a new document will be among the first things you do on 

your computer. The process is similar in most programs of the MS family. To open a word 

document following steps should be applied-: 

Click the left mouse button once at the START at the bottom left of the screen 

1. Point at ALL PROGRAMS and click the left mouse button once so that some icons 

appear on the right 

2. Point at MS Office and click the left mouse button, and then press the ENTER key 
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As a result Microsoft Office word Document Window appears, filling the whole screen. 

At the top of the window is the blue Title bar, indicating that this is Document 1. Below that is 

the Menu bar, containing the names of various menus, and below the Menu bar are the two 

rows of buttons, and the Ruler. Down the right hand side and near the foot of the screen are the 

two scroll bars, with arrows at each end 

 

 

2.2 Creating a File: 

As we go to the File menu and click on NEW , a new file opens on the screen. This enables you 

to creat and modify documents with ease. Before starting typing one should first specify the size  

and orientation of the document, size of its margins, and size of the paper you want to print on. 

To do this go to the File menu and click on Page Setup. Click on the margin boxes and enter 

your settings, then click OK.  
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 To enter a text, just type on the keyboard. As you type, the words will appear at the 

cursor position on your screen. When you reach the end of a line, the text will automatically flow 

to the next line. To start typing on a new line before reaching the end of the current one press the 

Enter key on the keyboard and continue to type. If you make a mistake use Backspace key to 

delete the last character you have typed. The Backspace key is at the top right of the main part of 

the keyboard, marked with a left pointing arrow. 

2.3 Setting the text: Selecting text 

Open the file FOCUS. Choose the Open command from the File menu. Double-click on 

the file name FOCUS. 

Note that you could have opened the file as before, by clicking on the file name and then clicking on the 

Open button. Double-clicking on the name of the file is a useful shortcut. 

To delete a piece of text, or to make changes to it, the text must first be selected (highlighted). 

To select a word, double-click on it.  

To deselect a piece of text, click with the pointer somewhere else.  

To select a whole line, point in the left margin (the pointer becomes arrow-shaped) and click.  

To select a paragraph,  triple-click in the paragraph (not in the margin). Select the last paragraph in this 

way. 

To select a sentence, hold down the CTRL key and, keeping it depressed, click the left mouse button 

with the pointer somewhere in that sentence. This is known as "CTRL+click". Select the last sentence in 

this way. 

To select the whole text, choose the Select All command from the Edit menu. Try this. Alternatively, you 

can triple-click in the margin. 

To select a phrase, drag over it. For example, to select, move the pointer to the place from where to start 

highlighting press and hold down the left mouse button, and drag over the two words, letting go of the 

mouse button when both words are highlighted. 

Another way of selecting a phrase is by extending the highlight, using the SHIFT key. Place the insertion 

point in the first word to be selected, and then hold down the SHIFT key and, keeping it depressed, click 

the left mouse button with the pointer in the last word to be selected. This is known as "SHIFT+click".  
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To select part of a word, the highlight is extended using the SHIFT key in conjunction with the direction 

keys, marked with arrows. Place the insertion point before the first character to be selected, and then hold 

down the SHIFT key and, keeping it depressed, press the appropriate direction key. 

To move the insertion point up or down one page, click on the double upwards-pointing and double 

downwards-pointing triangles near the bottom of the vertical scroll bar. 

To move the insertion point to the beginning or end of the text, press CTRL+HOME or CTRL+END. This 

means "hold down the CTRL key and, keeping it depressed, press HOME or END".  

To move the insertion point to the beginning of a specified page, use the Go To command: 

• Choose the Go To command from the Edit menu; the Find and Replace dialogue box 

appears 

• Type 2 to go to page 2 

• Click on the Go To button to confirm your choice 

• Click on the Close button to make the dialogue box disappear 

At the foot of the screen, Word confirms that the insertion point is on page 2. Click a few times on the 

upwards-pointing scroll button to see that the insertion point is at the top of the page (indicated by a line 

of dots). 

Once the text is highlighted it is ready for setting or Style.  

Placing the insertion point: 

Use the mouse to move the I-beam pointer so that it is slightly to the left of the first letter of  the 

first line, and click the left mouse button. The insertion point should move to this position. 

Check that the insertion point is a flashing vertical bar and not a block. 

Inserting text: 

With  the  insertion  point  followed by a space,  notice the words moving along as new text  is 

inserted and the text is tidied so that the words do not overshoot the right-hand margin. 

Deleting text: 

Pressing the BACKSPACE key deletes the character to the left of the insertion point. To change 

1503 to 150, place the insertion point slightly to the right of 1503 and lightly press BACKSPACE. The 3 

should disappear. 
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Pressing the DELETE key deletes the character to the right of the insertion point. To delete the words in the 

last paragraph, place the insertion point to the left of these characters and keep pressing the DELETE key 

lightly until the words disappear. 

 

Inserting a new line: 

Place the insertion point immediately to the left of  the first line; again, check that the insertion 

point is a flashing vertical bar. Press ENTER twice: this inserts two blank lines at the top of the text. 

Place the insertion point on the first of the new blank lines and type whatever you want. 

Splitting a line: 

To split the first paragraph into two, place the insertion point just before I at the beginning of 

the sentence and press ENTER twice. If you accidentally split the line in the wrong place, you should 

press BACKSPACE immediately to delete the unwanted "enter" character. 

Joining lines: 

To join the two paragraphs, place the insertion point immediately after the last word of the 

first paragraph, and press DELETE twice. This deletes the two "enter" characters that were 

inserted when you pressed the ENTER key. 

It will be necessary to insert a space between the full stop and beginning of first letter of 

the next sentence. 

Font: 

 Window offers a range of fonts (particular styles of typing). Go to the format menu and 

click on Font. To view the list of fonts, click on the arrow. Click on your choice of font. 

Highlighted portion becomes in chosen font. If you find that the writing is rather small, and that the 

text occupies only part of the width of the screen, you can make the text easier to read, using the Zoom 

command from the View menu as follows: 

• Use the mouse to move the pointer so that it is pointing at the word View in the Menu 

Bar 

• With the tip of the arrow pointer on the word View, click the left mouse button once; the 

commands in the View menu appear. 
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• Use the mouse to move the pointer to the word Zoom in the View menu and click the left 

mouse button once; this action is known as "choosing a command". The Zoom window, 

or dialogue box, appears. 

• Use the mouse to move the pointer to the words Page width in the dialogue box and click 

the left mouse button once; a dot should appear to the left of these words 

• Use the mouse to move the pointer to the OK button in the dialogue box and click the left 

mouse button once; the dialogue box disappears and the text is now enlarged and extends 

across the full width of the screen 

 

Underline:  

 You can underline text in number of ways. Click on the arrow next to the Underline box. 

Scroll through the options and click on your choice. If you do not want text to be underlined 

ensure that None is selected. 

Effects:   

You are presented with a number of special effects that you can apply to your text. To 

choose one , click in the relevant box, a tick will appear. Click the box again to remove the 
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effect. Once you have chosen a font, you can also select a font style for it. Typically, you can 

choose whether your text appears in a regular format,  or in italics or in bold. To select a font 

style, click on your choice from the Font Style box.  

Size: 

The size of the box is measured in points. The greater the point size, the larger the text. 

However point sizes are not uniform across all the fonts. To alter the font size , scroll through 

and click on your choice in the Size box. A good thumb rule is not to use text smaller than 8pt, as 

it becomes difficult to read. 

Colour:  

To alter the colour of the text, click on the arrow next to the colour box, scroll through 

the colours and click on your choice. Remember that too many colours on one page may be 

overpowering.  

When you have finished editing a piece of text (or document) you should Close it. To do this, 

choose the Close command from the File menu as follows: 

• Click on the word File in the Menu Bar to pull down the File menu 

• Click on the word  Close  in the list of commands to choose that command 

The text and its window should disappear but you still have a copy of it on your file space. 

2.4  Editing And Page Formatting: 

Setting up a new piece of text: the New command: 

To set up a new piece of text, you must choose the New command from the File menu: 

• Click on File to pull down the File menu 

• Click on New to choose the New command 

On the right-hand side of the screen a list of possible kinds of New Documents appears: 

• Click on  Blank Document; a new, empty, document window will appear 

 

Type few.  Now  save this new document with the file name Doctor as follows: 
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• Pull down the File menu 

• Choose the Save command 

• Type the name Doctor in the File name box (the suggested name will disappear as 

soon as you start typing) 

• Click on the Save button 

Changing your mind about using a menu or dialogue box Making a menu 

disappear: 

Note that if you pull down a menu by mistake, you can make the menu disappear by clicking 

somewhere else on the screen. Try this as follows: 

• Pull down the Help menu by clicking on its title 

• Click somewhere else on the screen to make the menu disappear 

Making a dialogue box disappear: 

You can make a dialogue box disappear by clicking on the Cancel or Close button. Try this as 

follows: 

• Pull down the File menu 

• Choose the Open command by clicking on it 

• In the Open dialogue box, click on the Cancel button to make the dialogue box disappear 

Making changes to an existing file: the Open command 

Remember that the New command from the File menu is used for setting up a new piece of text. 

To edit an existing piece of text, the Open command is used. 

You have a file whose name is TARGET and which contains some mistakes. Open this document as 

follows: 

• Pull down the File menu 

• Choose the Open command 

The Open dialogue box appears, containing, amongst other items, a list of your Word files. To open 

TARGETS: 
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• Click on TARGETS to select (highlight) it 

• Click on the Open button 

The text of TARGETS appears on the screen, ready for editing. 

Moving and copying blocks of text: 

You might wish to move a block of text (a paragraph, or a phrase or word, for example) from one 

part of the document to another, or you might wish to copy a block of text several times. 

Moving a block of text: 

Text can be moved from one place to another within a document using the Cut and Paste 

commands from the Edit menu as follows: 

• Select the text to be moved 

• Choose the Cut command from the Edit menu 

A copy of the text goes to a special part of the computer's memory sometimes called the Clipboard. 

The contents of the clipboard can be pasted in the text as follows: 

• Move the insertion point to the place before which the text is to be inserted 

• Choose the Paste command from the Edit menu 

For example, try changing the order of the sentences in the last paragraph as follows: 

• Select the first sentence of the last paragraph (remember CTRL+click to select a sentence) 

• Choose the Cut command from the Edit menu 

• Click after the last sentence of the last paragraph 

• Choose the Paste command from the Edit menu 

Copying a block of text: 

Text can be copied in a similar way: 

• Select the text to be copied 

• Choose the Copy command from the Edit menu 

• Move the insertion point to the place before which the text is to be inserted 

• Choose the Paste command from the Edit menu 

The contents of the Clipboard may be copied several times, and a floating Clipboard box enables you to 

copy several different pieces of text which have been copied to the Clipboard. 
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Try inserting some extra instances of the words officially recorded before sets of triplets  and sets of 

quadruplets in this way. 

Placing the contents of one file into another: 

You might wish to place a copy of one file into another; for example, you might wish to put a 

copy of a file containing an address into a file containing a standard letter. To place a copy of a file into 

the text in the document window: 

• Move the insertion point to the place before which the text is to be inserted 

• Choose the File command from the  Insert menu (not the Open command from the File 

menu) 

• In the File dialogue box, click on the name of the file to be inserted 

• Click on the Insert button 

More shortcuts: using the Standard Toolbar The New, Open and Save 

commands: 

    The Standard Toolbar is just below the Menu Bar, and it too contains a series of buttons which can be 

used to speed up your work. For example, the group of three buttons at the left-hand end can be used to 

give the New, Open and Save commands, thus by-passing the File menu. 

    Point at each of these buttons in turn, slowly, and the ScreenTip will indicate the name of each button. 

 

Try clicking on the middle button of this group of three (shaped like a folder); the Open dialogue 

box appears. Close the dpen dialogue box by clicking on the Cancel button or by pressing the ESCAPE key. 

Change the Print button as follows: 

• Choose the Customize command from the Tools menu 



54 
 

• Click on the Commands "tab" in the tab dialogue box 

• Scroll down the list of commands on the right and notice that there are two Print buttons 

available: Print and Print... 

• Remove the Print button from the real toolbar by dragging it down into the text 

• Add the Print button to the toolbar by dragging it from the dialogue box up to the real 

toolbar, next to the Save button 

• Click on Close to confirm choice 

The Close and Exit buttons: 

If you have used MS-Office before you will know that at the three buttons at the very top right on 

the screen can be used to Minimize the window, Resize or Maximise  the window, and Close the window. 

If there are two Close (X) buttons on the screen, the lower one is a shortcut to the Close command (the 

current document is closed) and the upper one is a shortcut to the Exit command (for leaving Word). 

• Click on the Close button to close the current document, and do not save the changes 

Normal View and Print Layout View: 

Open TARGET using the Open button. 

MS-Office displays the text in Normal View (this is what has been used up to now in the course) and also 

in Outline View or in Print Layout View. Although some people prefer to work in Print Layout View, the 

author of these notes prefers Normal View, and these notes assume that the reader is using Normal View 

at present. 

Pull down the View menu and check that the "button" to the left of the Normal command is highlighted. 

If a different button is highlighted, then the wrong view is selected; choose the Normal command to 

return to the Normal View. 

Five buttons near the bottom left of the screen (above the Page number) provide a shortcut to these 

commands: point at each one in turn and notice that the ScreenTip shows that they are, from left to right, 

Normal View, Web Layout View, Print Layout View, Outline View, Reading Layout. The leftmost of 

these buttons should be highlighted. 

More shortcuts: autocorrect: 

Without closing already opened file, use the New command or button. Try to type the 

following piece of text exactly and see what happens: 

(c) 1/2 1st <=> :) 
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Now try the following (complete with deliberate mistakes): 

Teh CAt sat onthe MAt on a monday. 

he was affraid i think. 

Office may automatically correct some of your mistakes and this can be a useful feature. Sometimes, 

however, you will not want the change to be made. For example, to prevent Office from automatically 

changing (c) to © try the following: 

• Choose the AutoCorrect Options command from the Tools menu 

• Click on (c) to select it 

• Click on the Delete button 

• Look at the other options in the AutoCorrect dialogue box 

• Click on the OK button 

• Try to type (c) again 

Close the current piece of text without saving it.  

Working in inches rather than centimetres: 

Your system may have been arranged so that the Ruler is marked off in centimetres, whereas the 

tab stops (faint marks on the bottom of the Ruler) are every half an inch. It may be sensible, therefore, to 

arrange for the Ruler to be marked off in inches. Do this as follows: 

• Choose the Options command from the Tools menu 

• In the Options dialogue box, bring the General index card to the front 

• At the foot of the "card", there is a section which deals with Measurement units; click on 

the V to the right of Centimeters 

• Click on Inches in the drop-down list 

• Click on the OK button 

The Ruler should now be marked off in inches. 

 

 

The margins: 

The default margins: 

By default, the text is printed with a top and bottom margin of 1 inch each, and with a left and a 

right margin of 1.25 inches. The margins remain the same for the whole document, although the indent 

can be changed relative to the margins. 
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Changing the margins: 

To change the margins: 

• Choose the Page Setup command from the File menu 

• In the Page Setup dialogue box, ensure that the Margins index card is at the front 

• Change the Top, Bottom, Left and Right margins as appropriate, either by typing the new 

value or by pressing UP and DOWN 

• Click on the OK button 

The margins should not be set at less than half an inch, as many laser printers cannot print very near to the 

edge of the paper. 

Special characters: 

Office allows you to include many special characters which do not appear on the keyboard. For 

example, to type the character n 

• Choose the Symbol command from the Insert menu 

• Check that the Symbols index card is at the front and change the fount to Symbol ("font" 

is the American spelling of the English word "fount") 

• In the Symbol dialogue box, scroll down until you see on the square containing a n and 

then click on it 

• Click on the Insert button Try this. 

Special characters can be selected from other founts: scroll down the list in the Font box. 

For accented characters, change the fount to (normal text) (at the top of the fount list). 

Finally, click on the Close button to close the Symbol dialogue box; there is no need to close this dialogue 

box after each special character has been inserted, although it will be necessary to make the document 

window and the Symbol window active in turn by clicking in them. 

 

2.5 Printing and previewing the text: 

Print preview: 

It is important to preview your text before you print it, to check that the layout is correct, and that 

there are no headings at the foot of a page. 
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Preview the file is as follows: 

• Choose the Print Preview command from the File menu 

A representation of the page appears on the screen. To see the next page, press PAGE DOWN, and to see the 

previous page, press PAGE UP.  

Use the mouse pointer to point at the page; it is in the shape of a magnifying glass. Click in the page for a 

magnified view. Use the scroll bar to move around the document. 

With the mouse pointer still in the shape of a magnifying glass, click in the document again to see a 

representation of the whole page. 

Return to the normal view by clicking on the Close button on the Toolbar. 

Close the file by choosing the Close command from the File menu. 

Printing the text: 

Open the file TARGET 

• Choose the Print command from the File menu; the Print dialogue box appears  

• Unless you wish to go ahead with printing, click on the Cancel button 

Printing only part of a document: 

As mentioned above, long pieces of text such as books or theses should be divided into several 

files, perhaps one chapter per file. Often it will be necessary to make a small change to one page, and you 

will not wish to print the whole file. To print only part of the document: 

• Choose the Print command from the File menu 

• In the Page range section of the Print dialogue box, click on the Pages button 

• Type the numbers of the pages to be printed as indicated by MS-Office 

• Click on the OK button to confirm your choice 

The Save command Choosing Save from the File menu: 

When you have finished typing or editing a piece of text, you must save it so that you have a 

permanent copy of it. 
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Using the mouse, point at the word File in the Menu Bar and click the left mouse button. The File menu 

appears, with the commands New, Open, Close. Choose the Save command by clicking on it. If all goes 

well, the Save As dialogue box appears. 

2.6 Saving the text: 

The File name box contains a suggested name for the file. Give the file a shorter name, 

TARGET, as follows: 

• Type the word TARGET (as soon as you start typing, the highlighted contents of the File 

name box will disappear) 

• Click on the button labelled Save to confirm that you wish to save the file as TARGET  

The dialogue box disappears and after a few seconds the name of the file TARGET.doc appears in the 

title bar of the document window. The .doc extension indicates that the file was created using MS-

Office. 

If your text already has a name when you use the Save command, MS-Office will save the text 

with the same name and the old version will be lost. Make some changes to the text. Now choose the Save 

command from the File menu again. This time no dialogue box appears, because MS-Office does not 

need to ask for a file name and the text is saved as TARGET again. The old version is lost. 

You may wish to save the changes in a file with a new name, so that there are two versions of the 

text. This time, choose the Save As command from the File menu. The Save As dialogue box appears, 

with the current name, TARGET, highlighted in the File name box. To give the text a new name, type 

FOCUS  and the highlighted old name disappears as soon as you start typing. Click on the Save button 

to confirm the new name. There are no more changes to be made to this text, so the window should be 

closed as before, by choosing the Close command from the File menu. 

2.7 Save an MS-Office Word file in another file format: 

We can save MS-Office Word documents to any of several file formats. You cannot use MS-

Office to save a document as a JPEG (.jpg), GIF (.gif) file, and as a PDF (.pdf) file. Click the 

Microsoft Office Button and then click Save As. To view all of the possible file formats, in the 

Save As dialog box, click the arrow to the right of the Save as type list, and then click the file 

type that you want. The list of various type of files is given below: 

FOR THIS TYPE OF FILE CHOOSE 
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.docx Word Document 

.docm Word Macro-Enabled Document 

.doc Word 97-2003 Document 

.dotx Word Template 

.dotm Word Macro-Enabled Template 

.dot Word 97-2003 Template 

.pdf PDF 

.xps XPS Document 

.mht (MHTML) Single File Web Page 

.htm (HTML) Web Page 

.htm (HTML, filtered) Web Page, Filtered 

.rtf Rich Text Format 

.txt Plain Text 

.xml (Word 2007) Word XML Document 

.xml (Word 2003) Word 2003 XML Document 

.wps Works 6.0-9.0 

In the File name box, type a name for the file. Click Save. File will be saved in the desired 

format. 

2.8 How to create a new folder: 

 

When saving a document you are working on in Microsoft Office, you are prompted to 

enter a name for the new file. After you enter the name of the file, file is saved in the current 

folder. To move it to another folder or directory, or create a new folder in which to save the file, 

following instructions are to be followed: 

 

1.  Click File and Save as. The Save as dialog box appears. 
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2.  Look in the upper-right corner of the Save as dialog box. The folder with 

a star burst is the button to create a New Folder. Before clicking on the 

New Folder icon, look at the directory and drive that is open. If this is the location where you 

want to create a new folder, then skip to Step 4. If you want to create the new folder in a 

different directory or drive, then go to Step 3. 

 

3.  Consider where you want to create the new folder. On the top of the 

Save as dialog box is a Save in box that indicates what folder or directory is currently open. To 

change that location to another folder or directory, click the down arrow at the end of the Save in 

box and then choose the new location. You can also click on the Up one level icon, which is 

depicted in the upper-right portion of the dialog box as a file folder with a blue arrow. 

 

4.   Click the New Folder icon button and the New Folder dialog box appears with an open box 

into which to type the desired name for the new folder. After typing in the new folder name, 

click OK. The Save as dialog will then display the new folder as the save-as location. 

 

5.  Enter the name for the document and then click Save to save the file in the folder.  

2.9 Tables and tabs using the tab stops and the TAB key: 

The TAB key, marked with two horizontal arrows, is used to type tables with columns lined up. If 

variable-pitch characters (as in these notes) are being used, it is essential to use tabs, otherwise the 

columns (although they may look neat in the document window) will not be lined up when the document 

is printed. 

By default, tab stops are set every 0.5". The faint marks on the lower part of the Ruler indicate the 

position of these default tab stops. Pressing the TAB key makes the insertion point move from tab stop to 

tab stop. Each time you press the TAB key, a tab character is inserted into the text. Tab characters can be 

deleted in the usual way, using the BACKSPACE or DELETE key. Try some experiments. 

In a table it is essential to press SHIFT+ENTER at the end of each line (apart from the last). 

Why use SHIFT+ENTER? 

When SHIFT+ENTER is pressed, Office starts a new line, but not a new paragraph. 
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One of the reasons for pressing SHIFT+ENTER at the end of a line in a table is that the whole table (not each 

line separately) will be treated as a paragraph. Office allows you to keep all the lines of one paragraph 

together, so that the paragraph (in this case a table) will not be split at a page break. 

If the non-printing symbols are not visible, ask Office to indicate where TAB, ENTER and SHIFT+ENTER were 

pressed by clicking on the f button in the Standard Toolbar. 

Office indicates where TAB was pressed by means of horizontal arrows, and where SHIFT+ENTER was 

pressed by means of bent left-pointing arrows. 

Preventing a table from being split: 

As already noted, MS-Office automatically divide long pieces of text into pages, and this can 

result in a table being split. To prevent this: 

Select the whole table 

Choose the Paragraph command from the Format menu Ensure that the Line and Page Breaks index card 

is at the front In the Pagination section, click in the Keep lines together box Click on the OK button Try 

this. 

Setting your own tab stops: 

To set your own tab stops: 

•       Click on the lower part of the Ruler (below the dots) in the place where the new tab stop is 

required 

In the Ruler, a L will indicate the position of the new tab stop. Try clicking in the Ruler at 1" and 3.5". 

Provided you pressed SHIFT+ENTER at the end of every line, the columns will move across to obey the new 

tab stops.  

2.10 Bullets and numbering: 

Arrange for the references to have bullets as follows: 

• Select the paragraphs containing the references 

• Choose the Bullets and Numbering command from the Format menu; the Bullets and 

Numbering dialogue box appears, with four "index cards" labelled Bulleted, Numbered, 

Outline Numbered and List Styles. Check that the Bulleted "index card" is at the front 

• Click on one of the types of bullet 

• Click on the OK button 

Arrange for the references to be numbered as follows: 
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• Select the paragraphs containing the references 

• Choose the Bullets and Numbering command from the Format menu; the Bullets and 

Numbering dialogue box appears 

• Click on the "tab" of the Numbered "index card" to bring it to the front 

• Click on the required style of numbered list 

• Click on the OK button 

2.11 Inserting the page number, date or time: 

Choose the Header and Footer command from the View menu. 

In the Header and Footer Toolbar there are three useful buttons which make it possible to have, as well as 

text, the following in the header or footer: 

• Insert Page Number (marked with a # sign) 

• Insert Date (marked with the numbers 8 and 7) 

• Insert Time (marked with a clock) 

To include any of these in the header or footer: 

• Move the insertion point to the required position in the line, using the TAB key 

• Click on the appropriate button 

• Click on the Close button of the Header and Footer Toolbar to return to Normal View 

Changing the page numbering: 

If a long document such as a dissertation is to be produced, it may be sensible to break it into 

small files of not more than, say, 15-20 pages each, 

 

for ease of handling. 

MS-Office automatically starts the page numbering from 1, so it will be necessary to change the first page 

number of the second and subsequent documents. To do this: 

• Choose the Page Numbers command from the Insert menu 

• In the Page Numbers dialogue box, click on the Format button 

• In the Page Number Format dialogue box, type the number of the first page in the Start at 

box 
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• Click on the OK button in the Page Number Format dialogue box 

• Click on the Close button in the Page Numbers dialogue box (not the OK button, 

because that might insert a new page number at the bottom right of the page) 

Use Print Preview to see the effect of this. 

Notice that, in the Page Number Format box, you can also change the format of the page numbers,* for 

example to i ii i i i o r  A B C .  

A simpler way of inserting page numbers: 

Open the file Crystal by choosing that from the File menu. 

If only the page number is required, rather than the more complicated headers and footers described 

above, then a simpler method may be used as follows: 

• Choose the Page Numbers command from the Insert menu 

• In the Position section of the Page Numbers dialogue box, click on the V for a drop-down 

list and then click on the required position for the number (Top of Page or Bottom of 

Page) 

• In the Alignment section of the Page Numbers dialogue box, click on the V for a drop-

down list and then click on the required alignment for the number (left, centred, right and 

so on) 

• Click on the OK button to confirm your choice 

MS-Office will automatically change to Print Layout View so that you can see the effect of this. 

To arrange for the first page to be unnumbered (as for the first page of a letter, or first page in a chapter): 

• Choose the Page Numbers command from the Insert menu 

• Click on   Show number on first page   so that the box no longer contains a tick 

• Click on the OK button 

2.12 Using the spelling and grammar checker: 

Close this piece of text without saving the changes and then open the file.  To check the spelling 

in a piece of text: 

• Place the insertion point at the beginning of the text to be checked 

• Choose the Spelling and Grammar command from the Tools menu 
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The Spelling and Grammar dialogue box appears and the first word not recognized by MS-Office is 

highlighted in the text. There may be a list of suggested alternative spellings. 

If the word is correctly spelled: 

• Click on the Ignore button 

If the word is incorrectly spelled, but the correct version appears in the Suggestions list: 

• Click on the correct version to select it 

• Click on the Change button 

If the word is incorrectly spelled, but the correct version does not appear in the 

Suggestions list: 
 

• Type the correct version in the Not in Dictionary box 

• Click on the Change button 

 MS-Office may also complain about your grammar (not always appropriately). If you agree with the 

complaint, edit the text in the upper box and then click on the Change button. 

If you do not want MS-Office to check grammar for you, simply click on the Check grammar check box 

so that the tick disappears. 

                      

2.13 Indenting: 
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There are two types of indents that can be adjusted: paragraphs and bullet points. Each 

has a separate way of adjusting the indent size. Below are the different ways you can adjust the 

indentation in Microsoft Word. 

First line indent with tab: 

You can also access the Bullet and Numbering window by placing your text cursor on a 

bulleted or numbered line and right-clicking on the Word document. The first line indent can 

always be created using the Tab key on the keyboard. To change the first line indent size or 

indent the full paragraph, following steps should be followed: 

Adjusting indents using the ruler: 

To adjust a paragraph indent size, use the Ruler, which is just below the menu bar and 

resembles the picture shown below. If this feature is not visible, see our document on how to 

enable the Ruler. Towards the left side of the Ruler, look for indent markers that resemble an 

hourglass, like the image shown below. 

                                 

The top marker (down arrow) controls the first line indent, the middle marker (up arrow) controls 

the hanging indent, and the bottom market (small box) controls the left indent. To adjust these 

indents, you can click and drag each marker to the right or left. 

Changing indents in the Paragraph window: 

Another way to adjust the indents is to view the Paragraph settings. To view this window 

double-click on the markers in the Ruler, click Format and then Paragraph, or with the cursor 

in the paragraph right-click and chose Paragraph. As seen below, in the Paragraph window, the 

http://www.computerhope.com/jargon/t/tab.htm
http://www.computerhope.com/issues/ch001352.htm
http://www.computerhope.com/issues/ch001352.htm
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left and right indentation, the first line indent, and hanging indent size can all be adjusted. The 

hanging and first indent line settings are found under Special in the Indentation section. 

                           

At the bottom of the Paragraph settings window, you can preview the look of the indent sizes 

you are setting and make changes accordingly until you get it the way you want. 
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Adjusting the bullet and numbering indentation: 

To adjust the indenting for bullet points, place you text cursor in a bulleted or numbered 

line in Microsoft Word. Then, in the Format menu, click on Bullets and Numbering.  In the 

Bullets and Numbering window, click on the Customize button on one of the first three tabs, 

depending on the type of list you are changing the indentation for. 

                               

In the next window that opens, you can adjust the indent size for the bullet position and the text 

position. At the bottom of that window, you can preview how the indentation sizing will look 

and make changes accordingly until you get it the way you want. 

2.14 Mail Merge: 

 The Mail Merge feature enables you to take information from two documents, one, a Main 

Document and two, a Data Source, and combine them into a                                    
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single document. This feature allows you to write to many different people with the same 

information which may or may not be modified for each individual. On opening Mail Merge 

(Tools/Letters and Mailings/Mailmerge), a Task Pane appears to the right of the document and is 

visible throughout the entire Mail Merge procedure. The Task Pan will guide you through the 

mail merge and help you create customized form letters, labels and envelopes. Open a new 

 

The Mail Merge feature takes information from two documents;  one, a Main Document and the 

second, a Data Source, combining them into a single document.  

The main document: can be a standard letter, labels, envelopes, e-mail messages or a directory.  

The data source: is a file that contains recipients‘ names and addresses, plus any other variable 

information.  

The following is a complete list of the steps required to create a Mail Merge. The Main 
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Document is a standard letter.  

1. In the Tools menu, point to Letters and Mailings and then click Mail Merge. A Task 

Pane appears to the right of the document. There In the Mail Merge Task Pane, click 

Letters (if necessary). (When you click an option button, a brief description of that option 

is displayed in the centre of the Task Pane.)  

2. Select Starting Document:  

Go to the bottom of the Task Pane and click Starting document You have a choice of three 

options when starting the document. Use the current document: This is the blank document 

already on screen.  

Start from a template:Use this option if you already have a letter template that you prefer to use, 

or you can base your document on one of Word‘s mail merge templates.  

Start from existing document: Open an existing document that already contains the pre-typed 

text.  

Use the current document for understanding the Mail-merge here. 

To continue to the next step, click Select recipients  

3. Select Recipients: 

The next step is to specify and create the file that contains the recipient‘s names and addresses 

(the Data Source) so that Word can attach it to the letter. There are three options for moving 

forward in this step:  

Use an existing list •  

Select from Outlook contacts •  

Type a new list. •  

Under Select recipients, select Type a new list, to create a list of recipients to whom the mail will 

be sent. 

Under Type a new list, click Create to open the New Address List dialog box. 

The New Address List box has data fields, any of which can be used in the mail merge, or you 

can delete them and add your own. (Note: These data fields are the link between your letter and 
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the data source file.)  

To delete or add fields, click the Customize button.  

To remove a field name, select it and With Title selected, click Delete - a message box appears 

asking for confirmation. Click Yes to delete the field. Delete the Field Names: Company Name, 

Address Line 1, Address Line 2, City, State, PIN Code, Country, Home Phone, Work Phone, and 

E-mail Address 

Click Add (to add new field names to the list).  

In the click Delete, fields must be deleted individually - you cannot select multiple fields. If 

necessary, use the Move Up and Move Down buttons to arrange the fields in the order you want. 

 In the box, enter Department. 

Click OK to add this field name to the list. 

Repeat this action to add the following: Subject, Year_of_Study, Exam_Date (Note that spaces 

are not allowed in field names.) 

Click OK to close the Customize Address List dialog box. 

In the New Address List dialog box, enter data as shown. 

First Name:Theo, Last Name:Colbin, Department: Physics, Subject: Physics , Year_of_Study: , 

Exam_Date: 12/11/03.                             
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Click New Entry and enter another two records as shown. 

                            

                          

 You can view and edit the records by clicking the Next or Previous button. Close, the Save 

Address List dialog box appears. 

Call the file My_data_source. The data source will be saved as a Microsoft Office Address Lists 
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file type, in the My Data Sources folder. 

The Mail Merge Recipients box appears and you have the option to sort or filter the address list. 

               

Click OK to return to Mail Merge. In the Task Pane, you can now see the name of the data 

source file. 

4. Write the standard letter:  

Click in Write your letter. 

Type the standard text of the letter as below, putting a [tab] between Department, Subject and 

Year. 

Dear 

Department: Subject: Year: 

Your examination has been scheduled for   . It will take place in the department and you are 

requested to arrive ten minutes before it starts at 9:30am. 

Yours sincerely, 

Department Secretary  

Enter the fields - add recipient information to your letter. 

Place the insertion point where you want to insert the first merge field. The Mail Merge Task 
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Pane lets you choose from the following merge field options: Address Block:, Greeting Line:, 

Electronic Postage:, More items... 

To access your own fields, click in More Items. 

                                     

                                         

 As you select the fields in turn, the Insert Merge field dialog box is opened. 

Click Insert then Close. 

Again, click in More Items, repeating the above until all your fields are inserted, ensuring that 

you have the insertion point in the correct place. 

When you have finished editing the main document, save and name the file.  

To advance to the next step, 

 Click Preview your letters. 

5. Preview Your Letters:  

Click the arrow buttons in the Task Pane to preview the letters.  

Make any last minute changes to the data source file by clicking Edit recipient list and close the 

document. To proceed to the final step, click Next: Complete the merge. 

6. Complete the Merge:  

You are now ready to print the letters and there are two options:  
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Print: 

  Click this option to print the letters. The Merge to Printer box lets you choose which 

records to send to the printer.  

Edit individual letters: 

This allows you to personalise individual letters. With this option you get the Merge to New 

Document box. Click OK and the letters are merged to a new document, thereby giving you the 

opportunity to edit each individual letter. You will see that each letter is separated by a section. 

When you are ready to print the letters, click Print on the File menu.  

Sorting records 

Before you print your standard letters, you may want to sort them in a particular way. For 

example, you might want to print all the letters in alphabetical order by last name. You can do 

this by sorting the records in the data source by a field in ascending or descending order. By 

default, the records are sorted in ascending order.  

To sort records: 

Click the Mail Merge Recipients button to open the Mail Merge Recipients dialog box. 

Click in the arrow as shown to display a menu. 

                                                  

                                                         

 

 

Choose (Advanced…) to open the Filter and Sort dialog box. 

Activate the Sort Records tab. 

From the Sort by list, select Last_Name. 

Your list of field names appears. You can sort records according to any of the field names. Next 
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to Sort by, Ascending is selected by default.  

Click in Descending. 

Click OK to close the Filter and Sort dialog box. In the Mail Merge Recipients dialog box, the 

records are sorted by Last_Name in descending order. 

Click OK. To view all your records, click in the arrows under Preview your letter. Save the 

document. 

Merging addresses into mailing labels: 

You can also create mailing labels by using the mail merge feature. This is done by merging data 

from a data source into a mailing label document. The steps to do so are as follows. 

Create a document and open Mail Merge. 

Under Select document type, select Labels. 

In the next step of the wizard, click Next: Starting document, then Label options to open the 

Label Options dialog box. 

Specify the printer and label settings in the Label Options dialog box. 

Click OK. A sheet of labels with the specified label information is created. 

Specify the data source by clicking Browse. Click Next: Select recipients. This opens the Mail 

Merge Recipients dialog box. 

Close the dialog box and move to the next step in the wizard.  

Insert the fields in the document.  

Click Update all labels to add the labels to all the divisions in the document. 

Click the View Merged Data button. 

Preparing mailing labels: 

Open a new document. 

Choose Tools, Letters and Mailings, Mail Merge and select Labels. 

Click in Starting document, choose Label Options under Change Document Layout. Select the 

label to match your stationery (in this case, select 5159- Address). 
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Click OK to create a sheet of labels with the specified label information. 

Click Next: Select recipients. 

Under Use an existing list, click Browse to open the Select Data Source dialog box. 

Open your file, My_data_source to open the Mail Merge Recipients dialog box. 

Click OK to close the dialog box. 

The first division is blank. In the other divisions, the field, Next Record appears. Next: Arrange 

your labels. Arrange your labels, click More items to open the Insert Merge Field dialog box. 

Select each appropriate field, putting a space or return between fields as necessary, clicking 

Close after each field. 

Under Replicate labels, click Save the document as My_label_form.  

To insert the fields in all the divisions.                    
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Update all labels on the Task Pane. 

Viewing the merged labels: 

Click on Next - Preview your labels. 

This will show how the labels will appear when printed. 

Save the document as My mailing labels. 

 Preview and print labels: 

Before printing mailing labels, you can preview them by clicking on the arrow buttons on the 

Task Pane, Printing labels 

(Choose File, Print.) The Print dialog box appears. Select the printer and click OK to print the 

document.  

2.15 Writing a CD: 

To write data on CD, following steps should be followed: 

1.  Insert a blank, writable CD into the CD recorder. Use one of the following: 

        Recordable compact disc (CD-R)  

The reasons for writing your data on a CD are endless. As more and more computers come 

standard with a CD-ROM drive, for creating backup copies and to share files with other people, 

one should write data onto a CD. For example, you might want to write a CD to preserve the 

digital photographs you took on vacation instead of taking up precious space on your hard drive. 

Or you might want to keep a digital record of your house inventory on a CD and store that CD in 

a safety deposit box. When you copy a Word document to a disc, you don't have to open the file 

to do so. You can copy the file from its current location to the disc drive. The Word document 

will remain in its original location from where it is copied. 
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 Rewritable compact disc (CD-RW): With rewritable CDs, you can copy data to and erase data 

from the CD multiple times. 

2. Click Start, and then click My Computer. 

3. Click the files or folders that you want to copy to the CD. 

4. To select more than one file, hold down the CTRL key while you click the files you want. 

Then, under File and Folder Tasks, click Copy this file, Copy this folder, or Copy the 

selected items. If the files are located in My Pictures, under Picture Tasks, click Copy to 

CD or Copy all items to CD. 

5. In the Copy Items dialog box, click the CD recording drive, and then click Copy. In My 

Computer, double-click the CD recording drive. Windows displays a temporary area 

where the files are located before they are copied to the CD. Verify that the files and 

folders that you intend to write to the CD appear under Files Ready to be Written to the 

CD. Under CD Writing Tasks, click Write these files to CD. Windows displays the CD 

Writing Wizard. Follow the instructions in the wizard. After you copy files or folders to 

the CD, you can view the CD to confirm that the files have been copied. 
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Unit-3 

EXCEL/ SPREAD-SHEET 

3.0 Introduction 

Of all the computer functions, spreadsheets are the hardest to get to grips with. But a small investment of 

time and effort will soon pay dividends, because once you have the hang of them, spreadsheets can perform quite 

complex financial calculations. Microsoft-Excel or Spreadsheet is a very popular and 

powerful spreadsheet application. Spreadsheets facilitate the production of 

lists, tables and charts which means they are much used by those who wish to 

prepare balance sheets of income and expenditure. They may also be used to 

process examination results and to tabulate anything from any record. 

 You can, for example, set up a spreadsheet to work out the true cost of running your car, including such invisible outlay as 

depreciation and wear and, tear. All you have to do is 'explain' the task to the program once: it will do all the arithmetic for you, 

month after month, year on year.  

 

Opening a NEW spreadsheet: 

Microsoft Excel and the spreadsheet tool in Microsoft Works. To open a document in either program, go to the Start 

menu and select Programs then Microsoft Excel or Microsoft Works. 

If you open Excel, a new blank document will automatically appear on screen. If you open Works, the Works Task Launcher will 

open. Click on the Works Tools tab, then on the Spreadsheet button, then on OK. 
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 LOGGING IN AND STARTING: 

 EXCEL — DESCRIPTION OF THE CELLS: 

 The Excel window is headed by several bars which you should learn to identify: 

1. The Title Bar (blue, saying Microsoft Excel - ) 

2. The Menu Bar (with File, Edit, View etc.) 

3. The Standard Toolbar (with the New, Open, Save etc. buttons) 

4. The Formatting Toolbar (with the Font, Font Size, Bold etc. buttons) 

5. The Formula Bar (with the Name Box on the left, probably containing Al) 

The Formula Bar is the only bar with a different name and purpose from the 

bar in the equivalent position in MS-Office. This bar is particularly important in 

Excel and you should take special note of it. 
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Use the mouse to point (but not click) in the white area above the column 

labels D, E, F etc. After a second or two, a yellow Screen Tip tells you that this is 

the Formula Bar. 

At the bottom of the window there are two more bars associated with Excel: 

6. The Horizontal Scroll Bar 

7. The Status Bar 

Finally, below the Status Bar (which probably says Ready), there is the Windows 

taskbar whose buttons indicate what other windows are open behind the 

scenes. 

All the facilities of Excel can be accessed via menus and dialogue boxes but, by 

using the buttons on the two Toolbars, numerous shortcuts are available. 

 

WORKBOOK AND WORKSHEET: 

The main part of the screen is called a workbook. This consists of a collection of 

worksheets, initially called Sheet 1, Sheet 2 and Sheet 3. These names are to the left of the 
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Horizontal Scroll Bar near the bottom of the screen. Each name is on a sheet tab and Sheet l 

is on top to begin with. This is the active sheet.  A worksheet consists of a grid of 

rectangular cells which are arranged in rows and columns. The rows are 

numbered downwards starting from 1 and the columns have letters starting from 

A. There are grey column labels at the top of the worksheet and grey row labels 

along the left-hand edge. Note particularly column label A and row label 1. 

Initially, cell Al is the active cell. It is highlighted by an emphasized border and Al 

is noted in the Name Box at the left-hand end of Formula Bar: 

• Tap the —>-key to move the selection from cell Al to cell Bl. Cell Bl becomes 

the active cell and this is noted in the Name Box, to the left of the Formula 

Bar. 

• Repeatedly tap the —>-key and attempt to select a cell which is off the 

right-hand side of the window. Notice what happens. More columns 

appear at the right and columns A, B and so on disappear at the left. 

• Note that columns A to Z are followed by columns A A to AZ. The final 

column is IV. 

You see only part of the full worksheet which has 65,536 rows and 256 columns 

altogether. 

The standard ways of moving round the worksheet include using: 

1. The mouse (clicking a cell makes it the active cell). 

2. The arrow keys (with Ctrl when appropriate). 

3. The Page Up and Page Down keys (next to the Home and End keys). 

4. The scroll bars at the right-hand side and at the bottom of the window. 

Try these facilities but end with Ctrl-Home to make Al the active cell. 
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3.1 Uses of Excel Spread Sheet: 

Spreadsheets are often used to store financial data. Formulas and functions that are used on this 

type of data include:  

 Performing basic mathematical operations such as summing columns and rows of figures.  

 Finding values such as profit or loss.  

 Calculating repayment plans for loans or mortgages.  

 Finding the average, maximum, or minimum values in a specified range of data. 

 Graphing or charting data to assist users in identifying data trends.  

 Sorting and filtering data to find specific information. 

The information garnered in a spreadsheet can easily be incorporated into electronic 

presentations, web pages, or printed off in report form. 

3.2 FORMATTING: 

In Excel terminology, the format category is, by default, this normally means that a 

number is shown to as many significant figures as will fit in the cell but there is 

an overriding rule is that any leading or trailing  zeros  are suppressed and an 

integer (a whole number) is shown without a decimal point. 

In a normal-width cell 3.14159 would be written as 3.14159 but 00503.80 would 

be written as 503.8 (without the leading and trailing zeros). If you were to 

divide 100 by 3 (using the formula =100/3) the recurring decimal result would 

be taken to as many places as would fit in the cell. 

All the numbers in the square meter column are whole numbers so there are 

no decimal points. The numbers in the square feet column are taken to two 

decimal places except where the second decimal place would be a zero when 

only one decimal place is shown. 

ADJUSTING THE COLUMN WIDTH: 

• Click the grey column label B to select the square meter column. 

http://spreadsheets.about.com/od/c/g/chart_def.htm
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• Open Format and choose Column ► Width... The Column Width dialogue 

box indicates the current column width. A possible value might be 8.43 

[characters wide]. 

• Key in 15 to replace the 8.43 (or other value) and click OK. 

The whole column gets much wider and the general appearance certainly 

hasn't improved. You could experiment with different widths but one useful 

option should be explored: 

• Check that column B is still selected (click the column letter if not). 

• Open Format and choose Column ► AutoFit Selection. 

The AutoFit Selection facility makes a column just a little wider than the widest 

entry. Very often it is sensible to apply AutoFit Selection to every column in use: 

• Drag from column label A to column label D to select the whole of the first 

four columns. 

• Open Format and choose Column ► AutoFit Selection. 

This doesn't quite work as intended. Column A becomes enormously wide to 

accommodate the heading in cell Al. 

You could put matters right by selecting just column A and specifying a 

narrower width but it is worth noting an alternative approach: 

• Drag diagonally from cell A3 to cell D10. This selects all your entries 

except the top heading. 

• Open Format and choose Column ► AutoFit Selection. 

3.3 Range Names In Excel: 

There is a number of ways you can name a range of cells. 
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The first one is by using the Name box to the immediate left of the formula bar (see fig. 1). 

When the current selected range is already named, the name box will show its name. Otherwise 

you'll see the address of the active cell in this box. Select the range you want to name and then 

click in the Name box and type the name. Press Enter to confirm. There is one drawback to this 

method. When a name already exists, Excel will not apply the name to the selection. Instead 

Excel will select the range belonging to the existing definition of the name you typed. 

So the Name box can also be used to navigate to an existing name. Just select it from the 

dropdown list or type it in the box and hit enter. 

                                 

                              Fig. 1: Name Box Showing Cell Address 

A very fast way to create range names can be used when the headings of a table already represent 

the names you would like to assign to its rows and/or columns. See the table shown in fig. 2: 

                                 

                              Fig. 2: Range of cells with headings 

Select the both the tables content and its headers. Then choose Insert, Name, Create from the 

menu. 

You'll see the dialog screen of fig. 3 popup. By selecting the options shown in that screenshot, 

seven names are defined in one go: 
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                              Fig. 3: Dialog screen Create Names 

Name Refers to: Or 

Apples =Sheet1!$B$2:$B$4 The three cells below Apples 

Pears =Sheet1!$C$2:$C$4 The three cells below Pears 

Bananas =Sheet1!$D$2:$D$4 The three cells below Bananas 

Europe =Sheet1!$B$2:$D$2 The three cells to the right of  Europe 

Asia =Sheet1!$B$3:$D$3 The three cells to the right of  Asia 

America =Sheet1!$B$4:$D$4 The three cells to the right of  America 

Turn Over =Sheet1!$B$2:$D$4 All cells in the table, except the headers 

The third way to define a name through the user interface is by selecting Insert, Name, Define 

from the Menu. See fig. 4. This method will be used throughout the rest of this article. 
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                                Fig. 4: Dialog screen Define Name 

3.4 Protecting Cells:  

To protect cells following steps should be followed:  

Step 1: Select all cells in current worksheet with pressing the Ctrl key and A key together. 

Step 2: Right click, and select the Format Cell item from the context menu. 

Step 3: In the Format Cells dialog box, uncheck the Locked option under Protection tab, and 

click OK button. See the following screen shot: 
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Step 4: Select cells and ranges that you want to lock. 

Step 5: Right click selected ranges, and select the Format Cell item from the context menu. 

Step 6: In the Format Cells dialog box, check the Lock option under Protection tab, and click 

OK. 

Step 7: Click the Protect Sheet button in the Changes group under Review tab. 
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Step 8: In the Protect Sheet dialog box, enter a password in the blank box under Password to 

unprotect sheet: See the following screen shot: 

                                     

Step 9: Confirm Password dialog box pops up, please reenter the password again. 

                                   

Step 10: Click OK. 

Then it locks and protects only selected cells and ranges in current worksheet, while unselect 

ranges are editable. 

3.5 Sorting:  
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 The term list is used in Excel to describe a labelled series of rows that contain 

simar data. The sort feature in Excel allows you to look at the same data in different ways 

depending upon what information you are after. 

Excel allows you to sort by date, sort by text or numbers, sort by multiple columns, or by color. 

And, if you like, you can even color code your data. 

Types of sorting: 

When sorting data, it's important to first decide if you would like the sort to apply to the entire 

worksheet or just a cell range.  

 Sort sheet organizes all of the data in your worksheet by one column. Related 

information across each row is kept together when the sort is applied. In the example 

below, the Contact Name column (column A) has been sorted to display the names in 

alphabetical order.  
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 Sort range sorts the data in a range of cells, which can be helpful when working with a 

sheet that contains several tables. Sorting a range will not affect other content on the 

worksheet. 

 

To sort a sheet: 

In our example, we'll sort a T-shirt order form alphabetically by Last Name (column C). 

1. Select a cell in the column you wish to sort by. In our example, we'll select cell C2.  
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2. Select the Data tab on the Ribbon, then click the Ascending command  to Sort A to Z, 

or the Descending command  to Sort Z to A. In our example, we'll click the 

Ascending command.  

                         

3. The worksheet will be sorted by the selected column. In our example, the worksheet is 

now sorted by last name. 
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To sort a range: 

In our example, we'll select a separate table in our T-shirt order form to sort the number of 

shirts that were ordered on different dates. 

1. Select the cell range you wish to sort. In our example, we'll select cell range A13:B17. 
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2. Select the Data tab on the Ribbon, then click the Sort command.  

                   

3. The Sort dialog box will appear. Choose the column you wish to sort by. In our example, 

we want to sort the data by the number of T-shirt orders, so we'll select Orders. 
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4. Decide the sorting order (either ascending or descending). In our example, we'll use 

Smallest to Largest. 

5. Once you're satisfied with your selection, click OK.  

 

6. The cell range will be sorted by the selected column. In our example, the Orders column 

will be sorted from lowest to highest. Notice that the other content in the worksheet was 

not affected by the sort.  
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If your data isn't sorting properly, double-check your cell values to make sure they are entered 

into the worksheet correctly. Even a small typo could cause problems when sorting a large 

worksheet. In the example below, we forgot to include a hyphen in cell A18, causing our sort to 

be slightly inaccurate. 
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Custom sorting: 

Sometimes you may find that the default sorting options can't sort data in the order you need. 

Fortunately, Excel allows you to create a custom list to define your own sorting order. 

To create a custom sort: 

In our example below, we want to sort the worksheet by T-Shirt Size (column D). A regular sort 

would organize the sizes alphabetically, which would be incorrect. Instead, we'll create a custom 

list to sort from smallest to largest. 

1. Select a cell in the column you wish to sort by. In our example, we'll select cell D2.  

 

2. Select the Data tab, then click the Sort command.  
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3. The Sort dialog box will appear. Select the column you want to sort by, then choose 

Custom List... from the Order field. In our example, we will choose to sort by T-Shirt 

Size. 

 

4. The Custom Lists dialog box will appear. Select NEW LIST from the Custom Lists: 

box. 

5. Type the items in the desired custom order in the List entries: box. In our example, we 

want to sort our data by T-shirt size from smallest to largest, so we'll type Small, 

Medium, Large, and X-Large, pressing Enter on the keyboard after each item.  
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6. Click Add to save the new sort order. The new list will be added to the Custom lists: 

box. Make sure the new list is selected, then click OK. 
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7. The Custom Lists dialog box will close. Click OK in the Sort dialog box to perform the 

custom sort.  

 

8. The worksheet will be sorted by the custom order. In our example, the worksheet is now 

organized by T-shirt size from smallest to largest. 
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To sort by cell formatting: 

You can also choose to sort your worksheet by formatting rather than cell content. This can be 

especially helpful if you add color coding to certain cells. In our example below, we'll sort by 

cell color to quickly see which T-shirt orders have outstanding payments. 

1. Select a cell in the column you wish to sort by. In our example, we'll select cell E2.  

 

2. Select the Data tab, then click the Sort command.  

                            

3. The Sort dialog box will appear. Select the column you wish to sort by, then decide 

whether you'll sort by Cell Color, Font Color, or Cell Icon from the Sort On field. In 

our example, we'll sort by Payment Method (column E) and Cell Color.  
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4. Choose a color to sort by from the Order field. In our example, we'll choose light red. 

 

5. Click OK. In our example, the worksheet is now sorted by cell color, with the light red 

cells on top. This allows us to see which orders still have outstanding payments. 
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Sorting levels 

If you need more control over how your data is sorted, you can add multiple levels to any sort. 

This allows you to sort your data by more than one column. 

To add a level: 

In our example below, we'll sort the worksheet by Homeroom Number (column A), then by 

Last Name (column C). 

1. Select a cell in the column you wish to sort by. In our example, we'll select cell A2.  
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2. Click the Data tab, then select the Sort command.  

                     

3. The Sort dialog box will appear. Select the first column you wish to sort by. In this 

example, we will sort by Homeroom # (column A). 

4. Click Add Level to add another column to sort by.  

 

5. Select the next column you wish to sort by, then click OK. In our example, we'll sort by 

Last Name (column C). 
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6. The worksheet will be sorted according to the selected order. In our example, the 

homeroom numbers are sorted numerically. Within each homeroom, students are sorted 

alphabetically by last name.  

 

If you need to change the order of a multilevel sort, it's easy to control which column is sorted 

first. Simply select the desired column, then click the Move Up or Move Down arrow to adjust 

its priority. 
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Defining range In Microsoft Excel, you may have a named range that must be extended to 

include new information. This article describes a method to create a dynamic defined name. 

 

3.6 CHARTING — DATA SERIES AND CATEGORIES: 

There are numerous facilities in Excel for preparing charts and graphs. Charts 

can be created, embedded in a worksheet or as a separate chart sheet.  

Excel Graph Types 

There are many graphs or charts available in spreadsheet programs such as Excel and each has its 

own uses. The list below leads to information about the different Excel graphs and their uses.  

 Bar Graphs 

 Line Graphs 

 Scatter Plot Graphs 

 Pie Charts 

Bar Graphs 

http://spreadsheets.about.com/od/spreadsheetlessons/ss/excel_graph_use_2.htm
http://spreadsheets.about.com/od/spreadsheetlessons/ss/excel_graph_use_3.htm
http://spreadsheets.about.com/od/spreadsheetlessons/ss/excel_graph_use_4.htm
http://spreadsheets.about.com/od/spreadsheetlessons/ss/excel_graph_use_5.htm
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 Bar graphs are one of the most common types of graph used to display data. Sometimes 

known as "column charts", bar graphs are most often used to show amounts or the number of 

times a value occurs.  

                     

The amounts are displayed using a vertical bar or rectangle. The taller the bar, the greater 

number of times the value occurs.  

For example, for a school class you can use a bar graph to show and compare the number of 

students with different hair colors. The more students with a particular hair color, the taller the 

bar for that color will be in the graph.  

Bar graphs make it easy to see the differences in the data being compared. 

Line Graphs 

 Line graphs are often used to plot changes in data over time, such as monthly temperature 

changes or daily changes in stock market prices.  
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They can also be used to plot data recorded from scientific experiments, such as how a chemical 

reacts to changing temperature or atmospheric pressure.  

Similar to most other graphs, line graphs have a vertical axis and a horizontal axis. If you are 

plotting changes in data over time, time is plotted along the horizontal or x-axis and your other 

data, such as rainfall amounts is plotted as individual points along the vertical or y-axis.  

When the individual data points are connected by lines, they clearly show changes in your data - 

such as how a chemical changes with changing atmospheric pressure. You can use these changes 

to predict future results.  

Scatter Plot Graphs 

 Scatter plot graphs are used to show trends in data. They are especially useful when you 

have a large number of data points. Like line graphs, they can be used to plot data recorded from 

scientific experiments, such as how a chemical reacts to changing temperature or atmospheric 

pressure.  
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Whereas line graphs connect the dots or points of data to show every change, with a scatter plot 

you draw a "best fit"line. The data points are scattered about the line. The closer the data points 

are to the line the stronger the correlation or affect one variable has on the other.  

If the best fit line increases from left to right, the scatter plot shows a positive correlation in the 

data. If the line decreases from left to right, there is a negative correlation in the data 

Excel Pie Charts 

 Pie charts, or circle graphs as they are sometimes known, are a little different from the 

other three types of graphs discussed.  
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For one, pie charts do not use horizontal and vertical axes to plot points like the others. They also 

differ in that they are used to chart only one variable at a time. As a result, it can only be used to 

show percentages.  

The circle of pie charts represents 100%. The circle is subdivided into slices representing data 

values. The size of each slice shows what part of the 100% it represents.  

Pie charts can be used anytime you want to show what percent a particular item represents of a 

data series such as:  

 A baseball player's batting average can be shown with a pie chart as it represents the 

percentage of hits when compared to his total number of at bats for a season. 

 A company's profits for each month can be shown with a pie chart as a percentage of the 

year's total profits. 

CHANGING THE SIZE OF THE CHART: 

The outermost boundary of the chart has eight handles, four at the corners and 

four in the middles of the sides. These handles indicate that the chart is 

selected. A selected chart can be deleted by pressing the Delete-key. If your 

chart is completely wrong delete it and start again. 

The handles on the chart boundary can be dragged so that the edges and 

corners can be moved: 

• Click a cell in the worksheet outside the chart. The handles disappear as 

the chart ceases to be selected and the newly active cell is selected 

instead. 

• Click just inside the chart. The chart is again selected. Ensure that the 

bottom edge of the chart is exposed; use the Vertical Scroll Bar if 

necessary. 
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• Point at a handle and notice how the pointer becomes a double-headed 

arrow. 

• Drag the different handles in turn so that the border exactly fills all the 

cells in the range E13 to J26. 

 

 

MOVING THE DATA AND THE CHART: 

You should now have a reasonably tidy chart but the worksheet as a whole 

would look better if the data were moved one column to the right and the chart 

moved underneath the data. The data occupy four columns and the chart 

occupies six columns: 

• Click cell A3 to select it (and unselect the chart). 

• Open Insert and choose Columns. Everything moves right one column 

including the chart. 

• Click anywhere in the chart. This selects the chart and you can then... 

• Drag the chart as far to the left as it will go. 

By using the drag handles, arrange for the chart border to fill all the cells 

in the range A13 to F26. 

3.7 USING FORMULAE 

Suppose you are putting  length in meters in first column, breadth in second 

column and now you wish to add a third column giving the areas in square 

feet. Take  one square  meter to be 10.76 square feet. The first new entry will 

be 10.76 x length x breadth in cell CI. It is time to use a spreadsheet formula: 

• Make cell CI the active cell and key in =10.76 *A1*B1 (the equals sign is 

essential). Click the Enter box (with the tick) to confirm. An Excel formula is always 

introduced by an equals sign. In simple cases, formulae consist of numbers, cells 
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and arithmetic operators (principally +, —, * and /, the last two being for 

multiplication and division). 

 

ARRAY RANGE — FILL ► DOWN 

Up until now only one cell, the active cell, has been selected at a time. By 

dragging the mouse, you can highlight an array range so that a group of cells is 

selected at once. Certain operations can be performed on the group taken as 

a whole: 

• Drag the mouse from cell CI to cell C6. This selects the range C1: C6 (as it 

would normally be written). Check that a common border encloses the 

array of six cells (although only cells C2 to C6 are shaded). 

• Open the Edit menu and click Fill. 

• In the sub-menu click Down. The formula in cell CI (the 'white' cell) is copied 

into the other selected cells. 

• Make cell C2 the active cell and note, in the Formula Bar, that the formula 

in this cell is now =10.76*A2*B2. Check that the formula in cell C3 is now 

=10.76*A3*B3 and so on. 

Most, but not all, values are taken to two decimal places. This inconsistency 

makes the new column a little untidy and will be attended to shortly. 

The Fill ► Down facility and a companion facility Fill ► Right, which works on a 

horizontal array of selected cells, are powerful features when setting up a 

spreadsheet. 

THE SUM FUNCTION: 

Next, incorporate some totals. First: 

• Make cell A9 the active cell and key in Totals 
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Although in cell B9 you could now key in =B2+B3+B4+B5+B6+B7 as the formula to 

add 

up the six areas in the second column, there is a better way... 

 • Make cell B9 the active cell and key in =SUM(B2:B7) and click the 

Enter box (with the tick) to confirm. 

There are scores of functions built into Excel and SUM is one of them; it totals the values in 

the array range supplied in brackets. An item in brackets after the name of a 

function is called an argument of the function. Here the argument B2:B7 

designates the range of cells B2 to B7 inclusive. 

Although you could now make cell C9 the active cell and key in =SUM(C2:C7), it is 

easier to use the Fill Right facility as follows: 

• Drag the mouse from cell B9 to cell C9 to select these two cells. 

• Open the Edit menu and choose Fill ► Right. 

• Convert the three entries in row 9 to bold fount. 

When a formula incorporates a function, the Insert Function button, marked fx and 

found to the left of the Formula Bar, is sometimes useful. In the special case of 

the SUM function, it is better still to use the AutoSum button, marked with a E-sign 

in the Standard Toolbar. These buttons will be discussed later. 

 PERCENTAGES, RELATIVE AND ABSOLUTE REFERENCES AND THE $ PREFIX: 

Suppose you now wish to add a fourth column showing each of the six areas 

as a percentage of the total. 

       

• Key in the formula =B2/B9. Click the Enter box. The result is 0.15 which 

 itf 6/40 

 

and needs to be converted to a percentage... 

• Open Format and choose Cells...   The dialogue box indicates that the Category is 
General. 
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• Make cell D2 the active cell.                

• Click the Percentage category and again check that the number of Decimal places 

is shown as 2. Click OK. The value in cell D2 changes to 15.00%.              

• Check that D2 is the active cell. You could key in the whole of the revised 

formula afresh, but since it is only one character different a shortcut is 

advised... 

• Click in the Formula Bar between the B and the 9 of B9 and then key in $. 

The formula changes to =B2/B$9 as required. Click the Enter box. The result 

in D2 is 15.00% as before. 

• Drag the mouse from cell D2 to cell D7 to select the array of six cells again. 

• Open Edit and choose Fill ► Down. This time the entries are sensible percentages. 

Make cell D3 the active cell. The formula (look at the Formula Bar) is =B3/B$9 

and you will find that the formula in cell D4 is =B4/B$9. The $ really does 

mean that the 9 Sticks at 9. 

You could have had a second $ and included $B$9 in the formula. This extra $ 

forces the B to Stick to being a B but since you are filling down a column, the B 

won't change anyway. If you were filling a row using Fill ► Right then prefixing the 

B would be essential. 

3.8  SAVING YOUR DOCUMENT: 

Whenever you prepare a worksheet it is advisable to save it in a file soon 

after starting and to keep saving at frequent intervals thereafter. Open the File 

menu and choose Save As so that the Save As dialogue box appears. Type the  

• File name(Book1) into the File name box. 

       Click Save. 
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 This saves the file. The Bookl appears in the Title Bar. As a matter of note, 

the file name extension .xls indicates an Excel file. 

               

3.9 Printcomments:  

If your worksheet contains comments like the one shown here, you can print them, either as they 

appear on the sheet or at the end of the sheet. 

 

1. Click the worksheet that contains the comments that you want to print. 

2. To print the comments in place on the worksheet, display them by doing one of the 

following: 

 To display an individual comment, right-click the cell containing the comment, and then 

click Show/Hide Comments on the shortcut menu.  

 To display all comments in the worksheet, on the Review tab, in the Comments group, 

click Show All Comments. 



116 
 

                                         

If necessary, you can move and resize any overlapping comments. To do this, click the border of 

the comment box so that handles appear.  

                                                    

To move the comment, drag the border of the comment box. To change the size, drag the handles 

on the sides and corners of the box. 

3. On the Page Layout tab, in the Page Setup group, click the dialog box launcher to open 

the Page Setup dialog box. 

                             

4. Click the Sheet tab. 

5. In the Comments box, click As displayed on sheet or At end of sheet. 
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6. At the bottom of the dialog box, click Print.  
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Unit-4 

 PowerPoint Presentation 

 

4.0 Introduction: 

PowerPoint is a complete presentation graphics package. It gives you everything you need to 

produce a professional-looking presentation. PowerPoint offers word processing, outlining, 

drawing, graphing, and presentation management tools- all designed to be easy to use and learn.  

Microsoft PowerPoint is a presentation software package. PowerPoint users create and 

organize slides on a computer, to be printed on paper or acetate transparencies, projected directly 

from the computer or shared via the Internet. Users can create graphs and diagrams to which they 

may then add graphics and text. It also allows users to incorporate animation, audio and video 

elements. As well as presentations, PowerPoint can be used to make games, tutorials, animations 

and posters. 

 

 

4.1 Features of PowerPoint:  

 PowerPoint uses a graphical approach to presentations in the form of slide shows that 

accompany the oral delivery of the topic. This program is widely used in business and 

classrooms and is an effective tool when used for training purposes. 

1. PowerPoint is a quick and easy way to organize ideas and information, but it can encourage 

the creation of presentations that lack substance. 

2. PowerPoint is regarded as the most useful, accessible way to create and present visual aids; 

others believe it has its own mind-set which forces presenters to spend countless hours 

thinking in PowerPoint and developing slides. 

3. Easy to create colourful, attractive designs using the standard templates and themes; easy to 

modify compared to other visual aids, such as charts, and easy to drag and drop slides to re-

order presentation. 

4. Easy to present and maintain eye contact with a large audience by simply advancing the 

slides with a keystroke, eliminating the need for handouts to follow the message. 

http://presentationsoft.about.com/od/s/g/slide_show.htm
http://presentationsoft.about.com/od/powerpointinbusiness/
http://presentationsoft.about.com/od/classrooms/
https://www.boundless.com/communications/definition/powerpoint/
https://www.boundless.com/communications/definition/slide/
https://www.boundless.com/communications/definition/visual-aid/
https://www.boundless.com/communications/definition/audience--2/
https://www.boundless.com/communications/definition/message--2/
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5. PowerPoint is one of the simplest computer programs to learn. It is the number 1 program 

used worldwide for presentations. Anyone can create stunning presentations that look like 

they were designed by a professional.  

6. PowerPoint presentations can be made into photo albums, complete with music or 

narrations, to distribute on CDs or DVDs. If you are in the sales field, it involves just a few 

simple clicks to add an illustrative chart of data or an organizational chart of your 

company's structure. Make your presentation into a web page for emailing purposes or as a 

promotion displayed on your company's website. 

7.  It is easy to customize presentations with your company logo and to dazzle   your audience 

by using one of the many design templates that come with the programs. Many more free 

add-ins and templates are available online from Microsoft and a host of other websites. In 

addition to an on screen slide show, PowerPoint has printing options that allow the 

presenter to provide handouts and outlines for the audience as well as notes pages for the 

speaker to refer to during the presentation.  

8.  The main features of Microsoft PowerPoint include having advanced     cropping tool and 

artistic filters such as blur, paintbrush as well as watercolour. These features help in adding 

visual impact to the presentations.  

4.2 Uses of Power Point Presentation:  

 When you create a presentation using PowerPoint, the presentation is made up of a series 

of slides. The slides that you create using PowerPoint can also be presented as overhead 

transparencies or 35mm slides.  

 In addition to slides, you can print audience handouts, outlines, and speaker's notes.  

 You can format all the slides in a presentation using the powerful Slide Master which 

will be covered in the tutorial.  

 You can keep your entire presentation in a single file- all your slides, speaker's notes, and 

audience handouts.  

 You can import what you have created in other Microsoft products, such as Word and 

Excel into any of your slides. PowerPoint can go just about anywhere the presenter or 

http://presentationsoft.about.com/od/powerpoint101/ss/photo_album.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/sound.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/sound.htm
http://presentationsoft.about.com/od/powerpoint101/ss/slide_types_9.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/save_as_webpage.htm
http://presentationsoft.about.com/od/powerpointadvanced/ss/master_slide.htm
http://presentationsoft.about.com/od/d/g/design_template.htm
http://presentationsoft.about.com/od/templatesaddins/
http://presentationsoft.about.com/od/printinginpowerpoint/index.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/ppt_printing_4.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/ppt_printing_8.htm
http://presentationsoft.about.com/od/nextstepsinpowerpoint/ss/ppt_printing_7.htm
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audience goes. PowerPoint files are portable, making them easy to share, edit and view. 

A presentation can be emailed, saved directly to a computer, carried on a flash drive or 

uploaded to a Web site. With PowerPoint, the speaker can also record their presentation 

and save it for future use so that employers, students or other audiences can still view it 

without having to be there live. PowerPoint includes a number of features that allow 

presenters to better engage the audience. 

 Use PowerPoint to add video, photos, animations and slide transitions. These elements 

can help grab attention and break up mundane lectures or speeches. Video and photos can 

be directly embedded into presentations as well as edited directly through PowerPoint. 

No additional software is needed. PowerPoint also allows the presenter to add animations 

that can accentuate or highlight important points. Slide transitions work to move the 

presentation from one topic to the next. 

4.3 Toolbar:  

Toolbar is just below the Menubar. Toolbar is large in number. PowerPoint includes 13 

toolbars including commonly used ones such as Standard, Formatting, Table and Borders, 

Drawing, Animation Effects, Pictures and E-mail. Toolbars include important components for 

developing a presentation. A toolbar is an onscreen bar which contains shortcut buttons. These 

allow easy access to frequently used commands. You can easily get to the toolbars you need by 

telling PowerPoint which ones to display. You can pick and choose which toolbars are visible, 

and once you know how to turn toolbars on and off, you can always get to the toolbar you need.  
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 You can also right-click your mouse anywhere in a toolbar area and the list of 

PowerPoint toolbars will appear. From here you can turn toolbars on or off.    

               

                             

Moving and Changing the Toolbars 

You can reposition toolbars on the presentation you are working on. You can also resize toolbars 

so that all or only a few of the buttons contained in them are visible.  

Each toolbar has four vertical dots that help you move them to a fixed position on the screen or 

to floating positions on the screen. To move a toolbar, click the four dots that are found on the 

left end of each toolbar.                                                                                                                     

Note that when you choose to view a toolbar, it appears in the position in which it was most 

recently used. In the Toolbars list, click the toolbars you want to display. Click Close, and the 

toolbars you selected appear on the workspace.  
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Creating Your Own Toolbar: You can create your own customized toolbar. Right click any 

toolbar and hit Customize. In the Customize dialog box, select the toolbars tab and click New. 

Name the toolbar and allocate a template. 

                                 

4.4  Creating Presentation:  

To create presentation by using template, follow these steps: 

1. Start Power Point. 

2. Select 'Design Template' option and click on 'OK' button. 'New Presentation' dialog box 

will open. 

3. ‗New Presentation' dialog box has three options and in each option a list is available. Select 

any desired option and click on OK button. 'New Slide' dialog box will open.  

 4.  Select desired option and click on 'OK' button. For example, if we select 'Blank Presentation', 

then we will see the blank slide. 

To use slide master, follow these steps: 
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1. Create blank presentation. 

2. Click on View' menu. A drop down list will open. 

3. Click on ‗Master' option. A list will open.  

4.     Click on 'Slide Master' option. As soon as we do this, a slide will appear before us. View 

your slideshow. To view your final product, you can either click "Slide Show" in the top toolbar 

or select "Slide Show > View Slide Show" in the main menu.  

 

 

4.5 Slide Show  

A slide show can present and illustrate an event in history, or explain a geometric proof in math. It 

can illuminate an oral book report, or report the results of a science experiment. Teachers use slide 

shows as backdrops to their lectures, students use them to deliver reports, and schools use them to 

show the community what they are doing. A slide show can be a valuable tool for teaching, sharing 

and learning. 

The best way to learn this lesson  is to construct your own slide show as you read it. To do this, you'll 

need a collection of images that can be arranged to tell a story. Once you have the images you need, 

save them in a folder and get ready to construct your slide show. Make sure all of your images have 

been saved in the right size and resolution for the screen. 

Setting Up a Slide 

Open PowerPoint 

When you launch the PowerPoint program, it may ask you what kind of document you want to 

create. 
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2. You can choose the wizard tool, a template, or a blank presentation. Choose template. Click 

OK. 

 

3. Choose the Blends template 
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4  The New Slide layout screen appears. You can select from a variety pre-
designed layouts. Choose Title Slide Click OK.  

 
 

5  Click in the Title Box.  

 
 
6  You can choose different fonts by selecting Font from the Format menu or by 
pulling down on fonts in the Formatting Bar. You can also select the size and style. TIP: 
By using the Formatting Bar, you will be able to see the font style.  
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7 Choose a font, size, color and style. Type your title. For this workshop, type 
World Travel. You can also add a subtitle. Type Sights and Sounds.  

 

Inserting a Picture  

 

1. Click on New Slide in the Common Tasks window or New Slide from the Insert menu. The 

short cut is Ctrl+M. TIP: Sometimes this window gets hidden. Knowing the short cut will save 

you a lot of frustration trying to figure out how to make a new slide or how to get the Common 

Task Window to display again.  
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2. Choose the Clip Art and Text slide.  

 

1  Insert clip art on your slide by double clicking on the icon or selecting picture 
from clip art in the Insert menu.  

 
 
2  Choose travel and then the Leaning Tower from the clip art gallery.  
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3  The clip art is automatically inserted in the box. Choose the font, size, and style. 
Then, type the title: Leaning Tower of Pisa.  

 
 

4  Notice in the text box (see screen shot in Step #5) that there is a bullet. This 
might be fine for listing items, but when you want to type a paragraph, this feature can 
be annoying. To eliminate bullets, click on the text box. Choose Bullets and Numbering 
from the Format menu. Click on None and then OK.  

 
 

5  Type the following in the text box. Be sure to hit enter at the end of each line so 
the text will line up on the left. After the Leaning Tower of Pisa is shored up, workers 
say it will lean 19 feet. Type Leaning Tower of Pisa in the Title box.  
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Inserting a Sound File 

 

 

1  Click on New Slide in the Common Tasks window or New Slide from the Insert 
menu. The short cut is Ctrl+M. TIP: Sometimes this window gets hidden. Knowing the 
short cut will save you a lot of frustration trying to figure out how to make a new slide or 
how to get the Common Task Window to display again.  

 
 
2  Select the Two Column Text Slide.  
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3  Add a sound by selecting Movies and Sounds then Sound from Gallery in the 
Insert menu.  
 

 

4. Click on Music. 

 

 

5 Right click on CARB_1 and select insert. Close the window.  

 
 
 

6  Choose whether or not you want the sound to play automatically or when you 
click it. You can further customize the order in which objects are played or displayed on 
your slide by going to custom animation under the Slide Show Menu. You will learn 
more about custom animation when you insert a movie.  
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Inserting a Movie 

 

 

1  Click on New Slide in the Common Tasks window or New Slide from the Insert 
menu. The short cut is Ctrl+M. TIP: Sometimes this window gets hidden. Knowing the 
short cut will save you a lot of frustration trying to figure out how to make a new slide or 
how to get the Common Task Window to display again.  

 
 

2  Select the Title Only Slide.  
 

 

 

3  To insert a movie select Movies and Sounds from the Insert menu and choose 
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Movies from Gallery.  

 
4  Right click on the image and select insert. Close the window and return to the 
slide show.  

 
 
5  In order for the animation to play, you must set the controls for how it will be 
played. Highlight the movie. Select Custom Animation from the Slide Show menu.  
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Check the box next to your movie object. Then, choose the effects you want the movie to exhibit 

such as flying in from the left before it is played. Finally, set the order in which items on your 

slide will be displayed and whether or not they will appear automatically or on a mouse click.  

Transitions  

Transitions between slides will make the show look more professional. The transition you 

choose will precede the slide.  

 

1  Go to your first slide, then select Slide Transition from the Slide Show menu.  
2  Choose the effect and speed you want for the transition. Choose whether or not 
you want to advance each slide with the mouse or automatically. You can also have a 
sound effect between slides. Then, click Apply for the current slide or Apply to All for 
every slide.  
 

 

Saving the File  

1 Save your file often. Select Save As from the File menu. Pull down on the arrow 
and choose Presentation as the file type (ppt). Name the file and click on Save.  
2  To save it as a slide show, select Save As from the File menu. Pull down on the 
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arrow and choose PowerPoint Show as the file type (pps). Name the file and click on 
Save.  
 

Viewing the Slide Show  

 

Select View Show from the Slide Show menu.  

4.6 Saving slide:  

1. Display the slide you want to save. 

2. On the File menu, click Save As. In the File name box, type a name for your PowerPoint 

presentation, and then select the graphics format you want, click Save 

3. Do one of the following:  

 If you want to save only the current slide select Current Slide Only. 

 If you want to save every slide in a presentation select Every Slide. 
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Note:  By default, PowerPoint 2010 saves files in the PowerPoint Presentation (.pptx) file 

format. To save your presentation in a format other than .pptx, click the Save as type list, and 

then select the file format that you want. 

4.7 Delete a slide: 

         To delete the slide, follow these steps: 

1. Select desired slide. 

2. Press Delete key on keyboard. 

As soon as we do this, Power Point will ask us for deleting the slide. Now click the Ok button, 

desired slide will be deleted. 

4.8  Hide a Slide in PowerPoint Presentation:  

If there is a slide that you need in your presentation, but you do not want it to appear in 

the slide show, you can hide the slide. This is particularly useful when you have added slides to a 

presentation that provide different levels of detail on the subject matter, perhaps for different 

audiences. You can mark these slides as hidden so that they are not displayed in your main slide 

show, but you can still access them if you need to. For example, a member of your audience 

might ask you to explain an item in more detail. In that case, you can reveal the hidden slides 

that contain those details. When you hide a slide, the slide remains in the file even though it is 

http://www.wikihow.com/Hide-a-Slide-in-PowerPoint-Presentation
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hidden when you run the presentation in Slide Show view. You can switch the Hide Slide option 

on and off individually for any slide in the presentation. 

If you want to hide a slide to later go back to it after by a hyper linked button on another 

slide, then few quick easy steps are there in PowerPoint Presentation to do so: 

1. Open up PowerPoint and a couple of slides.  

 2. On the Slides tab in normal view, select the slide you want to hide/ not show up while moving 

through your presentation, then go up to the menu bar and click on "Slide Show". 

3. Scroll down the drop down menu to "Hide Slide" and click it or you can just right click and 

click on "Hide Slide" on the quick menu. The hidden slide icon appears with the slide number 

inside, next to the slide you have hidden. 

                                 

javascript:AppendPopup(this,'588663614_1')
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Create a slide show containing four slides. Leave the first slide white, but format the 

backgrounds of the remaining slides to be red, blue, and yellow respectively by right clicking 

each slide thumbnail, choosing FormatBackground from the options, and changing background 

colours accordingly (Following Figure).  

                                

For example we will hide Red and Blue Slides. To hide red and blue slides i.e. slides 2 and 3, 

select the slide thumbnails and then click the Hide Slide button on the Ribbon‘s Slide Show tab, 

or right click the selected slide thumbnails and choose Hide Slide from the options (Following 

Figure) . 
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There are two Methods for Hiding Slides: 

When a slide is hidden, its slide number displays with a dashed line and the slide thumbnail 

displays lighter (Following Figure). At any time, you can unhide a slide by repeating the steps 

just described. 
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Slide Thumbnails 2 and 3 Display with a Line when Hidden 

Next, click the slide 1 thumbnail to select slide 1. Let‘s start the slide show and scroll to see what 

happens. Notice that PowerPoint skips the red and blue slides entirely and immediately displays 

the yellow slide instead.  

   If you are in Slide Show view and you decide that you want to show a slide that you previously 

hid, right-click the slide that you want to show, and then click Hide Slide.  

4.9 Embedding Multimedia: 

 

 When utilizing multimedia files such as sound or movies in PowerPoint, PowerPoint can 

either embed them fully in the PowerPoint file simply create an icon or insert a ―poster frame,‖ 

and then when it‘s necessary to play the sound or movie, PowerPoint locates the sound or movie 

file and plays it. 

For embedding multimedia following steps has to be followed: 

1. Create a new PowerPoint presentation. 

2. Navigate to the slide into which you would like to embed the video clip. 

3. Select ―Insert‖ → ―Movie…‖ from the menu. 

4. Select the video file you want to embed.  

5. PowerPoint will ask whether you want the video to begin playing as soon as the slide is 

shown in presentation mode. 

Otherwise only the first frame of the film will appear, and playback will begin when the 

video is clicked. 

6. The first frame of the video will appear on slide stage with a video playback icon 

superimposed on the lower left corner. 

The video can be moved and resized just like a picture. 

7. Make sure to save your presentation! 

8. See ―Taking Your Presentations With You‖ below if you will not be showing your 

presentation on the same computer on which it was created. 
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UNIT – 5    ACCESS/WORKSHEET 

5.1    Introduction 

5.2    What is Database? 

         5.2.1    Database 

         5.2.2    Data Base Management System 

5.3   Access Database 

5.4   Relational Database Management System 

         5.4.1    Advantages 

         5.4.2    Disadvantages 

5.5    Devising Tables and Relationships 

Let Us Sum Up (Summary) 

Answers  
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5.1   INTRODUCTION 

 

Microsoft Access, also known as Microsoft Office Access, is a database management 

system from Microsoft that combines the relational Microsoft Jet Database Engine with a 

graphical user interface and software-development tools. It is a member of the Microsoft 

Office suite of applications, included in the Professional and higher editions or sold separately. 

Microsoft Access stores data in its own format based on the Access Jet Database Engine. It can 

also import or link directly to data stored in other applications and databases 

Software developers and data architects can use Microsoft Access to develop application 

software, and "power users" can use it to build software applications.  

 

A worksheet is a sheet of paper, or on a computer, on which problems are worked 

A worksheet generator is a software program that generates problems, particularly 

in mathematics or numeracy. Such software is often used by teachers to make classroom 

materials and tests. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Relational_database
http://en.wikipedia.org/wiki/Microsoft_Jet_Database_Engine
http://en.wikipedia.org/wiki/Graphical_user_interface
http://en.wikipedia.org/wiki/Microsoft_Office
http://en.wikipedia.org/wiki/Microsoft_Office
http://en.wikipedia.org/wiki/Data
http://en.wikipedia.org/wiki/Software_developer
http://en.wikipedia.org/wiki/Data_architect
http://en.wikipedia.org/wiki/Application_software
http://en.wikipedia.org/wiki/Application_software
http://en.wikipedia.org/wiki/Power_users
http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/Mathematics
http://en.wikipedia.org/wiki/Numeracy
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5.2   WHAT IS DATABASE 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

viii. Define what is database 

ix. Explain database management system 

 

5.2.1 DATABASE  

 

A database is a tool for collecting and organizing information. Databases can store information 

about people, products, orders, or anything else. Many databases start as a list in a word-

processing program or spreadsheet. As the list grows bigger, redundancies and inconsistencies 

begin to appear in the data. The data becomes hard to understand in list form, and there are 

limited ways of searching or pulling subsets of data out for review. Once these problems start to 

appear, it's a good idea to transfer the data to a database created by a database management 

system (DBMS), such as Access 2013. 

A computerized database is a container of objects. One database can contain more than one table. 

For example, an inventory tracking system that uses three tables is not three databases, but one 

database that contains three tables. Unless it has been specifically designed to use data or code 

from another source, an Access database stores its tables in a single file, along with other objects, 

such as forms, reports, macros, and modules. Databases created in the Access 2007 format 

(which is also used by Access 2013 and Access 2010) have the file extension .accdb, and 

databases created in earlier Access formats have the file extension .mdb. You can use Access 

2013, Access 2010, or Access 2007 to create files in earlier file formats (for example, Access 

2000 and Access 2002-2003). 

 

5.2.2. DATA BASE MANAGEMENT SYSTEM 

 

A database management system (DBMS) is a collection of programs that enables you to store, 

modify, and extract information from a database. There are many different types of DBMSs, 

http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/D/database.html
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ranging from small systems that run on personal computers to huge systems that run 

on mainframes. The following are examples of database applications: 

 Computerized library systems 

 Automated teller machines 

 Flight reservation systems 

 Computerized parts inventory systems 

From a technical standpoint, DBMSs can differ widely. The terms 

relational, network, flat, and hierarchical all refer to the way a DBMS organizes information 

internally. The internal organization can affect how quickly and flexibly you can extract 

information. 

Requests for information from a database are made in the form of a query, which is a stylized 

question. For example, the query 

 

SELECT ALL WHERE NAME = "SMITH" AND AGE > 35 

 

requests all records in which the NAME field is SMITH and the AGE field is greater than 35. 

The set of rules for constructing queries is known as a query language. Different 

DBMSs support different query languages, although there is a semi-standardized query language 

called SQL (structured query language). Sophisticated languages for managing database systems 

are called fourth-generation languages, or 4GLsfor short. 

The information from a database can be presented in a variety of formats. Most DBMSs include 

a report writer program that enables you to output data in the form of a report. Many DBMSs 

also include a graphics component that enables you to output information in the form of graphs 

and charts. 

Check your progress – 1  

Fill in the blanks: 

a) A ……………….. is a tool for collecting and organizing information. 

b) A computerized database is a container of ………………... 

c) A …………………………. is a collection of programs 

d)  ………………………is a semi-standardized query language.  

e) Sophisticated languages for managing database systems are called ………………….. 

http://www.webopedia.com/TERM/S/system.html
http://www.webopedia.com/TERM/R/run.html
http://www.webopedia.com/TERM/P/personal_computer.html
http://www.webopedia.com/TERM/M/mainframe.html
http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/H/hierarchical.html
http://www.webopedia.com/TERM/Q/query.html
http://www.webopedia.com/TERM/R/record.html
http://www.webopedia.com/TERM/F/field.html
http://www.webopedia.com/TERM/Q/query_language.html
http://www.webopedia.com/TERM/S/support.html
http://www.webopedia.com/TERM/S/SQL.html
http://www.webopedia.com/TERM/L/language.html
http://www.webopedia.com/TERM/F/fourth_generation_language.html
http://www.webopedia.com/TERM/F/format.html
http://www.webopedia.com/TERM/R/report_writer.html
http://www.webopedia.com/TERM/O/output.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/R/report.html
http://www.webopedia.com/TERM/G/graphics.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/L/language.html
http://www.webopedia.com/TERM/F/fourth_generation_language.html
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5.3   ACCESS DATABASE 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Explain access database 

ii. Describe its parts 

 

The database component of MS Office is designed to act as an "intelligent"1 electronic filing 

cabinet. Like a manual filing cabinet, it enables you to  

• collect sets of related data and keep the data organized;  

• update the data once you've collected them, by adding or deleting records and by changing 

existing records;  

An electronic filing cabinet such as a database allows you also to easily and quickly use the data-

-sort them, create reports, merge the data with other documents, and so forth. 

 

 

Microsoft Access: 

Access is an object-oriented relational database management system. 

 

Using Access, you can: 

 Add new data to a database, such as a new item in an inventory 

 Edit existing data in the database, such as changing the current location of an item 

 Delete information, perhaps if an item is sold or discarded 

 Organize and view the data in different ways 

 Share the data with others via reports, e-mail messages, an intranet , or the Internet 

 

Access Database Files 

You can use Access to manage all of your information in one file. Within an Access database 

file, you can use: 

 

 Tables to store your data. 
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 Queries to find and retrieve just the data that you want. 

 Forms to view, add, and update data in tables. 

 Reports to analyze or print data in a specific layout. 

 

 
 

 Store data once in one table, but view it from multiple locations. When you update the 

data, it's automatically updated everywhere it appears. 

 Retrieve data by using a query. 

 View or enter data by using a form. 

 Display or print data by using a report. 

 

  

The Parts of an Access Database: 

The parts of a typical Access database are: 

 Tables 

 Forms 

 Reports 

http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378512
http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378513
http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378514
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 Queries 

 Macros 

 Modules 

 

 

 
 

Tables 

 

A database table is similar in appearance to a spreadsheet, in that data is stored in rows and 

columns. As a result, it is usually quite easy to import a spreadsheet into a database table. The 

main difference between storing your data in a spreadsheet and storing it in a database is in how 

the data is organized. 

http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378515
http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378516
http://office.microsoft.com/en-in/access-help/database-basics-HA010341616.aspx#_Toc257378517
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To get the most flexibility out of a database, the data needs to be organized into tables so that 

redundancies don't occur. For example, if you're storing information about employees, each 

employee should only need to be entered once in a table that is set up just to hold employee data. 

Data about products will be stored in its own table, and data about branch offices will be stored 

in another table. This process is called normalization. 

 

Each row in a table is referred to as a record. Records are where the individual pieces of 

information are stored. Each record consists of one or more fields. Fields correspond to the 

columns in the table. For example, you might have a table named "Employees" where each 

record (row) contains information about a different employee, and each field (column) contains a 

different type of information, such as first name, last name, address, and so on. Fields must be 

designated as a certain data type, whether it's text, date or time, number, or some other type. 

Another way to describe records and fields is to visualize a library's old-style card catalog. Each 

card in the cabinet corresponds to a record in the database. Each piece of information on an 

individual card (author, title, and so on) corresponds to a field in the database. 

 

 
Forms 

   

Forms allow you to create a user interface in which you can enter and edit your data. Forms often 

contain command buttons and other controls that perform various tasks. You can create a 

database without using forms by simply editing your data in the table datasheets. However, most 

database users prefer to use forms for viewing, entering, and editing data in the tables. 

You can program command buttons to determine which data appears on the form, open other 

forms or reports, or perform a variety of other tasks. For example, you might have a form named 

"Customer Form" in which you work with customer data. The customer form might have a 

button which opens an order form where you can enter a new order for that customer. 

Forms also allow you to control how other users interact with the data in the database. For 

example, you can create a form that shows only certain fields and allows only certain operations 

to be performed. This helps protect data and to ensure that the data is entered properly. 
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Reports 

 

Reports are what you use to format, summarize and present data. A report usually answers a 

specific question, such as "How much money did we receive from each customer this year?" or 

"What cities are our customers located in?" Each report can be formatted to present the 

information in the most readable way possible. 

A report can be run at any time, and will always reflect the current data in the database. Reports 

are generally formatted to be printed out, but they can also be viewed on the screen, exported to 

another program, or sent as an attachment to an e-mail message. 

 

 
Queries 

 

Queries can perform many different functions in a database. Their most common function is to 

retrieve specific data from the tables. The data you want to see is usually spread across several 

tables, and queries allow you to view it in a single datasheet. Also, since you usually don't want 

to see all the records at once, queries let you add criteria to "filter" the data down to just the 

records you want. 

 

Certain queries are "updateable," meaning you can edit the data in the underlying tables via the 

query datasheet. If you are working in an updateable query, remember that your changes are 

actually being made in the tables, not just in the query datasheet. 

Queries come in two basic varieties: select queries and action queries. A select query simply 

retrieves the data and makes it available for use. You can view the results of the query on the 

screen, print it out, or copy it to the clipboard. Or, you can use the output of the query as the 

record source for a form or report. 

 

An action query, as the name implies, performs a task with the data. Action queries can be used 

to create new tables, add data to existing tables, update data, or delete data. 
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Macros 

 

Macros in Access can be thought of as a simplified programming language which you can use to 

add functionality to your database. For example, you can attach a macro to a command button on 

a form so that the macro runs whenever the button is clicked. Macros contain actions that 

perform tasks, such as opening a report, running a query, or closing the database. Most database 

operations that you do manually can be automated by using macros, so they can be great time-

saving devices. 

 

 

 
Modules 

 

Modules, like macros, are objects you can use to add functionality to your database. Whereas 

you create macros in Access by choosing from a list of macro actions, you write modules in 

the Visual Basic for Applications (VBA) programming language. A module is a collection of 

declarations, statements, and procedures that are stored together as a unit. A module can be either 

a class module or a standard module. Class modules are attached to forms or reports, and usually 

contain procedures that are specific to the form or report they're attached to. Standard modules 

contain general procedures that aren't associated with any other object. Standard modules are 

listed under Modules in the Navigation Pane, whereas class modules are not. 

 

                  Note: 

 

 

 

 

 

 

 

Some Access databases contain links to tables that are stored in other 

databases. For example, you may have one Access database that 

contains nothing but tables, and another Access database that contains 

links to those tables, as well as queries, forms, and reports that are based 

on the linked tables. In most cases, it does not matter whether a table is a 

linked table or actually stored in the database. 

javascript:AppendPopup(this,'508351376_1')
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Check your progress – 2 

Fill in the blanks 

a) ………………… is an object-oriented relational database management system. 

b) ……………….. are what you use to format, summarize and present data. 

c) Retrieve data by using a …………….. 

d) ……………. Are used  to store data. 

 

 

5.4   RELATIONAL DATA BASE MANAGEMENT SYSTEM 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define relational database management system 

ii. Explain its advantages and disadvantages 

 

A relational database management system (RDBMS) is a database management 

system(DBMS) that is based on the relational model as introduced by E. F. Codd, of IBM's San 

Jose Research Laboratory. Many popular databases currently in use are based on the relational 

database model. 

Relational databases have often replaced legacy hierarchical databases and network 

databases because they are easier to understand and use. However, relational databases have 

been challenged by object databases, which were introduced in an attempt to address the object-

relational impedance mismatch in relational database, and XML databases. 

Relational database management system is a type of database management system 

(DBMS) that stores data in the form of related tables. Relational databases are powerful because 

they require few assumptions about how data is related or how it will be extracted from the 

database. As a result, the same database can be viewed in many different ways. 

An important feature of relational systems is that a single database can be spread across several 

tables. This differs from flat-file databases, in which each database is self-contained in a single 

table. 

http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Relational_model
http://en.wikipedia.org/wiki/Edgar_F._Codd
http://en.wikipedia.org/wiki/IBM_Almaden_Research_Center
http://en.wikipedia.org/wiki/IBM_Almaden_Research_Center
http://en.wikipedia.org/wiki/Relational_database
http://en.wikipedia.org/wiki/Relational_database
http://en.wikipedia.org/wiki/Hierarchical_database
http://en.wikipedia.org/wiki/Network_database
http://en.wikipedia.org/wiki/Network_database
http://en.wikipedia.org/wiki/Object_database
http://en.wikipedia.org/wiki/Object-relational_impedance_mismatch
http://en.wikipedia.org/wiki/Object-relational_impedance_mismatch
http://en.wikipedia.org/wiki/XML_database
http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/T/table.html
http://www.webopedia.com/TERM/S/system.html
http://www.webopedia.com/TERM/F/flat_file_database.html
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What is table? 

The data in RDBMS is stored in database objects called tables. The table is a collection of 

related data entries and it consists of columns and rows. 

Remember, a table is the most common and simplest form of data storage in a relational 

database. Following is the example of a CUSTOMERS table: 

 

ID NAME AGE ADDRESS SALARY 

1 Ramesh 32 Ahmedabad 2000.00 

2 Khilan 25 Delhi 1500.00 

3 kaushik 23 Kota 2000.00 

4 Chaitali 25 Mumbai 6500.00 

5 Hardik 27 Bhopal 8500.00 

6 Komal 22 MP 4500.00 

 

 

What is field? 

Every table is broken up into smaller entities called fields. The fields in the CUSTOMERS table 

consist of ID, NAME, AGE, ADDRESS and SALARY. 

A field is a column in a table that is designed to maintain specific information about every record 

in the table. 

 

What is record or row? 

A record, also called a row of data, is each individual entry that exists in a table. For example 

there are 7 records in the above CUSTOMERS table. Following is a single row of data or record 

in the CUSTOMERS table: 

1 Ramesh 32 Ahmedabad 2000.00 

 

A record is a horizontal entity in a table. 
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What is column? 

A column is a vertical entity in a table that contains all information associated with a specific 

field in a table. 

For example, a column in the CUSTOMERS table is ADDRESS, which represents location 

description and would consist of the following: 

 

What is NULL value? 

A NULL value in a table is a value in a field that appears to be blank, which means a field with a 

NULL value is a field with no value. 

It is very important to understand that a NULL value is different than a zero value or a field that 

contains spaces. A field with a NULL value is one that has been left blank during record 

creation. 

 

SQL Constraints: 

Constraints are the rules enforced on data columns on table. These are used to limit the type of 

data that can go into a table. This ensures the accuracy and reliability of the data in the database. 

Constraints could be column level or table level. Column level constraints are applied only to 

one column where as table level constraints are applied to the whole table. 

Following are commonly used constraints available in SQL: 

 Not null constraint:  ensures that a column cannot have null value. 

 Default constraint:  provides a default value for a column when none is specified. 

 Unique constraint:  ensures that all values in a column are different. 

 Primary key:  uniquely identified each rows/records in a database table. 

 Foreign key:  uniquely identified a rows/records in any another database table. 

http://www.tutorialspoint.com/sql/sql-not-null.htm
http://www.tutorialspoint.com/sql/sql-default.htm
http://www.tutorialspoint.com/sql/sql-unique.htm
http://www.tutorialspoint.com/sql/sql-primary-key.htm
http://www.tutorialspoint.com/sql/sql-foreign-key.htm
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 Check Constraint: The CHECK constraint ensures that all values in a column satisfy 

certain conditions. 

 Index:  Use to create and retrieve data from the database very quickly. 

 

Data Integrity: 

The following categories of the data integrity exist with each RDBMS: 

Entity Integrity: There are no duplicate rows in a table. 

Domain Integrity: Enforces valid entries for a given column by restricting the type, the format, or 

the range of values. 

Referential integrity: Rows cannot be deleted, which are used by other records. 

User-Defined Integrity: Enforces some specific business rules that do not fall into entity, domain 

or referential integrity. 

Database Normalization 

Database normalization is the process of efficiently organizing data in a database. There are two 

reasons of the normalization process: 

 Eliminating redundant data, for example, storing the same data in more than one tables. 

 Ensuring data dependencies make sense. 

Both of these are worthy goals as they reduce the amount of space a database consumes and 

ensure that data is logically stored. Normalization consists of a series of guidelines that help 

guide you in creating a good database structure. 

Normalization guidelines are divided into normal forms; think of form as the format or the way a 

database structure is laid out. The aim of normal forms is to organize the database structure so 

that it complies with the rules of first normal form, then second normal form, and finally third 

normal form. 

 

Popular Relational Databases 

In this article, we are going to introduce three major and important open-source relational 

database management systems that have helped to shape the world of application development. 

http://www.tutorialspoint.com/sql/sql-check.htm
http://www.tutorialspoint.com/sql/sql-index.htm
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 SQLite: A very powerful, embedded relational database management system. 

 MySQL: The most popular and commonly used RDBMS. 

 PostgreSQL: The most advanced, SQL-compliant and open-source objective-RDBMS. 

SQLite:  

SQLite is an amazing library that gets embedded inside the application that makes use of. As a 

self-contained, file-based database, SQLite offers an amazing set of tools to handle all sorts of 

data with much less constraint and ease compared to hosted, process based (server) relational 

databases. 

When an application uses SQLite, the integration works with functional and direct calls made to 

a file holding the data (i.e. SQLite database) instead of communicating through an interface of 

sorts (i.e. ports, sockets). This makes SQLite extremely fast and efficient and also powerful 

thanks to the library are underlying technology. 

 

 

Advantages of SQLite: 

 File based: The entire database consists of a single file on the disk, which makes it 

extremely portable. 

 Standards-aware: Although it might appear like a "simple" DB implementation, SQLite 

uses SQL. It has some features omitted (RIGHT OUTER JOIN or FOR EACH 

STATEMENT), however, some additional ones are baked in. 

 Great for developing and even testing: During the development phase of most 

applications, for a majority of people it is extremely likely to need a solution that can 

scale for concurrency. SQLite, with its rich feature base, can offer more than what is 

needed for development with the simplicity of working with a single file and a linked C 

based library. 

 

Disadvantages of SQLite 

 No user management: Advanced databases come with the support for users, i.e. 

managed connections with set access privileges to the database and tables. Given the 
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purpose and nature of SQLite (no higher-levels of multi-client concurrency), this feature 

does not exist. 

 Lack of possibility to tinker with for additional performance: Again by design, 

SQLite is not possible to tinker with to obtain a great deal of additional performance. The 

library is simple to tune and simple to use. Since it is not complicated, it is technically not 

possible to make it more performing than it already, amazingly is. 

 

When To Use SQLite 

 Embedded applications: All applications that need portability, that do not require 

expansion, e.g. single-user local applications, mobile applications or games. 

 Disk access replacement: In many cases, applications that need to read/write files to 

disk directly can benefit from switching to SQLite for additional functionality and 

simplicity that comes from using the Structured Query Language (SQL). 

 Testing: It is an over kill for a large portion of applications to use an additional process 

for testing the business-logic (i.e. the application's main purpose: functionality). 

 

When Not To Use SQLite 

 Multi-user applications: If you are working on an application whereby multiple clients 

need to access and use the same database, a fully-featured RDBM (e.g. MySQL) is 

probably better to choose over SQLite. 

 Applications requiring high write volumes: One of the limitations of SQLite is 

the write operations. This DBMS allows only one single write*operating to take place at 

any given time, hence allowing a limited throughput. 

 

 

MySQL 

MySQL is the most popular one of all the large-scale database servers. It is a feature rich, open-

source product that powers a lot of web-sites and applications online. Getting started with 
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MySQL is relatively easy and developers have access to a massive array of information 

regarding the database on the internet. 

 

Advantages of MySQL 

 Easy to work with: MySQL can be installed very easily. Third-party tools, including 

visual ones (i.e. GUIs) make it extremely simple to get started with the database. 

 Feature rich: MySQL supports a lot of the SQL functionality that is expected from a 

RDBMS -- either directly or indirectly. 

 Secure: A lot of security features, some rather advanced, are built in MySQL. 

 Scalable and powerful: MySQL can handle a lot of data and furthermore it can be used 

"at scale", if needed be. 

 Speedy: Giving up some standards allows MySQL to work very efficiently and cut 

corners, thus providing speed gains. 

Disadvantages of MySQL 

 Known limitations: By design, MySQL does not intend to do everything and it comes 

with functional limitations that some state-of-the-art applications might require. 

 Reliability issues: The way certain functionality gets handled with MySQL (e.g. 

references, transactions, auditing etc.) renders it a little-less reliable compared to some 

other RDBMSs. 

 Stagnated development: Although MySQL is still technical an open-source product, 

there are complaints regarding the development process since its acquisition. However, it 

should be noted that there are some MySQL-based, fully-integrated databases that add 

value on top of the standard MySQL installations (e.g. MariaDB). 

When to Use MySQL 

 Distributed operations: When you need more than what SQLite can offer, including 

MySQL to your deployment stack, just like any stand-alone database server, brings a lot 

of operational freedom together with some advanced features. 

 High security: MySQL's security features provide reliable protection for data-access 

(and use) in a simple way. 
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 Web-sites and web-applications: A great majority of web-sites (and web-applications) 

can simply work on MySQL despite the constraints. This flexible and somewhat scalable 

tool is easy to use and easy to manage -- which proves very helpful in the long run. 

 Custom solutions: If you are working on a highly specific and extremely custom 

solution, MySQL can tag along easily and go by your rules thanks to its rich 

configuration settings and operation modes. 

When Not To Use MySQL 

 SQL compliance: Since MySQL does not [try to] implement the full SQL standard, this 

tool is not completely SQL compliant. If you might need integration with such RDBMSs, 

switching from MySQL will not be easy. 

 Concurrency: Even though MySQL and some storage engines perform really well 

with read operations, concurrent read-writes can be problematic. 

 Lack of features: Again, depending on the choice of the database-engine, MySQL can 

lack certain features, such as the full-text search. 

PostgreSQL:    

PostgreSQL is the advanced, open-source [object]-relational database management system which 

has the main goal of being standards-compliant and extensible. PostgreSQL, or Postgres, tries to 

adopt the ANSI/ISO SQL standards together with the revisions. 

Compared to other RDBMSs, PostgreSQL differs itself with its support for highly required and 

integral object-oriented and/or relational database functionality, such as the complete support for 

reliable transactions, i.e. Atomicity, Consistency, Isolation, Durability (ACID). 

Due to the powerful underlying technology, Postgres is extremely capable of handling many 

tasks very efficiently. Support for concurrency is achieved without read locks thanks to the 

implementation of Multiversion Concurrency Control (MVCC), which also ensures the ACID 

compliance. 

 

PostgreSQL is highly programmable, and therefore extendible, with custom procedures that are 

called "stored procedures". These functions can be created to simplify the execution of repeated, 

complex and often required database operations. 
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Although this DBMS does not have the popularity of MySQL, there are many amazing third-

party tools and libraries that are designed to make working with PostgreSQL simple, despite this 

database's powerful nature. Nowadays it is possible to get PostgreSQL as an application package 

through many operating systems default package manager with ease. 

Advantages of PostgreSQL 

 An open-source SQL standard compliant RDBMS: PostgreSQL is open-source and 

free, yet a very powerful relational database management system. 

 Strong community: PostgreSQL is supported by a devoted and experienced community 

which can be accessed through knowledge-bases and Q&A sites 24/7 for free. 

 Strong third-party support: Regardless of the extremely advanced features, 

PostgreSQL is adorned with many great and open-source third-party tools for designing, 

managing and using the management system. 

 Extensible: It is possible to extend PostgreSQL programmatically with stored 

procedures, like an advanced RDBMS should be. 

 Objective: PostgreSQL is not just a relational database management system but an 

objective one - with support for nesting, and more. 

 

Disadvantages of PostgreSQL 

 Performance: For simple read-heavy operations, PostgreSQL can be an over-kill and 

might appear less performing than the counterparts, such as MySQL. 

 Popularity: Given the nature of this tool, it lacks behind in terms of popularity, despite 

the very large amount of deployments - which might affect how easy it might be possible 

to get support. 

 Hosting: Due to above mentioned factors, it is harder to come by hosts or service 

providers that offer managed PostgreSQL instances. 

When To Use PostgreSQL 

 Data integrity: When reliability and data integrity are an absolute necessity without 

excuses, PostgreSQL is the better choice. 

 Complex, custom procedures: If you require your database to perform custom 

procedures, PostgreSQL, being extensible, is the better choice. 
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 Integration: In the future, if there is a chance of necessity arising for migrating the entire 

database system to a propriety (e.g. Oracle) solution, PostgreSQL will be the most 

compliant and easy to handle base for the switch. 

 Complex designs: Compared to other open-source and free RDBMS implementations, 

for complex database designs, PostgreSQL offers the most in terms of functionality and 

possibilities without giving up on other valuable assets. 

When Not To Use PostgreSQL 

 Speed: If all you require is fast read operations, PostgreSQL is not the tool to go for. 

 Simple set ups: Unless you require absolute data integrity, ACID compliance or complex 

designs, PostgreSQL can be an over-kill for simple set-ups. 

 Replication: Unless you are willing to spend the time, energy and resources, achieving 

replication with MySQL might be simpler for those who lack the database and system 

administration experience. 

 

 

 

5.4.1 ADVANTAGE 

 

Data Structure: The table format is simple and easy for database users to understand and use. 

RDBMSs provide data access using a natural structure and organization of the data. Database 

queries can search any column for matching entries. 

Multi-User Access: RDBMSs allow multiple database users to access a database 

simultaneously. Built-in locking and transactions management functionality allow users to access 

data as it is being changed, prevents collisions between two users updating the data, and keeps 

users from accessing partially updated records. 

Privileges: Authorization and privilege control features in an RDBMS allow the database 

administrator to restrict access to authorized users, and grant privileges to individual users based 

on the types of database tasks they need to perform. Authorization can be defined based on the 
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remote client IP address in combination with user authorization, restricting access to specific 

external computer systems. 

Network Access: RDBMSs provide access to the database through a server daemon, a 

specialized software program that listens for requests on a network, and allows database clients 

to connect to and use the database. Users do not need to be able to log in to the physical 

computer system to use the database, providing convenience for the users and a layer of security 

for the database. Network access allows developers to build desktop tools and Web applications 

to interact with databases. 

Speed: The relational database model is not the fastest data structure. RDBMS advantages, such 

as simplicity, make the slower speed a fair trade-off. Optimizations built into an RDBMS, and 

the design of the databases, enhance performance, allowing RDBMSs to perform more than fast 

enough for most applications and data sets. Improvements in technology, increasing processor 

speeds and decreasing memory and storage costs allow systems administrators to build 

incredibly fast systems that can overcome any database performance shortcomings. 

Maintenance: RDBMSs feature maintenance utilities that provide database administrators with 

tools to easily maintain, test, repair and back up the databases housed in the system. Many of the 

functions can be automated using built-in automation in the RDBMS, or automation tools 

available on the operating system. 

Language: RDBMSs support a generic language called "Structured Query Language" (SQL). 

The SQL syntax is simple, and the language uses standard English language keywords and 

phrasing, making it fairly intuitive and easy to learn. Many RDBMSs add non-SQL, database-

specific keywords, functions and features to the SQL language. 

 

5.4.2   DISADVANTAGES 

 

Cost: One disadvantage of relational databases is the expensive of setting up and maintaining the 

database system. In order to set up a relational database, you generally need to purchase special 

software.  
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Abundance of Information: Advances in the complexity of information cause another 

drawback to relational databases. Relational databases are made for organizing data by common 

characteristics. Complex images, numbers, designs and multimedia products defy easy 

categorization leading the way for a new type of database called object-relational database 

management systems. These systems are designed to handle the more complex applications and 

have the ability to be scalable. 

Stuctured Limits: Some relational databases have limits on field lengths. When you design the 

database, you have to specify the amount of data you can fit into a field. Some names or search 

queries are shorter than the actual, and this can lead to data loss. 

Isolated Databases: Complex relational database systems can lead to these databases becoming 

"islands of information" where the information cannot be shared easily from one large system to 

another. Often, with big firms or institutions, you find relational databases grew in separate 

divisions differently. For example, maybe the hospital billing department used one database 

while the hospital personnel department used a different database. Getting those databases to 

"talk" to each other can be a large, and expensive, undertaking, yet in a complex hospital system, 

all the databases need to be involved for good patient and employee care. 

Check your progress – 3 

 

Fill in the blanks 

a) ……………………………… is a type of database management system 

(DBMS) that stores data in the form of related tables. 

b) …………………… means there are no duplicate rows in a table. 

c) ……………… is a very powerful, embedded relational database management system. 

d) …………………The most advanced, SQL-compliant and open-source objective-

RDBMS 

e) ………………………… is the process of efficiently organizing data in a database. 

 

 

5.5   DEVISING TABLES AND RELATIONSHIPS 

http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/T/table.html
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Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define table  

ii. Explain table and relationship 

 

Introduction to tables 

When you use a database, you store your data in tables — subject-based lists that contain data 

arranged in records. For instance, you might create a Contacts table to store a list of names, e-

mail addresses, and telephone numbers. 

 

A table is a database object that you use to store data about a particular subject, such as 

employees or products. A table consists of records and fields. 

Each record contains data about one instance of the table subject, such as a particular employee. 

A record is also commonly called a row or an instance. 

Each field contains data about one aspect of the table subject, such as first name or e-mail 

address. A field is also commonly called a column or an attribute. 

A record consists of field values, such as Contoso, Ltd. or someone@example.com. A field value 

is also commonly called a fact. 

 

 

 

1. A record 

2. A field 

3. A field value 
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A database can contain many tables, each storing information about a different subject. Each 

table can contain many fields of different types of data, such as text, numbers, dates, and 

hyperlinks. 

 

External Data 

You can link to a variety of external data sources, such as other databases, text files, and Excel 

workbooks. When you link to external data, Access can use the link as if it were a table. 

Depending on the external data source and the way that you create the link, you can edit the data 

in the linked table, and can create relationships that involve the linked table. However, you 

cannot change the design of the external data by using the link. 

 

Table and Field Properties 

Tables and fields have properties that you can set to control their characteristics or behavior. 

 

 
 

A table open in Design view. 

1. Table properties 

2. Field properties 

 

Table Properties: 
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In an Access database, table properties are attributes of a table that affect the appearance or 

behavior of the table as a whole. Table properties are set in the table's property sheet, in Design 

view. For example, you can set a table's Default View property to specify how the table is 

displayed by default. 

 

 

Field Properties: 

A field property applies to a particular field in a table and defines one of the field's 

characteristics or an aspect of the field's behavior. You can set some field properties in Datasheet 

view. You can also set any field property in Design view by using the Field Properties pane. 

 

 Data Types 

Every field has a data type. A field's data type indicates the kind of data that the field 

stores, such as large amounts of text or attached files. 

 

 

 

A data type is a field property, but it differs from other field properties as follows: 

 You set a field's data type in the table design grid, not in the Field 

Properties pane. 

 A field's data type determines what other properties the field has. 

 You must set a field's data type when you create the field. 

 

TABLE RELATIONSHIPS 

To store your data, you create one table for each type of information that you track. Types of 

information might include customer information, products, and order details. To bring the data 

from multiple tables together in a query, form, or report, you define relationships between the 

tables. 

                Note: 

In a web database, you cannot use the Relationships object tab to create 

relationships. You can use lookup fields to create relationships in a web 

database. 

javascript:AppendPopup(this,'34470417_2')
javascript:AppendPopup(this,'34470417_2')
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                Note: 

 

 

1. Customer information that once existed in a mailing list now resides in the Customers 

table. 

2. Order information that once existed in a spreadsheet now resides in the Orders table. 

3. A unique ID, such as a Customer ID, distinguishes one record from another within a 

table. By adding one table's unique ID field to another table and defining a relationship 

between the two fields, Access can match related records from both tables so that you can 

bring them together in a form, report, or query. 

Although each table stores data about a different subject, tables in a database usually store data 

about subjects that are related to each other. For example, a database might contain: 

 A customers table that lists your company‘s customers and their addresses. 

 A products table that lists the products that you sell, including prices and pictures for 

each item. 
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 An orders table that tracks customer orders. 

Because you store data about different subjects in separate tables, you need some way to tie the 

data together so that you can easily combine related data from those separate tables. To connect 

the data stored in different tables, you create relationships. A relationship is a logical connection 

between two tables that specifies fields that the tables have in common. 

Keys 

Fields that are part of a table relationship are called keys. A key usually consists of one field, but 

may consist of more than one field. There are two kinds of keys: 

 Primary key    A table can have only one primary key. A primary key consists of one or 

more fields that uniquely identify each record that you store in the table. Often, there is a 

unique identification number, such as an ID number, a serial number, or a code, that 

serves as a primary key. For example, you might have a Customers table where each 

customer has a unique customer ID number. The customer ID field is the primary key of 

the Customers table. When a primary key contains more than one field, it is usually 

composed of pre-existing fields that, taken together, provide unique values. For example, 

you might use a combination of last name, first name, and birth date as the primary key 

for a table about people. 

 Foreign key    A table can also have one or more foreign keys. A foreign key contains 

values that correspond to values in the primary key of another table. For example, you 

might have an Orders table in which each order has a customer ID number that 

corresponds to a record in a Customers table. The customer ID field is a foreign key of 

the Orders table. 

The correspondence of values between key fields forms the basis of a table relationship. You use 

a table relationship to combine data from related tables. For example, suppose that you have a 

Customers table and an Orders table. In your Customers table, each record is identified by the 

primary key field, ID. 



167 
 

To associate each order with a customer, you add a foreign key field to the Orders table that 

corresponds to the ID field of the Customers table, and then create a relationship between the 

two keys. When you add a record to the Orders table, you use a value for customer ID that comes 

from the Customers table. Whenever you want to view any information about an order's 

customer, you use the relationship to identify which data from the Customers table corresponds 

to which records in the Orders table. 

 

A table relationship, shown in the Relationships window: 

1. A primary key, identified by the key icon next to the field name. 

2. A foreign key — note the absence of the key icon. 

 

Table Specifications 

In Access 2010, a table has the following practical limits: 

ATTRIBUTE MAXIMUM 

Number of characters in a table name 64 

Number of characters in a field name 64 

Number of fields in a table 255 
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Number of open tables 2048; this limit includes tables 

opened internally by Access 

Table size 2 gigabytes, minus the space 

needed for the system objects 

Number of characters in a Text field 255 

Number of characters in a Memo field 65,535 when entering data 

through the user interface; 

2 gigabytes of character storage 

when entering data 

programmatically 

Size of an OLE Object field 1 gigabyte 

Number of indexes in a table 32 

Number of fields in an index 10 

Number of characters in a validation message 255 

Number of characters in a validation rule 2,048 

Number of characters in a table or field description 255 

Number of characters in a record (excluding Memo 

and OLE Object fields) when the Unicode 

Compression property of the fields is set to Yes 

4,000 

Number of characters in a field property setting 255 

 

 

Benefits of Using Relationships: 

Keeping data separated in related tables produces the following benefits: 

Consistency    Because each item of data is recorded only once, in one table, there is less 

opportunity for ambiguity or inconsistency. For example, you store a customer's name only once, 

in a table about customers, rather than storing it repeatedly (and potentially inconsistently) in a 

table that contains order data. 

Efficiency    Recording data in only one place means you use less disk space. Moreover, smaller 

tables tend to provide data more quickly than larger tables. Finally, if you don't use separate 

tables for separate subjects, you will introduce null values (the absence of data) and redundancy 

into your tables, both of which can waste space and impede performance. 
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Comprehensibility    The design of a database is easier to understand if the subjects are properly 

separated into tables. 

Check your progress – 4 

 

Fill in the blanks 

a) A table consists of …………. and ………………. 

b) A …………… property applies to a particular field in a table defines one of the field's 

characteristics. 

c) A ………………… determines what other properties the field has. 

d) Fields that are part of a table relationship are called ………………………... 

e) A table can have only ……………….. primary key 

f) A ……………… note the absence of the key icon 
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Let Us Sum Up (Summary): 

a) A database is a tool for collecting and organizing information. 

b) A database management system (DBMS) is a collection of programs that enables you 

to store, modify, and extract information from a database. 

c) Access is an object-oriented relational database management system. 

d) A relational database management system (RDBMS) is a database management 

system(DBMS) that is based on the relational model as introduced by E. F. Codd, of 

IBM's San Jose Research Laboratory. 

e) Database normalization is the process of efficiently organizing data in a database. 

f) A table is a database object that you use to store data about a particular subject, such as 

employees or products. 

g) Table properties are attributes of a table that affect the appearance or behavior of the 

table as a whole. 

h) A field property applies to a particular field in a table and defines one of the field's 

characteristics or an aspect of the field's behavior. 

i) A relationship is a logical connection between two tables that specifies fields that the 

tables have in common. 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/D/database.html
http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Database_management_system
http://en.wikipedia.org/wiki/Relational_model
http://en.wikipedia.org/wiki/Edgar_F._Codd
http://en.wikipedia.org/wiki/IBM_Almaden_Research_Center
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Answers: 

 

Check Your Progress – 1 

a) Database 

b) Objects 

c) Database management system 

d) SQL 

e) Fourth generation languages 

 

Check Your Progress – 2 

a) Access 

b) Reports 

c) Query 

d) Tables 

 

Check Your Progress – 3 

a) Relational database management system 

b) Entity integrity 

c) SQLite 

d) PostgreSQL 

e) Data Normalization 

 

Check Your Progress – 4 

a) Records , fields 

b) Field 

c) Fields data type 

d) Key 

e) One 

f) Foreign key 
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UNIT – 6    INTERNET 
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          6.1.1   Net Browsing 
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6.1   INTRODUCTION TO INTERNET 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

x. Define internet  

xi. Explain net browsers and types of browsers 

xii. Explain Email - outlook express and web enabled 

xiii. Describe the components and software required to run multimedia website 

xiv. Understand how to print and save web files 

 

The internet has come a long way since the 1960s. The internet today is not a hierarchical 

structure. It is made up of many wide and local area networks joined by connecting devices and 

switching stations. It is difficult to give an accurate representation of the internet because it is 

continually changing.  

What is Internet? 

A network is a group of connected communicating devices such as computers and printers. An 

internet is two or more networks that can communicate with each other. Internet is a 

collaboration of more than hundreds of thousands of interconnected networks. Private 

individuals as well as various organizations such as government agencies, school, research 

facilities, corporations, and libraries in more than 100 countries use the internet. Millions of 

people are users. Yet this extraordinary communication system only came into being in 1969. 

The Internet is a worldwide network of computer networks that connects university, government, 

commercial, and other computers in the world. Using the Internet, you can send electronic mail, 

chat with colleagues around the world, and obtain information on a wide variety of subjects. 

 

 

A means of connecting a computer to any other computer anywhere in the 

world via dedicated routers and servers. Internet can be defined as the wired or wireless mode of 

communication through which one can receive, transmit information that can be used for single 

or multiple operations. 

The Internet is a collection of networks connected by interconnecting devices. 

http://www.businessdictionary.com/definition/mean.html
http://www.businessdictionary.com/definition/via.html
http://www.businessdictionary.com/definition/dedicated.html
http://www.businessdictionary.com/definition/router.html
http://www.businessdictionary.com/definition/server.html
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History of Internet ? 

In the mid 1960s, mainframe computers in research organizations were stand alone devices. The 

Advance Research Project Agency (ARPA) in the Department of Defense (DOD) was 

interested in finding a way to connect computers. 

In 1967, at an Association for Computing Machinery (ACM) meeting, ARPA presented its ideas 

for ARPANET, a small network of connected computers. The idea was that each host computer 

would be attached to a specialized computer, called an interface message processor (IMP). 

By 1969, Arpanet was a reality. Four nodes, at the University of California at Los Angeles 

(UCLA), the University of California at Santa Barbara (UCSB), Stanford research institute 

(SRI), and the University of Utah, were connected via the IMPs to form a network. 

In 1972, Vint Cerf and Bob Kahn, both of whom were part of the core ARPANET group, 

collaborated on what they called the Internetting project. Cerf and Kahn in 1973 outlined the 

protocols to achieve end-to-end delivery of packets. This is the transmission control protocol 

(TCP). Shortly TCP split into two protocols: Transmission Control Protocol (TCP) and 

Internetworking Protocol (IP). 
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6.1.1   NET BROWSING  

 

The words ―Browsing‖ or ―Surfing‖ are used to describe the process of looking at documents, 

websites and web pages on the Internet. Browsing behaviour differs from person to person. To 

access a website you can either type the domain name (the website address – more later) of the 

website directly into the address bar or you can use a search engine to search for the site using 

the business name or some other keywords that you know can be found on the website. 

The word browsing is used to refer to a reading process which is done randomly through 

unhurried and casual inspection. 

 

 

 

 

 

 

 

Browsing is often understood as a random activity. Dictionary.com, for example, has this 

definition: "to glance at random through a book, magazine, etc." 

Categories of browsing – 

Bawden (1986) identifies three categories of browsing activity: 

 Purposive browsing, which is the purposeful search for new information in a defined, 

broad subject area 

 Capricious browsing, which describes the random search of material without a clearly 

defined goal, and 

 Exploratory or semi-purposive browsing ―in search, quite literally of inspiration‖. 

Cove and Walsh (1988) also divide browsing, into three categories of online activity: 

 Search browsing, which is directed and structured, and where the end destination is 

known 

 General purpose browsing, which involves regularly consulting websites that are 

expected to contain items of interest, and 

 Serendipity browsing, which is wholly random, unstructured and undirected. 

"Browsing is a quick examination of the relevance of a number of objects 

which may or may not lead to a closer examination or 

acquisition/selection of (some of) these objects. 

- Hjørland  
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6.1.2   TYPES OF BROWSERS  

 

A browser is a software application used to locate, retrieve and display content on the World 

Wide Web, including Web pages, images, video and other files. As a client/server model, the 

browser is the client run on a computer that contacts the Web server and requests information. 

The Web server sends the information back to the Web browser which displays the results on the 

computer or other Internet-enabled device that supports a browser. 

A browser is software that is used to access the internet. A browser lets you visit websites and do 

activities within them like login, view multimedia, link from one site to another, visit one page 

from another, print, send and receive email, among many other activities.  

 

Although the primary application of all the web browsers is the same, they differ from each other 

in more than one aspect. The distinguishing areas are: 

 Platform: Linux, Windows, Mac, BSD and other Unix 

 Protocols: FTP, SFTP, SAMBA, HTTP, IMAP, etc. 

 Graphical User Interface (GUI) 

 Layout Engine: Amaya, Gecko, Trident, KHTML, WebKit 

 Mobile Compatibility 

 HTML5 Support 

 Open Source 

 Proprietary 

However, the general, primary and secondary features and facilities offered by web browsers 

include download, bookmarks, and password management. They also offer functions like spell 

checking, search engine toolbars, tabbed browsing, advertisement filtering, HTML access keys 

and pop-up blocking. 

The most popular browsers are Microsoft Internet Explorer , Firefox, Google Chrome, Apple 

Safari and Opera. While most commonly use to access information on the web, a browser can 

also be used to access information hosted on Web servers in private networks.    

 

The different types of browsers are:- 

 

 

http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/W/World_Wide_Web.html
http://www.webopedia.com/TERM/W/World_Wide_Web.html
http://www.webopedia.com/TERM/W/web_page.html
http://www.webopedia.com/TERM/C/client_server_architecture.html
http://www.webopedia.com/TERM/C/client.html
http://www.webopedia.com/TERM/S/server.html
http://www.webopedia.com/TERM/W/Web_server.html
http://www.webopedia.com/TERM/I/Internet_Explorer.html
http://www.webopedia.com/TERM/F/Firefox.html
http://www.webopedia.com/TERM/G/Google_Chrome.html
http://www.webopedia.com/TERM/A/Apple_Safari.html
http://www.webopedia.com/TERM/A/Apple_Safari.html
http://www.webopedia.com/TERM/O/Opera.html
http://www.webopedia.com/TERM/N/network.html
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Internet Explorer 
 

 

 

Internet Explorer (IE) is a product from software giant Microsoft. This is the most commonly 

used browser in the universe. This was introduced in 1995 along with Windows 95 launch and it 

has passed Netscape popularity in 1998. 

Features:  

There are regular Microsoft updates that IE supports. Favicon allows an image to be used as a 

bookmark. It supports Integrated Windows Authentication. 

 

Netscape 

 

 

Netscape is one of the original Web browsers. This is what Microsoft designed Internet Explorer 

to compete against. Netscape and IE comprise the major portion of the browser market. Netscape 

was introduced in 1994. 

Features: 

Netscape Messenger is an email and news client for Netscape Navigator 9. Also, another feature 

is Netscape Publishing System that allows commercial sites to publish articles and charge users 

for accessing them. 

 

Mozilla 

 

Mozilla is an open-source Web browser, designed for standards compliance, performance and 

portability. The development and testing of the browser is coordinated by providing discussion 

forums, software engineering tools, releases and bug tracking. Browsers based on Mozilla code 

is the second largest browser family on the Internet today, representing about 30% of the Internet 

community. 
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Chrome 

 

This web browser was developed by Google. Its beta and commercial versions were released in 

September 2008 for Microsoft Windows. The browser options are very similar to that of Safari, 

the settings locations are similar to Internet Explorer 7, and the window design is based on 

Windows Vista. 

Features: 

The main standout feature is the malware and phishing warning that the browser suggests when 

the user wants to browse a site. Also, there is a user tracking option available with Chrome. 

 

Konqueror 

 

it is a KHTML based engine that was developed by KDE and initially released in 1996. It 

supports protocols like FTP, SFTP, SAMBA, HTTP, IMAP and others. 

Features:  

Konqueror is an Open Source web browser with HTML 4.01 compliance, supporting Java 

applets, JavaScript, CSS 1, CSS 2.1, as well as Netscape plugins. This works as a file manager as 

well as supports basic file management on local UNIX file systems, from simple cut/copy and 

paste operations to advanced remote and local network file browsing 

 

Firefox 

 

Firefox is a new browser derived from Mozilla. It was released in 2004 and has grown to be the 

second most popular browser on the Internet. 

Features:  

As it is an open source software, it allows everyone to access the code. It supports tabbed 

browsing that allows the user to open multiple sites in a single window. Session storage is also 

http://www.google.com/chrome
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an important feature of Firefox, which allows the user to regain access to the open tabs after he 

has closed the browser window. 

 

Safari 

 

Safari is a web browser developed by Apple Inc. and included in Mac OS X. It was first released 

as a public beta in January 2003.  

Features:  

Safari has very good support for latest technologies like XHTML, CSS2 etc. Safari is based on 

open source software and is one of the fastest browsers available. The Safari 4 beta had many 

features like Voice Over screen reader, that reads aloud everything that is on the screen, 

including text and web links. Also, there is a resizable web search box option available. 

'Grammar Checking' is an interesting built-in feature. 

 

Opera 

 

This browser was developed by Opera Software in 1996. It is a well-known browser that is 

mainly used in Internet-activated mobile phones, PDAs, and smartphones. Opera Mini and Opera 

Mobile are the browsers used in smartphones. It is compatible with many operating systems such 

as Solaris, Linux, Mac OS X, and Microsoft Windows. 

Features:  

Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-friendly, 

with keyboard interface, multiple windows, zoom functions, and more. Java and non Java-

enabled versions available.  

 

Lynx 
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Lynx is a fully-featured World Wide Web browser for users on Unix, VMS, and other platforms 

running cursor-addressable, character-cell terminals or emulators. 

Features:  

Though being the oldest amongst the current lot of web browsers, it can be remotely accessed 

over Telnet and SSH. This feature enables Lynx to be used for testing a website's performance 

from any geographical location. 

 

6.1.3   E-MAIL - OUTLOOK EXPRESS  

 

One of the most popular internet services is electronic mail (e – mail). The designers of the 

internet probably never imagined the popularity of this application program.  

At the beginning of the internet era, the messages sent by electronic mail were short and 

consisted of text only, they let people exchange quick memos. Today electronic mail is much 

more complex. It allows a message to include text, audio, and video. It also one message to be 

sent to one or more recipients. 

The first e-mail was sent by Ray Tomlinson in 1971. By 1996, more electronic mail was being 

sent than postal mail. 

Features of using email 

 It's quick – recipient receives your email as soon as they go online and collect their mail. 

 It's secure. 

 It's low cost. 

 Photos, documents and other files can be attached to an email, so that more information 

can be shared. 

 One email can be sent to more than one recipient at a time. 

Email address 

 Like your address on envelopes, your email address tells people who you are and where 

you live, and it is unique — one of a kind. Nobody else in the world has the same email 

address as you. 

 Your email address is usually made up like this: your user name for connecting to the 

Internet (AT) the name of your Internet Service Provider (DOT) based at this kind of 

organization (DOT) in this country 

http://www.computerhope.com/history/196080.htm
http://www.computerhope.com/history/1996.htm
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How to send and receive e-mail 

To send and receive e-mail messages you can use an e-mail program, also known as an e-mail 

client such as Microsoft Outlook or Mozilla Thunderbird. When using an e-mail client you must 

have a server that stores and delivers your e-mail this service is provided by your ISP but can 

also be a service provided by another company. The e-mail client will connect to the server to 

download all new e-mail and deliver any unsent e-mail. 

An alternative way of sending and receiving e-mail and a more popular solution for most people 

is an online e-mail service or webmail such as Hotmail, Gmail, and Yahoo Mail. Many of the 

online e-mail services including the above examples are free or have a free account option. 

 

OUTLOOK  EXPRESS 

To access an e-mail account you also need an e-mail program, which is also called e-mail client 

software. You use e-mail program to open, print, delete, reply to, forward and save mail from 

your email server. One such program is Microsoft outlook express, which install as part of 

internet explorer.  

Outlook Express is an email program that works with Internet Explore versions 4.0 to 6.0. This 

product is typically bundled with Microsoft Windows (Windows 98 to Windows XP). However, 

the product isn‘t available with Windows Vista, which was replaced with ―Windows Mail.‖ 

Outlook Express is designed for use with any Internet standard system, for example, Simple Mail 

Transfer Protocol (SMTP), Post Office Protocol 3 (POP3), and Internet Mail Access Protocol 

(IMAP). 

 

 

 

 

 

 

Working of Outlook Express 

To put in simpler terms, you just need to set-up an Outlook Express profile with the help of the 

login details that you use to log in to any email service provider. Once done, the outlook Express, 

http://www.computerhope.com/comp/msoft.htm
http://www.computerhope.com/software/outlook.htm
http://www.computerhope.com/jargon/m/mozilla.htm
http://www.computerhope.com/jargon/t/thunbird.htm
http://www.computerhope.com/jargon/i/isp.htm
http://www.computerhope.com/jargon/w/webmail.htm
http://www.computerhope.com/jargon/h/hotmail.htm
http://www.computerhope.com/jargon/g/gmail.htm
http://mail.yahoo.com/
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then retrieves your email by connecting to the web mail service you use and downloads all the 

messages from the web mail service in your computer, deleting them simultaneously from 

the web mail service. 

 

Features Outlook Express 

Microsoft Outlook Express puts the world of online communication on your desktop. Whether 

you want to exchange e-mail with colleagues and friends or join newsgroups to trade ideas and 

information, the tools you need are here.  

 Manage multiple e-mail and newsgroup accounts  

 Browse through messages quickly and easily  

 Keep your e-mail on a server so you can view it from more than one computer  

 Use the Address Book to store and retrieve e-mail address  

 Add a personal signature or stationary to you messages  

 Send and receive secure messages  

 Find newsgroups that interest you  

 View newsgroup conversations efficiently  

 Download newsgroup messages for offline reading  

 

Improved Security 

In the past, Outlook Express was targeted for malicious viruses. The script could be opened as an 

attachment which made it easier for people to infect others with viruses. Also, previewing email 

could allow a virus to run without the user‘s knowledge. Microsoft has worked hard to correct 

these security holes. 

New versions of Outlook Express block outside images, which prevents virus infection. It also 

disables scripts and has strict restrictions for content transfer. The program now warns users 

when they‘re about to open a malicious email. If you get this message, make sure to delete the 

email immediately. 

 

Configuration Outlook Express  

Before you can use Outlook Express to send and receive e-mail, you need to set up an account. 

You can have more than one account—for business, online shopping, and so on—and each 

http://mail2web.com/webmail/
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person who uses your computer may have their own, completely separate account. Outlook 

Express gracefully handles it all. 

 Launch Outlook Express 

 

 

 

 

 

 

 

Email message storage and management in Outlook Express 

In Outlook Express, all incoming emails arrive at the INBOX folder. The three other default 

folders are Sent items, Drafts and the Outbox. Any email you send from Outlook Express is 

automatically moved to the Sent Items folder. The program lets you create additional folders 

under the Inbox and segregate your messages as you like. This is a big help in organizing your 

emails. For example, you can create separate folders called "Office", "Friends", or "Family" and 

place the respective email messages in them. The program also provides an automated method 

called Outlook Express Message Rules with which you can create rules and have them applied 

to all incoming emails. Thus, for instance, you can have certain messages moved to designated 

folders, replied to automatically or even delete without your involvement. 

To send an e-mail message: 

 Press the new mail button on the outlook express toolbar 

 Type the e-mail address of the recipient  

 Type your subject matter 

 Type your message and then click the send button 

To retrieve mail that has been send to you: 

 Click on the Send/Recv button on the toolbar 

 Outlook express will contact your e-mail server and download your e-mail message 

To reply to a message:  

 Click the reply button 

 The recipient address and the subject matter are automatically filled in 

http://www.webdevelopersnotes.com/tips/internet/create_outlook_express_message_rules.php
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 When you have completed typing, click on the send button 

 

The window in the outlook express looks like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Advantages of using Outlook Express 

 With the help of Outlook Express, you can download, read and reply to your mails 

offline. 

 From a single account, you can access and read all the mails and can even zero down the 

account through which you want to send a reply. 

 You can also have different users and can hence use Outlook express for a public setting 

such as a library or a laboratory. 

  

6.1.4   WEB ENABLED  

 

Web-enabled content is content that can be accessed with a web browser or via HTTP or HTTPS 

protocols. Computer application that is created with HTML and can therefore be accessed with 

a browser 

http://www.businessdictionary.com/definition/computer.html
http://www.businessdictionary.com/definition/Hypertext-Markup-Language-HTML.html
http://www.businessdictionary.com/definition/browser.html
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All documents on public websites and intranets are web-enabled and file shares and content 

management systems can be easily configured to publish (or deliver) documents in a web-

enabled format. This term may refer to general Web surfing, connecting to a specific Web site 

for some purpose or running applications within a Web browser. 

The instructions, typically written in a combination of HTML and JavaScript, are embedded 

within the Web page that is downloaded from a Web site.  

 

What is web-enabled software? 

 

Like the name suggests, web-enabled software has to be ―enabled‖ to be used over the internet. 

Web- enabled applications are primarily written to become desktop applications, which are only 

modified to be accessed over a Web browser. Most vendors just add a new layer to the existing 

software to enable their software to function over the internet. The system remains the same and 

performs the same functions as before with the only difference that the program input and output 

is now accessible on the web. This adaptation in most web-enabled software solutions makes it 

slow and complex. 

Vendors who own older generation software only enable the software to be used over the web to 

sell their product. To avoid risks and expense associated with writing new software from scratch, 

vendors mostly modify their older generation applications and sell them as web-based software. 

However this does not change the old engine of the software. Customers who invest in such 

software applications continue to get outdated technology performing the same functions as 

before underneath a new layer that is written so that the application works on a web browser. 

When a vendor offers to web enable its software, it indicates that the application is old and the 

vendor is willing to only invest in modifying the same old application. Most web-enabled 

software applications cannot survive the test of time. In case you have already invested in web-

enabled software, ask your vendor the time that it would take to completely rewrite the software 

to make it truly web-based. 

 

Disadvantages of Web- enabled Software: 

 Slow and complex 

 Outdated Technology 
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 Can‘t be integrated with other applications 

 

6.1.5   COMPONENTS AND SOFTWARE REQUIRED TO RUN MULTIMEDIA     

           WEBSITE     

 

Multimedia means that computer information can be represented through audio, video, and 

animation in addition to traditional media (i.e., text, graphics drawings, and images). 

 

A good general definition is: 

Multimedia is the field concerned with the computer-controlled integration of text, graphics, 

drawings, still and moving images (Video), animation, audio, and any other media where every 

type of information can be represented, stored, transmitted and processed digitally. 

 

The basic elements of multimedia on a computer are: 

 Movies 

 Animation 

 Sound 

 Text  

 Still images 

 Special effects 

 

Why to use Multimedia?  

According to Dr. Albert Mehrabian, a specialist in interpersonal communication at the University 

of California says:  

People recall 20% of what they see  

                      40% of what they see & hear  

                      70% of what they see, hear & do  

                                 Multimedia allows for seeing, hearing and doing 

Multimedia Applications 

Examples of Multimedia Applications include: 

 World Wide Web 
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 Multimedia Authoring, e.g. Adobe/Macromedia Director 

 Hypermedia courseware 

 Video-on-demand 

 Interactive TV 

 Computer Games  

 Virtual reality 

 Digital video editing and production systems 

 Multimedia Database systems 

 

In this section, we introduce you to the inside story of multimedia i.e. about the hardware and the 

software which enable you to get the end product called multimedia. Understanding these 

concepts is very important as it is only the hardware (the computer), the software (tools for 

designing multimedia) which will be crucial in order to run multimedia website. 

 

COMPONENTS REQUIRED TO RUN MULTIMEDIA WEBSITE: 

The components are thus divided into five categories viz. System devices, Memory and storage 

devices, Input devices, Output devices, and Communication devices. 

 

System devices –  

These are the devices that are the essential components for a computer. These include 

microprocessor, motherboard and memory. Microprocessor is basically the heart of the 

computer. A microprocessor is a computer processor on a small microchip. When you turn your 

computer on, it is the microprocessor, which performs some operations. The microprocessor gets 

the first instruction from the Basic Input/output System (BIOS), which is a part of its memory. 

BIOS actually load the operating system into random access memory (RAM). A motherboard is 

a device in the computer that contains the computer's basic circuitry and other components. 

Motherboard contains computer components like microprocessor, memory, basic input/output 

system (BIOS), expansion slots and interconnecting circuitry.  

Memory and storage devices –  

A memory and storage device RAM (random access memory), also called primary memory, 

locates the operating system, application programs, and data in current use so that the computer's 
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processor reaches them quickly. RAM is called "random access" because any storage location 

can be accessed randomly or directly. RAM is much faster than the hard disk; the floppy disk 

and the CD-ROM. RAM can be taken as short-term memory and the hard disk as the long-term 

memory of a computer. However, RAM might get slow when used to its limit. That is why, you 

need more memory to work on multimedia. Today's personal computers come with 128 or more 

of RAM. 

A hard disk stores and provides access to large amounts of data on an electro magnetically 

charged surface. The disk cache holds data that has recently been read. The other type of 

hardware cache inside your computer is cache memory. Cache stores something temporarily e.g. 

Temporary Internet files are saved in Cache. 

A (CD) is a small medium that can store data pertaining to audio, video, text, and other 

information in digital form. Initially, CDs were read-only, but newer technology allows users to 

record as well. (Compact Disc, read-only memory) can store computer data in the form of text, 

graphics and sound.  

 

Input devices –  

A keyboard is the primary text input device of computer. The keyboard contains certain standard 

function keys, such as the escape key, tab, cursor movement keys and shift and control key. A 

mouse is also a primary input device but it is not suitable for dealing with text. 

A mouse is a small device that you move across a pad in order to point to a place on a display 

screen and thus execute a command by clicking it. The mouse is an integral part of any personal 

computer.  

Microphone is another input device that can interpret dictation and also enable us to input sound 

like the keyboard is used for text. 

A digital camera records and stores photographic images in digital form that can be fed to a 

computer as the impressions are recorded or stored in the camera for later loading into a 

computer. The digital cameras are available for still as well as motion pictures. 

 

Output devices –  

A printer is a device, which on receiving the signal from computer transfers the information to 

paper. Earlier the printer was a popular low-cost personal computer printer; now printers have 
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taken its place. Dot-matrix printer strikes the paper a line at a time while inkjet sprays ink and 

laser printer uses a laser beam to attract ink (also called toner).  

 

A monitor is a device for display. It is just like a television set and is measured diagonally from 

two opposing corners of the picture tube. The standard monitor size is 14 inches. Very large 

monitors can measure 21 inches diagonal or greater. 

 

An amplifier is an electronic device that increases the power of a signal. Amplifiers are used in 

audio equipments. They are also called power amplifiers. Speakers with built-in amplifiers have 

become an integral part of the computers today and are important for any multimedia project. 

 

Communication devices –  

Burger (1994) stated; 

              ―Effective communication is the most important criteria in Multimedia.‖ 

A modem modulates going out from a computer or other digital device to for a telephone line 

and demodulates the analog signal to convert it to a digital signal to be inputted in a computer. 

Most new personal computers come with 56 Kbps modems. Modems help your computer to 

connect to a network 

 

SOFTWARE REQUIRED TO RUN MULTIMEDIA WEBSITE 

Multimedia content on the website requires various software  

 Windows Media Player 

 Macromedia Flash  

 Microsoft PowerPoint 

 Adobe flash player 

 Real Networks, Real One Player, and/or Flash Player software to be installed on your 

computer. 

 Your web browser software must support frames to view activities that contain live 

webcasts. 

 Your web browser software must be configured to accept cookies  

 JavaScript must be enabled in your web browser software. 
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 Your web browser software must be configured not to block pop-up windows  

 To view and print the any materials that accompany the activity, you will need software 

that is capable of opening a PDF file such as  Adobe Acrobat 

 

6.1.6   SAVING AND PRINTING WEB FILES 

 

If you have accessed a long text file on the net, you may want to save it for later to read off-line 

(especially if you're paying per minute for connection time!). You can also print it out later as 

well. 

You can open files for viewing or listening without saving them first, or you may want to save 

files to your computer for later use. A saved file can be opened any time without a web browser 

or Internet connection. 

The documents on the website are mostly in PDF, Word (DOC) and Excel (XLS) formats. There 

are also MP3 sound files, images and links to videos. 

TO SAVE A WEB PAGE: 

Web pages browsed on the internet can be saved on the hard disk of the computer for future 

use. The process for saving web pages on the computer depends on the web browser used.  

Internet Explorer users should choose 'Save As' from the File menu where 'Web Archive' 

should be clicked to compile the web pages, with all its contents, in a single file.  

In Google Chrome from the 'Save As' option, the field 'Web Page, complete' should be selected. 

Firefox users should select 'Save page As' and then 'Web page, Complete' to save the required 

web pages.  

Internet Explorer 

1. Open Internet Explorer by clicking the Start button , and then clicking Internet 

Explorer. 

2. Go to the webpage you want to save. 

3. Click the Page button, and then click Save As. 

4. Navigate to the folder where you want to save the webpage. By default, web pages are 

saved in the Documents folder. 

5. Type a new name in the File name box if you want to change the name. 
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6. In the Save as type box, do one of the following: 

 To save all the files associated with the page, including graphics, frames, and style 

sheets in their original format, select Webpage, complete. 

 To save all information as a single file, select Web Archive, single file (*.mht). 

 To save just the current HTML page, without graphics, sounds, or other files, 

select Webpage, HTML only. 

 To save just the text from the current webpage, select Text File. 

7. Click Save. 

 

Google Chrome 

There are two ways to save a web page on Google Chrome. 

             

            Method 1: 

1. Open google chrome  

2. Go to the webpage you want to save. 

3. Right click on the desired web page 

4. Select "Save As" 

5. In the "Save as type" field, drop down the list and choose "Web page, Complete" 

 

Method 2: 

1. To save a specific frame in the page 

2. right-click anywhere in the frame and select "Save frame as". 

 

 

Mozilla Firefox 

1. Open Mozilla Firefox 

2. Go to the webpage you want to save. 

3. Right click on the desired web page 

4. Select "Save page as" or use the following shortcut: Ctrl + S 

5. In the "Save as type" field, drop down the list and choose "Web page, Complete" 
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Save a document as a PDF file 

You can share a document with other people by saving it in Portable Document Format (PDF). 

For example, you can email the PDF file or make it available on public file servers, such as the 

Public folder on your disc. Even people without the application that created the document will be 

able to read it as long as they have a PDF viewer, such as Preview or Adobe Acrobat. 

1. Open the document you want to save as a PDF file. 

2. Choose File > Print. 

3. Choose ―Save as PDF‖ from the PDF pop-up menu, and then choose a name and location 

for the PDF file. 

4. Enter the information you want in the Title, Author, Subject, and Keywords fields. 

You can search on the contents of those fields using Spotlight. 

5. If you want to encrypt your document, click Security Options. 

You can choose two passwords: one for opening the document and another for printing or 

copying from the document. 

TO PRINT A WEB PAGE 

 

If you are trying to print web-pages and find that some of the content of the page is not being 

printed out please carry out the following operations on your internet browser  

 

Internet explorer 

1. Select the 'Tools' on the top of your internet browser. 

2. Select 'Internet Options' from the drop down menu. 

3. Select the 'Advanced' tab from the 'Internet Options' menu 

4. Scroll down the 'Advanced' menu to the 'Printing' checkbox. 

5. Click the mouse inside the 'Print background colors and images' box. 



194 
 

6. Click 'Ok' 

.  

.  

 

 

 

 

 

 

 

 

 

 

 

Mozilla Firefox 

If your internet browser is called 'Mozilla Firefox' please follow the instructions below instead 

1. Click the Firefox tab at the top left of your screen. 

 

 

 

 

 

 

 

 

 

 

 

2. Mouse over Print… and select Page Setup 
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3. Select 'Print background colors and images' in the 'Options' box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Firefox 3x: 

1. Select File > Print 

2. Choose your printer, then select Properties 

3. Press Page Setup 

4. Click the checkbox to enable Print Background (colors and images) 

 

Google chrome: 

1. Click the Chrome controls icon at the top right of the window 
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2. Select Print… 

3. Click the Background colors and images box 
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Check your progress – 1 

a) The Internet is a collection of ………………. connected by interconnecting devices. 

b) A ………………. is software that is used to access the internet. 

c) The first e-mail was sent by ………………………… in 1971. 

d) All documents on public websites and intranets are ………………….. 

e) ………………….. allows for seeing, hearing and doing. 

 

6.2   NETWORKING 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define networking  

ii. Explain types of networking 

iii. Understand its topology  

 

Networking is the practice of linking two or more computing devices together for the purpose of 

sharing data. Networks are built with a mix of computer hardware and computer software. 

A network consists of two or more computers that are linked in order to share resources (such as 

printers and CDs), exchange files, or allow electronic communications. The computers on a 

network may be linked through cables, telephone lines, radio waves, satellites, or infrared light 

beams. 

A computer network consists of a collection of computers, printers and other equipment that is 

connected together so that they can communicate with each other.  

 

 

 

 

 

 

 

 

http://www.computerhope.com/history/196080.htm
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Every network includes: 

 At least two computers Server or Client workstation. 

 Networking Interface Card's (NIC) 

 A connection medium, usually a wire or cable, although wireless communication 

between networked computers and peripherals is also possible. 

 Network Operating system software, such as Microsoft Windows NT or 2000, Novell 

NetWare, Unix and Linux. 

 

Network Configuration 

 

 

 

 

 

 

 

 

Peer-to-peer networks are more commonly implemented where less than ten computers are 

involved and where strict security is not necessary. All computers have the same status, hence 

the term 'peer', and they communicate with each other on an equal footing. Files, such as word 

processing or spreadsheet documents, can be shared across the network and all the computers on 

the network can share devices, such as printers or scanners, which are connected to any one 

computer. 

  

 

 

 

 

 

 

 

network 
configurati

on 

client 
server 

network 

peer- to- 
network 
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Client/server networks are more suitable for larger networks. A central computer, or 'server', 

acts as the storage location for files and applications shared on the network. Usually the server is 

a higher than average performance computer. The server also controls the network access of the 

other computers which are referred to as the 'client' computers. Typically, teachers and students 

in a school will use the client computers for their work and only the network administrator 

(usually a designated staff member) will have access rights to the server. 

 

 

 

 

 

 

 

 

 

 

Advantages of using a network include:  

 Facilitating communications  

 Sharing hardware  

 Sharing data and information  

 Sharing software  

 Transferring funds. 

 

 

6.2.1   TYPES OF NETWORK  

 

A network is basically all of the components (hardware and software) involved in connecting 

computers across small and large distances.  
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LOCAL AREA NETWORK (LAN) 

Local area networks (LANs) are used to connect networking devices that are in a very close 

geographic area, such as a floor of a building, a building itself, or a campus environment. A local 

area network (LAN) is a computer network that spans a relatively small area. Most LANs are 

confined to a single building or group of buildings. Typical LANs are created with Ethernet or 

WIFI networking connections, and are wholly owned by a single person, group, or company. 

 

 

 

 

 

 

 

 

 

 

 

 

 

NETWORK 

LAN 

MAN WAN 

http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/N/network.html
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Types of LAN  

 

 

 

 

 

 

 

Personal Area Network  

A personal area network (PAN) is a computer network used for communication among computer 

and different information technological devices close to one person. Headphone Smartphone 

Laptop PDA Mouse Printer 

Examples of devices that are used in a PAN are:  

 Personal computers  

 Printers  

 Fax machines  

 Telephones  

 PDAs  

 Scanners  

 Video game consoles 

 A wired PAN is usually constructed with USB and Fire wire connections. Technologies such as 

Bluetooth and infrared communication typically form a wireless PAN. 

 

Home Area Network  

A home area network (HAN) is a residential LAN which is used for communication between 

digital devices typically deployed in the home, usually a small number of personal computers 

and accessories, such as printers and mobile computing devices. 

 An important function is the sharing of Internet access, often a broadband service through a 

Digital Subscriber Line (DSL) provider. 

 

LAN 

Personal area 
network 

(PAN) 

House area 
network 

(HAN) 
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Major Characteristics of LAN 

 Every computer has the potential to communicate with any other computers of the 

network 

 High degree of interconnection between computers 

 Easy physical connection of computers in a network 

 Inexpensive medium of data transmission 

 High data transmission rate 

Advantages 

 The reliability of network is high because the failure of one computer in the network does 

not affect the functioning for other computers. 

 Addition of new computer to network is easy. 

 High rate of data transmission is possible. 

 Peripheral devices like magnetic disk and printer can be shared by other computers. 

Disadvantages 

 If the communication line fails, the entire network system breaks down. 

Uses of LAN 

Followings are the major areas where LAN is normally used for: 

 File transfers and Access 

 Word and text processing 

 Electronic message handling 

 Remote database access 

 Personal computing 

 Digital voice transmission and storage 

 

METROPOLITAN AREA NETWORK (MAN) 

A metropolitan area network (MAN) is a large computer network that usually spans a city or a 

large campus. A MAN usually interconnects a number of local area networks (LANs) using a 

high-capacity backbone technology, such as fiber-optical links, and provides up-link services 

to wide area networks (or WAN) and the Internet. Many of the same technologies and 

http://www.wikipedia.org/wiki/Computer_network
http://www.wikipedia.org/wiki/Local_area_network
http://www.wikipedia.org/wiki/Wide_area_network
http://www.wikipedia.org/wiki/Internet
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communications protocols found in local area networks and wide area networks are used to 

create metropolitan area networks. 

A data network designed for a town or city. In terms of geographic breadth, MANs are larger 

than local-area networks (LANs), but smaller than wide-area networks (WANs). MANs are 

usually characterized by very high-speed connections using fiber optical cable or other digital 

media. In MAN, different LANs are connected through a local telephone exchange. Some of the 

widely used protocols for MAN are RS-232, X.25, Frame Relay, Asynchronous Transfer Mode 

(ATM), ISDN (Integrated Services Digital Network), OC·3 lines (1.55 Mbps), ADSL 

(Asymmetrical Digital Subscriber Line) etc. These protocols are quite different from those used 

for LANs. 

They can also provide interconnections between corporate data centers and Internet service 

providers. Almost all MANs are based on one of two basic forms of supporting technology: 

SONET or Ethernet 

 

There are three important features which discriminate MANs from LANs or WANs: 

1. The network size falls intermediate between LANs and WANs. A MAN typically covers 

an area of between 5 and 50 km range. Many MANs cover an area the size of a city, 

although in some cases MANs may be as small as a group of buildings. 

http://www.webopedia.com/TERM/L/local_area_network_LAN.html
http://www.webopedia.com/TERM/W/wide_area_network_WAN.html
http://www.webopedia.com/TERM/F/fiber_optics.html
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2. A MAN (like a WAN) is not generally owned by a single organisation. The MAN, its 

communications links and equipment are generally owned by either a consortium of users 

or by a network service provider who sells the service to the users. 

3. A MAN often acts as a high speed network to allow sharing of regional resources. It is also 

frequently used to provide a shared connection to other networks using a link to a WAN. 

 

Types of MAN 

 

 

 

 

 

 

 

 

Campus Area Network  

A campus area network is a computer network made up of an interconnection of local area 

networks (LANs) within a limited geographical area. 

In the case of a university campus-based campus network, the network is likely to link a variety 

of campus buildings including; academic departments, the university library and student 

residence halls. 

Advantages  

 The biggest advantage of MANs is the bandwidth (potential speed) of the connecting 

links.  

 Efficiency and shared access.  

 All the computer-owning residents of the area have equal ability to go on line..  

 Some installations allow multiple users to share the same high-speed Internet connection, 

thereby sharing the cost of the service and securing a better quality of service through 

collective bargaining and economies of scale. 

Disadvantages  

 It can be costly (hardware, software, support, etc.)  

MAN 

Campus area 
network 

(CAN) 
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 Security problems  

 As the network consists of many computers over the span of a city, the connection can 

lag or become quite slow. 

 

WIDE AREA NETWORK (WAN) 

A WAN is a computer network which is used to transfer data over large geographical areas, such 

as, a country, continent, or the entire world. Typically, a WAN consists of two or more local-area 

networks (LANs). Computers connected to a wide-area network are often connected through 

public networks, such as the telephone system. This ensures that computers and users in one 

location can communicate with computers and users in other locations. They can also be 

connected through leased lines or satellites. These leased lines involve a direct point-to-point 

connection between two sites. Point-to-point WAN service may involve either analog dial-up 

lines or dedicated leased digital private lines. The largest WAN in existence is the Internet. 

 

A major factor impacting WAN design and performance is a requirement that they lease 

communications circuits from telephone companies or other communications carriers. 

Transmission rates are typically 2 Mbps, 34 Mbps, 45 Mbps, 155 Mbps, 625 Mbps (or 

sometimes considerably more).  

 

A wide area network allows long transmission of data, voice, image and video information. A 

WAN is larger than a MAN network .  

 

WAN are of 2 types:- 

 Public WAN - Public Wide Area Network are those network in which the data and 

information (resources) are access and shared publicly example Internet. 

 Private WAN - Private Wide Area Network are those network in which the data and 

information (resources) are access and shared privately example ARPANET. 

 

 

 

http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/N/network.html
http://www.webopedia.com/TERM/L/local_area_network_LAN.html
http://www.webopedia.com/TERM/L/local_area_network_LAN.html
http://www.webopedia.com/TERM/L/leased_line.html
http://www.webopedia.com/TERM/I/Internet.html


206 
 

 

 

 

Major characteristics of WANs: 

 WANs generally connect devices that are separated by a broader geographical area  

 WANs use the services such as telephone companies, cable companies, satellite systems, 

and network providers. 

 WANs use serial connections of various types to provide access to bandwidth over large 

geographic area. 

Advantages of WANs: 

 These are similar to those of LAN's except the scale of sharing etc. becomes far greater 

and can be world-wide. 

Disadvantages of WANs: 

 Security become even more important as potential hackers could break into a computer 

system from anywhere in the world. 

 Encryption of secure data such as financial transactions is necessary because it is even 

easier to intercept data. 

 

 

 

http://www.orbit-computer-solutions.com/Satellite-Broadband.php
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Comparisons between LAN, MAN, WAN  

 

 

 

 

 

 

6.2.2 NETWORK TOPOLOGY  

 

Network Topology refers to layout of a network and how different nodes in a network are 

connected to each other and how they communicate. This slideshow describes five of the most 

common network topologies. 

1. Mesh Topology 

In a mesh network, devices are connected with many redundant interconnections between 

network nodes. In a true mesh topology every node has a connection to every other node in the 

network. There are two types of mesh topologies: 

 

Full mesh topology: occurs when every node has a circuit connecting it to every other node in a 

network. Full mesh is very expensive to implement but yields the greatest amount of redundancy, 

so in the event that one of those nodes fails, network traffic can be directed to any of the other 

nodes. Full mesh is usually reserved for backbone networks. 

Partial mesh topology: is less expensive to implement and yields less redundancy than full 

mesh topology. With partial mesh, some nodes are organized in a full mesh scheme but others 

 Cost Network size Speed Number of 

computers 

LAN Low Small Fastest Smallest 

MAN High Larger Slower Large 

WAN Higher Largest Slowest Largest 

http://www.webopedia.com/TERM/T/topology.html
http://www.webopedia.com/TERM/N/network.htm
http://www.webopedia.com/TERM/N/node.htm
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are only connected to one or two in the network. Partial mesh topology is commonly found in 

peripheral networks connected to a full meshed backbone. 

2. Star Topology 

 

In a star network devices are connected to a central computer, called a hub. Nodes communicate 

across the network by passing data through the hub. 

Advantage: 

In a star network, one malfunctioning node doesn't affect the rest of the network. 

Disadvantage:  

If the central computer fails, the entire network becomes unusable. 

 

3. Bus Topology 

In networking a bus is the central cable -- the main wire -- that connects all devices on a local-

area network (LAN). It is also called the backbone. This is often used to describe the main 

network connections composing the Internet.  Bus networks are relatively inexpensive and easy 

to install for small networks. Ethernet systems use a bus topology. 

Advantage:  

It's easy to connect a computer or device and typically it requires less cable than a star topology. 

Disadvantage:  

http://www.webopedia.com/TERM/L/local_area_network_LAN.html
http://www.webopedia.com/TERM/B/backbone.html
http://www.webopedia.com/TERM/E/Ethernet.html
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The entire network shuts down if there is a break in the main wire and it can be difficult to 

identify the problem if the network shuts down. 

4. Ring Topology 

A local-area network (LAN) whose topology is a ring. That is, all of the nodes are connected in a 

Closed loop. Messages travel around the ring, with each node reading those messages addressed 

 

to it. One main advantage to a ring network is that it can span larger distances than other types of 

networks, such as bus networks, because each node regenerates messages as they pass through it. 

5. Tree Topology 

 

This is a "hybrid" topology that combines characteristics of linear bus and star topologies. In a 

tree network, groups of star-configured networks are connected to a linear bus backbone cable. 

Advantage:  

A Tree topology is a good choice for large computer networks as the tree topology "divides" the 

whole network into parts that are more easily manageable. 

http://www.webopedia.com/TERM/L/local_area_network_LAN.html
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Disadvantage:  

The entire network depends on a central hub and a failure of the central hub can cripple the 

whole network. 

 

Check Your Progress – 2 

a) ……………………. is the practice of linking two or more computing devices together 

for the purpose of sharing data. 

b) …………………. networks are more suitable for larger networks. 

c) A …………………….. is a computer network that spans a relatively small area. 

d) A data network designed for a town or city is ……………………. 

 

 

6.3 COMPUTER CRIME AND SECURITY 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Explain what is computer crime 

ii. Understand its security 

 

Computer crime or Cybercrime, refers to any crime that involves a computer and a network. 

The computer may have been used in the commission of a crime, or it may be the target.   

Dr. Debarati Halder and Dr. K. Jaishankar (2011) define Cybercrimes as: 

 "Offences that are committed against individuals or groups of individuals with a criminal motive 

to intentionally harm the reputation of the victim or cause physical or mental harm to the victim 

directly or indirectly, using modern telecommunication networks such as Internet (Chat rooms, 

emails, notice boards and groups) and mobile phones (SMS/MMS)" 

Issues surrounding these types of crimes have become high-profile, particularly those 

surrounding cracking, copyright infringement, child pornography, and child grooming. There are 

also problems of privacy when confidential information is lost or intercepted, lawfully or 

otherwise. 

http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/N/network.html
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/Hacker_(computer_security)
http://en.wikipedia.org/wiki/Copyright_infringement
http://en.wikipedia.org/wiki/Child_pornography
http://en.wikipedia.org/wiki/Child_grooming
http://en.wikipedia.org/wiki/Privacy
http://en.wikipedia.org/wiki/Confidential
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Crime committed using a computer and the internet to steal a person‘s identity or illegal imports 

or malicious programs cybercrime is nothing but where the computer used as an object or subject 

of crime 

The first recorded cyber crime took place in the year1820. That is not surprising considering the 

fact that the abacus, which is thought to be the earliest form of a computer, has been around since 

3500 B.C. 

 

 

Categorizes Of Cyber Crime  

The Computer as a Target: using a computer to attack other computers. 

The computer as a weapon: using a computer to commit real world crimes. 

Types of Cyber attacks, by percentage (source- FBI) 

 Financial fraud: 11% 

 Sabotage of data/networks: 17% 

 Theft of proprietary information: 20% 

 System penetration from the outside: 25% 

 Denial of service: 27% 

 Unauthorized access by insiders: 71% 

 Employee abuse of internet privileges 79% 

 Viruses: 85% 

 

Types of Cyber Crime  

 Hacking: Hacking in simple terms means an illegal intrusion into a computer system 

and/or network. It is also known as CRACKING. Government websites are the hot 

targets of the hackers due to the press coverage, it receives. Hackers enjoy the media 

coverage. 

 Denial of service attack: This is an act by the criminal, who floods the bandwidth of the 

victims network or fills his e-mail box with spam mail depriving him of the services he is 

entitled to access or provide 
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 Virus dissemination: Malicious software that attaches itself to other software.(virus, 

worms, Trojan Horse, web jacking, e-mail bombing etc) 

 Computer vandalism: Damaging or destroying data rather than stealing or misusing 

them is called cyber vandalism. Transmitting virus: These are programs that attach 

themselves to a file and then circulate 

 Cyber terrorism: Terrorist attacks on the Internet is by distributed denial of service 

attacks, hate websites and hate emails, attacks on sensitive computer networks, etc. 

Technology savvy terrorists are using 512-bit encryption, which is impossible to decrypt. 

 Software piracy: Theft of software through the illegal copying of genuine programs or 

the counterfeiting and distribution of products intended to pass for the original. 

 

 

CYBER SECURITY: 

Internet security is a branch of computer security specifically related to the Internet. Its objective 

is to establish rules and measure to use against attacks over the Internet. 

Safety Tips: 

 Use antivirus software‘s 

 Insert firewalls 

 Uninstall unnecessary software 

 Maintain backup 

 Check security settings 

 Stay anonymous - choose a genderless screen name 

 Never give your full name or address to strangers 

 Learn ‗inetiquette - follow it and expect it from others 

 Don‘t respond to harassing or negative messages (flames) 

 Get out of uncomfortable or hostile situations quickly 

 Save offending messages 

 Learn more about Internet privacy 

 

Advantages of cyber security: 
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 The cyber security will defend us from critical attacks. 

 It helps us to browse the safe website. 

 Internet security processes all the incoming and outgoing data on our computer. 

 Security will defend from hacks and virus. 

 The application of cyber security used in our PC needs update every week. 

 The security developers will update their database every week once. Hence the new virus 

also deleted. 

 

Check Your Progress – 3 

a) ………………………. refers to any crime that involves a computer and a network. 

b) …………………… in simple terms means an illegal intrusion into a computer system 

and/or network. 

c) ………………….. will defend from critical attacks 

 

6.4 APPLICATION IN DEVELOPMENT SECTOR 

 

Learning Objective   :- 

 

After studying this sub unit you would be able to – 

i. Define the application of internet in development sector 

 

Internet is interconnection of large number of heterogeneous computer networks all over the 

world that can share information back and forth. These interconnected network exchange 

information by using same standards and protocols 

 

Applications of internet 

The internet is treated as one of the biggest invention. It has a large number of uses. 

 

http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Computer_network
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Communication: It is used for sending and receiving message from one and other through 

internet by using electronic mail. Some of the web sites providing this service are 

yahoomail.com Hotmail.com rediffmail.com etc 

Job searches: Getting information regarding availability of job in different sectors and areas. 

You can publish your resume in online for prospective job. Some of the web sites providing this 

service are naukri.com, monster.com, summerjob.com, recuritmentindia.com etc. 

Finding books and study material: Books and other study material stored around the world can 

be easily located through internet. Latest encyclopedias are available online. 

Health and medicine: Internet provides information and knowledge about field of health 

medicine, people can have information about various diseases and can receive help .patient can 

be taken to virtual check room where they can meet doctors.  

Travel: One can use internet to gather information about various tourist place. It can be used for 

booking Holiday tours, hotels, train and flights. Some of the web sites providing this service 

areindiatravelog.com, rajtravel.com, makemytrip.com. 

Entertainment: Entertainment one can download jokes, songs movies, latest sports updates 

through internet. Some of the web sites providing this service arecricinfo.com, movies.com 

espn.com 

Shopping: Internet is also used for online shopping. By just giving accounts details you can 

perform the transaction. You can even pay your bills and perform bank related transaction. 

Stock market updates: You can sell or buy shares while sitting on computer through internet. 

Several websites like ndtvprofit.com, moneypore.com, provide information regarding investment 

Research: A large number of people are using internet for research purposes you can download 

any kind information by using internet  

Business use of internet: Different ways by which internet can be used for business are: 

 Information about the product can be provided can be provided online to the customer. 

 Provide market information to the business 

 It helps business to recruit talented people 

 Help in locating suppliers of the product 

 Fast information regarding customers view about company product 

 Eliminate middle men and have a direct contact with customer 
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 Providing information to the investor by providing companies back ground and financial 

information on web site 

 

Check Your Progress – 4 

a) ……………… is used for sending and receiving message from one and other through 

internet by using electronic mail. 

b) One can use internet to gather …………………… about various tourist place. 

c) Internet is also used for ……………. shopping. 

Let Us Sum Up (Summary) 

a) A network is a group of connected communicating devices such as computers and 

printers. 

The Internet is a collection of networks connected by interconnecting devices. 

b) The words ―Browsing‖ or ―Surfing‖ are used to describe the process of looking at 

documents, websites and web pages on the Internet 

c) A browser is software that is used to access the internet. 

d) One of the most popular internet services is electronic mail (e – mail). 

e) Outlook Express is an email program that works with Internet Explore versions 4.0 to 

6.0. 

f) Web-enabled content is content that can be accessed with a web browser or via HTTP or 

HTTPS protocols. 

g) Multimedia means that computer information can be represented through audio, video, 

and animation in addition to traditional media (i.e., text, graphics drawings, and images). 

h) Networking is the practice of linking two or more computing devices together for the 

purpose of sharing data. 

i) Peer-to-peer networks are more commonly implemented where less than ten computers 

are involved and where strict security is not necessary. 

j) Client/server networks are more suitable for larger networks. 

k) Network Topology refers to layout of a network. 

l) A local area network (LAN) is a computer network that spans a relatively small area. 

LAN are of two types personal area network and home area network. 

http://www.webopedia.com/TERM/T/topology.html
http://www.webopedia.com/TERM/N/network.htm
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/N/network.html
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m) The various types of network topologies are Mesh, star, bus, ring and tree topology. 

n) Crime committed using a computer and the internet to steal a person‘s identity or illegal 

imports or malicious programs cybercrime is nothing but where the computer used as an 

object or subject of crime. 

o) Internet security is a branch of computer security specifically related to the Internet. Its 

objective is to establish rules and measure to use against attacks over the Internet. 

 

Answers  

 

Check Your Progress – 1 

a) Networks 

b) Browser 

c) Ray Tomlinson 

d) Web – enabled 

e) Multimedia  

 

Check Your Progress – 2  

a) Networking  

b) Client/server 

c) Local area network 

d) Metropolitan area network 

Check Your Progress – 3  

a) Computer crime 

b) Hacking 

c) Cyber security 

Check Your Progress – 4 

a) Internet 

b) Information 

c) Online 

 


